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DISCLAIMER 

 
SpecView software communicates with industrial instrumentation and displays and 

stores the information it receives. It is always possible that the data being displayed, 
stored or adjusted is not as expected. ERRORS IN THE DATABASE OR ELSEWHERE 
MEAN THAT YOU COULD BE READING OR ADJUSTING SOMETHING OTHER THAN 

THAT WHICH YOU EXPECT! 
Safety devices must ALWAYS be used so that safe operation of equipment is 

assured even if incorrect data is read by or sent from SpecView. 
SpecView itself MUST NOT BE USED IN ANY WAY AS A SAFETY DEVICE! 

 
SpecView will not be responsible for any loss or damage caused by 

incorrect use or operation, even if caused by errors in programs 
supplied by SpecView Corporation. 

 

Warranties & Trademarks 
This document is for information only and is subject to change without prior notice. 
SpecView is a registered trademark of SpecView Corporation 
Windows is a trademark of Microsoft Corporation. 
All other products and brand names are trademarks of their respective companies.  
 
 
Copyright  1995-2002 by SpecView Corporation. All Rights Reserved. 
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Installation 

Instrument Installation and Wiring 
NOTE: If you cannot establish communications between SpecView and your 
instruments first contact the instrument manufacturer for assistance.  Many have 
test programs that will check your converter and connections.  
 
Most computers have built in RS232 ports and an external converter to either RS422 or RS485 must be used. 
SpecView recommends (and can supply) converters made by B&B Electronics Tel: (815) 433-5100 Fax: 
(815) 434-7094 Internet: http://www.bb-elec.com  
NOTE: We strongly caution against using internal 422/485 cards 
Unless you are expert in testing and troubleshooting communications we recommend using internal RS232 
ports and external isolated converters. Since all computers have 232 ports a second computer can be used to 
determine whether a problem is in the computer or wiring if an external converter has been used. 
• Each serial port MUST operate with its own interrupt unless special interrupt sharing cards and software 

are used. 
• Serial ports using 16550 UARTS or above are strongly recommended, especially if BAUD rates above 

9600 are going to be used. They are required for instruments that use block mode data reading. 
 
The number of controllers that can be connected to SpecView is only limited by the available addresses on 
the controllers.  Most instruments go to 99 addresses and SpecView supports up to 40 ports (see page 124). 
 
Instrument Settings (see page 5) 
RS422 (EIA422-A) Instruments (see page 5) 
RS485 (EIA485) Instruments (see page 6) 
Connections for SpecView Networking (see page 6) 

Instrument Settings 
SpecView has help available for several makes of instruments: 
On the Ports and Protocols (see page 39) box when a protocol is chosen for a port a Help button appears for 
that port. Clicking it will open a separate help file specifically for that protocol. Refer to it for details on setting 
your instruments. 
You can also get this help by double-clicking on the instrument name in the Variables List accessed by 

clicking the tool   

 

RS422/EIA422 
This is a four wire connection and all four wires MUST be used. 
Follow the instrument manufacturers instructions carefully, paying attention to shielding in electrically noisy 
environments. 
The converter will have two Transmit (sometimes called Send) and two Receive connections 
These are marked either "+" & "-" or "A" & "B" (or both) 
• In general, the Transmit connections on the converter go to the Receive connections on the instrument. 
• In general, the Receive connections on the converter go to the Transmit connections on the instrument. 
• In general, the "+" or "B" connections on the converter go to the "+" or "B" connections on the instrument. 
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(NOTE: Most instruments made by Eurotherm Controls DO NOT follow this convention. In most cases 
connect Converter T+ (or B) to Instrument R-, Converter T- (or A) to Instrument R+ and so on.) 
 

RS485/EIA485 
This is normally a two wire connection but some instruments use four wires. 
Follow the instrument manufacturers instructions carefully, paying attention to shielding in electrically noisy 
environments. 
Two wire converters will have connections marked "A" or "-" and "B" or "+". These go to the corresponding 
connections on the instrument. 
If the instrument has four connections you should use a converter with four connections.  
If you are told by your instrument manufacturer that you can use a two wire converter, on the controller 
jumper the Transmit + (or B) to the Receive + (or B) and the Transmit - (or A) to the Receive - (or A). This 
leaves you with one "+" (or B) connection and one "-" (or A) connection to make to the converter. 
Four wire converters will have two Transmit (sometimes "send") and two Receive connections. 
If your instrument has four connections see the RS422/EIA422 (see page 5) help 
These  marked either "+" & "-" or "A" & "B" (or both) 
If your instrument has two connections, on the converter jumper the Transmit + (or B) to the Receive + (or 
B) and the Transmit - (or A) to the Receive - (or A). This leaves you with one "+" (or B) connection and one "-" 
(or A) connection. 
 

Connections for SpecView Networking 
For SpecView Networking the connection can be made in 3 possible ways: 
Via TCP/IP over a LAN (Local Area Network). 
By using Modem dial-up between computers. 
By making the Local computer available to the Internet so that the Remote computer(s) can access it. 
However, this has security implications so is not recommended. 
The diagrams below show example configurations: 
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It is possible for a PC to run one SpecView Local and several copies of SpecView Remote simultaneously: 

  
 
Setting up SpecView Networking (see page 31) 

Installing SpecView 
If there are any doubts about the suitability of the computer for installation of SpecView, or if you are using 
Windows XP, please check the minimum requirements for installing SpecView (see page 192). 
 
To install SpecView choose one of the following methods: 
 
CD  
If you have SpecView on a CD then load the CD into the drive. It should then automatically run Setup from 
the CD.  

If the CD does not auto-run then double-click the  icon on your screen, open the Compact Disc 

and double-click the  icon. 
 
NOTE: It is strongly recommended to install into the default location C:\SV32 
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Demo Configurations 
We have a number of fully functional example configurations pre-prepared for many of the instruments that 
we support. These configurations can be easily installed, and may be modified to meet your exact 
requirements.  
 
When installing from a CD, by default all the Demo Configurations are installed. Run SpecView then at the 
first screen (Configurations Found), select the one you require. Each Configuration is stored in its own sub-
folder within the installation folder (which is by default C:\SV32). They can be copied using Windows Explorer, 
therefore it is easy to make a backup of a configuration simply by making a copy of it, or by using SpecView's 
Archive/Restore (see page 39) facility. These configurations can, if required, be modified from Configuration 
Mode (see page 197). 

 
The Demo Configurations are not included in the downloaded product, so they must be downloaded 
separately from the website by selecting the most appropriate of these for your instrument(s). The file(s) you 
download is a .SVA file, which is a SpecView Archive, see Archive/Restore (see page 39). To use one of 
these files, install and run SpecView, then at the Configurations Found screen, press the [Restore] button. 
Find the .SVA file you have downloaded and restore the configuration into SpecView. Once restored, these 
configurations can, if required, be modified from Configuration Mode (see page 197). However modifications 
will only affect the restored Configuration folder, not the downloaded .SVA file, therefore the .SVA file can be 
considered as a backup which can be restored again if necessary. 
Diskettes 

If you have SpecView on diskettes, insert Disk 1 into drive A: double-click the  icon on your 

screen, open the 3½-Inch Floppy Disk and double-click the  icon. 
 
NOTE: It is strongly recommended to install into the default location C:\SV32 
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Download 
 
Downloading SpecView  from http://www.specview.com can be done either by downloading the single file or 
the multiple file version. 
 
All files on the website have been zipped, therefore you will need to unzip them using, for example, WinZip 
(which can be obtained from http://www.winzip.com) or another utility such as pkunzip. 
 
Download the multiple file version if the computer(s) you intend to install it on is not the same as the computer 
which is connected to the internet, and the only way to transfer files between the computers is by using floppy 
disks. 
 
The multiple file version can be also used if there is a likelihood that the internet connection could be lost 
during the download. If this is the case unzip all files into a single temporary folder on your hard disk and run 
SETUP.EXE,  
 
Single file download: 
 
Download the single file, unzip (using for example, WinZip) it into a temporary folder and then run SETUP. 
(Newer versions of WinZip may run SETUP.EXE automatically for you). 
 
For example, for SpecView version 697 the file is: 
 sv697_all.zip (12Mb) 
 
Multiple file download - for floppy disks: 
 
Download all the individual files into a temporary folder on your hard disk.  For example, for SpecView version 
697 the files are: 
 
sv697_1.zip 
sv697_2.zip 
sv697_3.zip 
sv697_4.zip 
sv697_5.zip 
sv697_6.zip 
sv697_7.zip 
sv697_8.zip 
sv697_9.zip 
 
Once they have been downloaded, extract each of them DIRECTLY onto individual separate (totally empty) 
floppy disks. 
NOTE: Do not COPY the ZIP files onto the floppies as they will not fit, they MUST be 
EXTRACTED to the floppies. 
 
The example below is for WinZip, which is not included with SpecView, but it can be obtained from 
http://www.winzip.com 
 
To extract them use Windows Explorer to list the downloaded files, and for each of them in turn, right-click 
and select the Extract to... menu command which will run WinZip. 
 



10       SpecView 2 

  
 
Select the Floppy (A:) and click Extract. 
 
The numbered ZIP files contain numbered CAB files and these numbers will not necessarily match, i.e. the 
file: SV697_6.ZIP may contain: Data7.cab  

 
NOTE: Several of the floppy disk ZIP files contain files that will exactly fill a blank 
floppy.  
 
If there is not enough space on the floppy to copy the files over, then re-format the floppy (ensuring that it is 
not formatted as a system floppy) before re-extracting the files. All the files (when unzipped) will fit onto a 
floppy disk. 
 
Newer versions of WinZip can be configured to run SETUP.EXE automatically, so when you unzip the first 
file, WinZip tries to run SETUP before the other files are unzipped. If this happens, unzip the files in reverse 
order, or download the single file. 
 
Once all the floppy disks have been created, put floppy #1 into the drive of the computer which you intend to 
install it on and run SETUP.EXE. 
 
An alternative method is to Unzip all the files into a single temporary folder on your hard disk and then run 
SETUP.EXE. 

 
If you have difficulty during installation please contact your SpecView supplier.  
 
Quick Start (see page 13) 
Starting SpecView (see page 39) 
 

Upgrading SpecView from a previous version 
Upgrading SpecView from an earlier version of SpecView 32 to a more recent version is just a matter of 
checking the Upgrade/Repair check box in the InstallShield Wizard. 
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However, upgrading to SpecView 32 from the 16-bit version (SpecView Plus) is complicated by the fact that 
the installation folder changed from C:\SPECVIEW in the 16-bit version to C:\SV32 in the 32-bit version. 
Upgrading from the 16-bit version is still possible without the need to re-create existing configurations by just 
copying the configuration's folder over to the new installation. Below is an example of copying a configuration 
folder using Copy and Paste: 
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Quick Start Guide 

Quick Start - Introduction 
NOTE: Press the F1 key at any time for help 
This quick start guide covers the installation and initial configuration of SpecView. 
 
When the computer is connected to an instrument via a serial port or Ethernet, SpecView gets data from and 
can send data to the instrument. Unlike conventional SCADA software, where each data point has to be 
defined by the user, SpecView has a pre-built database of hundreds of instruments. Most instruments, if 
already connected to the computer, can be automatically detected by SpecView. If the instrument is not 
connected to the computer or if that instrument does not support the auto-detection feature, the user picks it 
from a list. In SpecView this is called "Manually Defining Instruments". 
 
Once all the steps below have been followed, your screen should look similar to this: 
(The "Instrument View" (the MM8TC-1 object in the top left) will depend on the specific instrument being 
used) 
 

  
 
The steps are as follows: 

1. Installing SpecView 

2. Starting SpecView 
If you have no instrument currently connected to your computer then follow: 
3. Manual Configuration (see page 14)  
or, if you do have an Instrument(s) connected, then follow: 
3. Automatically detecting instruments and displaying Instrument Views (see page 18) 
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then continuing: 
4. Add a variable to the GDW (Graphical Display Window) 
5. Draw a Trend Chart 
6. Define a second GDW 
7. Adding buttons to switch between GDW's 
8. Adding a Bar chart to a GDW 
9. Seeing how it works in Runtime Mode 
Click the link below to go to the next step: 
 
NOTE:  SpecView's name for each screen is a GDW (Graphical Display Window). 
Each GDW is saved as a file on disk, much like a Word document. 

Quick Start - Starting SpecView 
Once SpecView is installed, double-click the SpecView icon, or click Start and select SpecView 32 from the 
Programs menu. 
 
If SpecView is started without a dongle connected then initially the following dialog box is displayed first. 
Click the Start in DEMO Mode button. 
 

  
 
 
This will display the 
Configurations Found dialog 
box: 
 

  
 
If a dongle is connected, the Configurations Found dialog box will be displayed directly. 
 
If you have an instrument connected then go to Automatically detect instruments (see page 18) below. 
 
Alternatively, if you have no instrument connected you can still configure SpecView by clicking the New 
Manual Configuration button and then going to Manual Configuration (see page 14) 

Quick Start - Manual Configuration 
If you have no instrument connected clicking on New Manual Configuration will display the Input Required 
dialog box 
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Enter a name for the configuration. SpecView will create a subfolder with this name in the SpecView folder 
(which is normally C:\SV32), the name you enter should follow the Windows file naming rules (see page 200) 
and should not be too long. 
 
Remember this name. This folder will be where all your log files and configuration files will be stored. Log 
Reports will also be stored here unless another folder is specified. 
 
When you have entered a name for the configuration and clicked OK this will immediately bring you into 
Configuration Mode displaying a blank Graphical Display Window (GDW) grid. 
 

Click the Variables List tool  on the Toolbar to display this dialog box. At this stage the only 
item listed will be SpecView. 
 
NOTE:  When using the Toolbar, move the pointer over a tool and the Tool Tip will 
tell you what it does. 
 
Click the Show New button, which will list the pre-defined instument types: 

    
 
Scroll down the list of available instruments to find the name of the instrument you intend to connect. Click the 

 symbol beside the instrument you require to display the specific instrument types. Select the appropriate 
one, then click Add Item.  
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Choose the Port from the list (for example COM1) and enter the Address. (If in doubt about what to set the 
address to, click Address Help).   
Modbus instrument addressing (see page 17) 
 
Click Create which will display the Port Settings dialog box: 
 

  

 
 
 
Enter the Baud Rate and Parity appropriate for the instrument 
and click OK. 
 
If in doubt about the values for these please consult your 
instrument manufacturer's manual. 
 

 
NOTE: Below is a description of how to use HyperTerminal to test if the COM port 
that your instrument(s) are connected to is functioning correctly: 
 
HyperTerminal may already be installed, and may be run from the Start button: Programs menu, possibly 
under the Accessories - Communications submenus.  From HyperTerminal's "Connection Description" dialog 
enter any name & choose any icon, then click OK. On the "Connect To" dialog, if you are, for example, testing 
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COM1 then select "Direct to Com1" from the "Connect using" list box, and click OK, then click OK on the 
"COM1 Properties" dialog leaving the "Bits per second" and the other settings as they are. If the status bar 
along the bottom of the window now says "Connected 00:00:00" and starts counting up in seconds, then 
COM1 is Ok. Otherwise an error dialog will be displayed.  If HyperTerminal cannot connect to the COM port, 
then SpecView will also be unable to communicate with it. 

 
The instrument has now been defined within SpecView, clicking the Show Defined button at the top of the 
Variables list dialog will now show it: 
 

  

 
Select the name of the instrument in the list and click Add Item. The 
Instrument View will be displayed on the GDW.  
 
Or double-click the name of the instrument in the list then click Add 
to GDW 
 

  
 

 
This is now configured as if the instrument was already connected and you had clicked the Test Comms for 
New Config button to automatically detect the instrument. Therefore you can now skip the next section, and 
go straight to Configuration mode, starting with Add a variable to the GDW (see page 21)  

Quick Start - For Instruments using the Modbus Protocol 
If the instrument you are using uses Modbus protocol you need to know how the instrument is configured. 
If there is a choice between Modbus or J-Bus protocol choose J-BUS 
If there is a choice for Data Bits choose 8 (EIGHT) 
If there is a choice for Parity choose NONE 
If there is a choice for Stop Bits choose 1 (ONE) 
The format of the address specification for Modbus is: 
 AA,PT;O 
Where: 
AA: Two-digit address of the instrument in decimal. 
P: Number of decimal places for user defined items (see Note 1 below). 
T: Type of protocol: J for J-Bus, M for Modbus (see Note 2 below). 
O: (Optional) Address offset (see Note 3 below). 
Examples: 
1,1J Address 1, 0 decimal place, J-Bus parameters 
2,1J;2 Address 2, 1 decimal place, J-Bus parameters, offset by 2 
10,0M 0 Decimals, Modbus parameters 
 
Note 1 (Decimal Places): 
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0 / 1 / 2 / 3 SpecView will put a decimal place in the position indicated by this setting. The setting affects 
those variables where the number of decimals required is based on an instrument setting such as the range 
that has been selected. Some items, such as Output Power are fixed at a given number of decimal places 
and are not affected by this setting. 
AutoDetect may assume 0 decimal places when detecting instruments.  This might result in values being 10 
or 100 times too large on displays.  If this is the case, then edit the address for the instruments from AA,0T to 
AA,1T (See below for the meaning of this). 
 
Note 2 (Protocol):  
If in ANY doubt, do not enter anything for this item. SpecView will add it for you. 
There is often confusion between Modbus "Registers" and "Addresses". With SpecView the user does not 
need to fully understand the difference but the correct setting MUST be made here. When "J" (for J-Bus) is 
used the "Address" that has been pre-defined by SpecView is sent to the instrument. When "M" (for Modbus) 
is used ONE is subtracted from the pre-defined address. SpecView pre-defined instruments ALWAYS 
assume the address and NEVER the register. Unless advised otherwise by SpecView either leave the letter 
out or use "J". 
 
Note 3 (Address Offset): 
Some instrument companies use an address structure so that a particular instrument view can be re-used 
with the appropriate address offset. This feature is also used with SpecView's "Generic Modbus" instrument 
views. The addresses for each instance of the instrument are the same, offset by a fixed number. See 
Generic Modbus for more details. Also, where this feature is required for a specific instrument, refer to the 
help for that instrument. 
 
Note that the rate at which the Modbus driver will supply the values of variables from the instruments is 
defined by the driver command WTTL (default=19 tenths of a second). This can be set using the Setup COM 
Ports menu command on the Setup menu (see page 74). 
 
For Instruments using Modbus TCP/IP 
 
The address, as detailed above, is prefixed with the full IP address followed by a comma. 
For example: 192.168.1.99,1,2J 

Quick Start - Automatically detect instruments and display instrument views 
Click the Test Comms for New Config button, to detect your instruments automatically.  
The Input Required dialog box is displayed. 
 

  
 
Enter a name for the configuration. SpecView will create a subfolder with this name in the SpecView folder 
(which is normally C:\SV32), the name you enter should follow the Windows file naming rules (see page 200) 
and should not be too long. 
 
Remember this name. This folder will be where all your log files and configuration files will be stored. Log 
Reports will also be stored here unless another folder is specified. 
 
When you have entered a name for the configuration and clicked OK, the Ports and Protocols dialog box is 
displayed. 
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Ports and Protocol 
You will need to know which COM port(s) on your computer the instrument(s) are connected to and the types 
of instruments. If in doubt about this please consult your instrument manufacturer's manual. 
 
For the appropriate COM port(s) select the name(s) of the instrument(s) under Protocol.  When you select a 
protocol for a COM port, a Help button is displayed on the same line. Click it for help on the driver selected. 

If the default port settings do not match the settings for your instruments, click   to set up the 
port. 
 
BAUD Rate 
If there is any uncertainty as to the BAUD rate used by the instrument then leave it set to "Auto" to allow 
SpecView to try a range of BAUD rates. If the BAUD rate is known then set it appropriately. 
 
TCP/IP 
There is also TCP/IP Auto Detection (see page 46) available for some instrument types. 
Start Scan 

Click  SpecView will begin to scan the ports and determine what instrument(s) you have 
connected. As each instrument is found, Instrument Views (pictures of the instruments) will be displayed on 
the Graphical Display Window (GDW) behind the Ports and Protocols dialog box. When all your instruments 
have been detected for this port, if there are further instruments connected to other COM ports then click Skip 
to Next Port, otherwise if there are no further instruments click Stop. A window will be displayed to inform 
you that all channels have been scanned.  
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Click OK to continue and enter 
Configuration Mode. 

 
The Configuration Mode screen will look something like that shown below. 
 
However, if no Instrument View(s) appear then SpecView is not communicating with the instrument(s). Check 
your connections and settings and rescan. If problems persist contact your instrument supplier. 
 

  
 
The actual Instrument View displayed will depend on the instrument type, other examples of Instrument Views 
are shown below: 

  
 
You have now created a GDW containing Instrument Views.  
The Instrument View(s) you see will depend on the kinds of instruments you have connected to your 
computer. 
 
Now move the Instrument View to a different position on the GDW, by clicking and then dragging, to move it 
down the GDW a little way. 
 

Click the Save tool  and then the Save button to save this GDW as "Specview.gdw" in the 
configuration subfolder. 
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Quick Start - Add a variable to the GDW 

To add a variable to the GDW (Graphical Display Window) click the Variables List tool  to 
display a list of the instruments that SpecView has detected.   
 

  
 
The name SpecView also appears in the list as this represents a list of variables that are associated 
SpecView, not one of the connected instruments. 
 
If the Include Name box is un-checked in the Variables List dialog then the name of the variable will not be 
displayed on the GDW, just the value of the variable itself. 
 
The Full Names checkbox toggles between showing the variables' full names and the abbreviated names.  
 
Click the  symbol next to an instrument name to see all the parameters 
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Double-click the variable you want to add to the GDW, for example, Input 1. The variable (XXX, which will be 
displayed as the numeric value of the variable in Runtime Mode) and its description (for example, MM8TC-
,Input 1) are displayed in the top left hand corner of the GDW.  

 

  
 
When the name of the variable and its value are initially put onto the GDW, they are put out as two separate 
items. In order to move them both together to a different position on the screen they will need to be grouped 
together.  

To do this use the Group tool  (or press G) which will group them together 
 

  
 
then use the mouse to drag them to where you would like them to be positioned on the GDW.  
 
If you would like to change the name of the variable then it is best to do this from the Variables List dialog 
BEFORE putting the variable onto the GDW.  This is done by selecting the variable then clicking the 
Properties button.  
 

In order to change, for example, the font of the variable's name, use the Ungroup tool   (or 
press U) to ungroup the variable and its description, then double-click the description to display the Text 
Attributes dialog box 
 

  
 
Make the changes to it that you require, then click OK to close the dialog box.   
 
NOTE: To change the default text font use the Text Font menu command from the Object menu. 
 

Click the Save tool  and then Save to save this GDW again. 
 

Click the Runtime tool  to enter Runtime Mode to start communicating with your 
instruments. 
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Values will be displayed on the Instrument Views and the variable you added to the GDW 
 

  
 
If an Alarms dialog box is displayed close it by clicking the Close button. 
 
NOTE: The immediately obvious differences between Configuration Mode and 
Runtime Mode are that Configuration Mode displays a grid across the screen (GDW). 
Although it is possible to disable the grid this is not recommended, as it helps with 
aligning items when positioning them on the screen (GDW). 
Variables in Configuration Mode are normally displayed as XXX. There are also 
significant differences between the contents of the menus in the two modes. 
Configuration Mode also has a toolbar. 
If you do not have instrument(s) connected then the values will remain at or change 
to XXX. 
 

Quick Start - Draw a trend chart 
Go back to Configuration Mode by selecting Configuration Mode from the File menu. 

  
 

Click the Draw Trend Chart tool  and the cursor changes to:   
Click and drag on the GDW to draw a rectangle. When you release the mouse button a Trend chart is drawn 
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and the Trend Chart Attributes dialog box is displayed: 
 

 

 
 
This is used to choose what you want to display on 
the Trend chart and how you want it to look. 
 
Time spans for the chart range from 1 minute to 28 
days.  When the Page Print box is checked the 
SpecView screen will be printed each time the chart 
is filled with new data.   
 
Initially the Pens list is blank, click Add to add a Pen 
to the Trend chart 
 
 

 
A Pen is the word used to refer to a single trace line on a Trend chart. 
 
Open the variable list for the instrument from which you wish to display data by clicking the  symbol if it is 
not already open. 
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Double-click the variable you want to put on the Trend chart, then set the scale for this Pen by entering values 
in the Min: and Max: boxes. If you want to change the label for the Pen, change the text in the Label: box. 
 
NOTE: If the variable is NOT now listed under Pens, ensure that the variable was 
double-clicked in the list, not just single-clicked. 
 
Change the color of the Pen by clicking the Color button 
 
Click OK to close the Pen Attributes dialog box. Add some more pens to the chart, giving each a different 
color, then click OK to close the Trend Chart Attributes dialog box. 
 

Click the Save tool  to save this GDW again. 
 
To subsequently edit the chart while in Configuration Mode, double-click anywhere on the chart. 
 

  
 

 

Quick Start - Define a second GDW 
You have already saved the first GDW (Graphical Display Window).  

Now click the New GDW tool  to get a new blank GDW. 
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Click the Trend Chart tool  and draw a second chart. Any variables (see page 23) may be 
used, even the same ones as before.  
 
Also, many types of variable can be plotted on a Trend chart, including boolean (On/Off functions). 

Click the Save tool  and give this new GDW a name so it can be saved. 
NOTE: When SpecView enters Runtime mode it will normally start by opening the 
GDW last edited. To specify which GDW is opened on Runtime use the Set As First 
GDW menu command from the File menu while in Configuration mode. 
 

  
 
To open more than one GDW use the Auto-open on Runtime menu command. It is highly recommended that 
this feature is used for all GDW's that contain Trend Charts in order to start their trace lines. 
 

Quick Start - Add buttons to switch between GDW's 

To put a button on the GDW click the Draw Buttons tool .  
Draw the button by clicking and dragging the mouse until the button is the size and shape you require 

. 
Double-click the button to display the Button Attributes dialog box,  
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and change the text in the Caption: box to say, for example, "Return to first screen".  
Then from the Action: list, select GDW Control: Swap to another GDW, then select the name from the Swap 
To: list 

  
that you gave to the first GDW. 

Click OK to close the Button Attributes dialog box, then click the Save tool  to save this new 
GDW again. 

 
Open the first GDW by either 

clicking the Open GDW tool  and then selecting the name of the GDW from the list and 
clicking OK, 
or 
by selecting the name of the GDW from the Window menu. 
 

Click the Draw Buttons tool  and draw a button on this GDW. 
As before, double-click this button and change its attributes.  
Change the caption to say, for example, "Go to second screen". 
From the Action: list, select GDW Control: Swap to another GDW, then select from the Swap To: list the 

name that you gave to the second GDW, click OK.  Click the Save tool  to save again.  
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Quick Start - Add a Bar chart 
 
Adding a Bar chart to a GDW is very similar to adding a Trend chart. 

Click the Draw Bar Chart tool   and the cursor changes to   
Click and drag on the GDW to draw a rectangle as shown below. When you release the mouse button a Bar 
chart is drawn on the GDW  
 

  
 
and the Bar Chart Setup dialog box is displayed  
 

  
 
This is used to choose the variable you want to display on the Bar chart and the appearance of it. 
Select the variable you want to display from the variables list by clicking the  symbol next to the name of the 
instrument, if it is not already open, and then double-clicking on the name of the variable. 
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NOTE: If the name of the variable is NOT now shown on the right hand side of the 
Bar Chart Setup dialog box, ensure that the variable was double-clicked in the list, 
not just single-clicked. 
 
Orientation defines how the value is displayed within the bar chart; Vertical for up/down, 
Horizontal for left/right. 
 
Enter a Top Value and a Bottom Value. You can choose the color of the bar, whether the bar grows from the 
bottom up, from the top down, or both up and down. And in the Scales section of the dialog box you can also 
choose whether to display a scale for the Bar chart and whether or not to show the value numerically within 
the bar. 
 

Once you have made all the appropriate changes, click OK and then click the Save tool  
again. 
 
 

Quick Start - See how it works in Runtime mode 

Click the Enter Runtime tool  to see how the configuration you have just set up working in 
Runtime Mode.   
 
Your GDW screen should now look similar to this: 
 

  
 
The Instrument View, variable, Trend chart and Bar chart on the first screen of the GDW will be displaying 
data. 
 
Clicking on the button(s) shown within the Instrument View(s), in this example the PAR button, should 
perform similar actions to clicking on the respective buttons on the front of the actual instruments themselves.   
 
Clicking on the value of the variable, in this case 26.7:  
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could if the variable was writeable allow this value to be changed. However, as the variable "Input 1" is not a 
writeable variable this is not possible in this example. 
 
The Trend chart lines will initially be invisible. However, after a few moments the lines will start to be drawn 
depending on the time-span that was specified for the Trend chart when it was created. 
 
Clicking on the [Setup] button in the top right-hand corner of the Trend chart allows you to modify the Trend 
chart attributes. 
 
Clicking on the [Help] button in the bottom left-hand corner of the Trend chart will display help for the Trend 
chart attributes. 
 
Clicking on any of the Pen labels along the top of the Trend chart switches the vertical scale to match the 
scale that you defined for that Pen. 
 

Clicking on the  button will switch to the other GDW which you defined,  
which may look similar to this: 

  
 
CONGRATULATIONS! You have just created your own custom multi-screen supervisory system in just a few 
minutes. 
 
Now explore the Data Logging (see page 134) and (optional) Historical Replay (see page 142) features. Then 
you can go back into Configuration mode (see page 79) and explore the custom graphics (see page 90), 
Recipe (see page 199), Networking (see page 31) and other features of SpecView.   
 
Use the help system, by pressing the F1 key, to find out about SpecView's advanced features. 
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SpecView Networking 

Setting up SpecView Networking 
Further detail on all these steps is provided below, but in brief: 
On the Local: 
• Ensure the dongle connected to the Local has the Networking Option enabled for the required number of 
simultaneous remote users. 
• From Runtime Mode use the Preferences menu command from the File menu. Click the Remote tab and 
ensure that at least one of the checkboxes for Network & Modem are checked. 
• Use the User Setup command from the Remotes menu to setup username(s) and password(s). 
On the Remote: 
• On the Configurations Found dialog click Remote. 
• Click New and create a new connection. 
• Click Connect. 
To check all is working: 
Check instrument values are updating as expected 
On the Local use the View Connected Users menu command from the Remotes menu. 
 
SpecView Networking - Local (see page 31) 
SpecView Networking - Remote (see page 32) 
SpecView Networking - Runtime Functions (on Remote) (see page 36) 
SpecView Networking - Runtime Functions (on Local) (see page 37) 
SpecView Networking - Troubleshooting (see page 37) 
SpecView Networking - Minimum Requirements (see page 38) 
Connections for SpecView Networking (see page 6) 
 

SpecView Networking - Local 
 
A dongle (copy protection key) with the Networking Option enabled must be connected to the Local computer.  
 
The next step is to ensure that the required SpecView configuration has been created. Further detail on 
SpecView configurations can be found in the SpecView Users Guide. 
 
From Runtime mode use the Preferences menu command from the File menu. Click the Remote tab: 
 

  
 
Either one (or both) of the Modem and Network checkboxes must be checked. 
If both are checked then SpecView will 'listen' on both for remote connections. 
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Note that these will take effect immediately, you do not need to restart SpecView for changes on the Remote 
tab to take effect.  
 
The Timeout value is used in the event of a network failure. This is the number of seconds after which the 
connection will be dropped.  
 
The next step is to register the remote users. Use the User Setup menu command on the Remotes menu. 
Each user will be assigned a password and will be assigned either "Read Only" (Level 1) or "Read & Write 
Access" (Level 2). 
 
Read Only will prevent the Remote user from changing the values of variables on the Local. 
 

  
 
Click Add, or select the user's name and click Edit: 
 

  
 
Note that this is an extra security mechanism for Networking. It is independent of SpecView's Password 
system, which will continue to function on the Remote. 
 
SpecView will decide whether a variable can be changed on the Local, based on the Access Level setting for 
the Remote user (in the dialog box above) and SpecView's Password system. 
 
We recommend that careful thought is given as to whether Remote users can change (Write to) variables, as 
they could be some distance away and oblivious to the subsequent effects of their change. 
 

SpecView Networking - Remote 
 
The Remote computer(s) do not require dongles.  However, the dialogs displayed will differ based on 
whether or not a dongle is connected. 
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When SpecView Remote is started without a dongle, the user will be asked to run SpecView in either 
Remote or Demo mode: 

  
However, if a dongle is connected, the Configurations Found dialog box will have a Remote button: 
 

  
 
When Remote mode is selected the Connection dialog is displayed: 
 

  
 
The user can select which Local computer to connect to, or click New... or Edit... to create or modify a 
connection: 
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The Description can be any name. This name will be appended to the name of the configuration from the 
Local computer when the configuration is copied to the Remote. For example, if this name is "Production Line 
PC" and the configuration is called "Batch Run" then the name of the Local configuration once it is copied to 
the Remote will be: "Batch_Run_Production_Line_PC". This is to distinguish between identically named 
configurations copied from different computers. 
 
Network:  
Enter the IP address (or network name) of a PC running SpecView Local or click Browse. 
SpecView's default TCP/IP port number is 3413; it is recommended to use this, as it is registered with: 
http://www.iana.org/assignments/port-numbers 
and therefore should not conflict with other communications software running on the PC. 
 
To confirm the address is correct, click the Check button. 
The Check button will only check that the other computer is contactable over the network, it will not at this 
stage check to see if it is running as a SpecView Local. 
 
Modem: Select the Modem to be used from the list and enter the number to dial in the Call: box. 
 
Redial attempts: (Default: 1) The number of times the connection will be tried before giving up. 
 
Reconnect on fail: (Default: Off) Whether the connection will automatically try to reconnect if it fails. 
 
Timeout: (Default 25 secs) The number of seconds that SpecView Remote will wait for a reply from 
SpecView Local, before timing out. 
 
Inactivity timeout: (Default: 5 mins) In the event of a network failure this is the number of minutes after which 
the connection will be dropped. A value of 0 is not allowed. In addition:  
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Auto log off: (Default off) When checked, the user will be logged off after the Inactivity timeout period, if 
there has been no user activity, such as clicking buttons. 
 
When it is unchecked, the user will not be logged off, the connection will remain open indefinitely. 
 
This is useful if the Remote machine is likely to be left unattended. 
 
Update rate: (Default 2 secs) This is the rate at which the Remote will update from the Local. 
Reducing this time will increase network traffic, but will mean that the Remote will be more tightly in-sync with 
the Local. 
 
Packet size: (Default 1000 bytes) This is the maximum number of bytes sent between the Local and the 
Remote. Adjust this together with Packet count according to the type of network detailed below.  
 
Window Size: The entries for Packet size and Window size can be adjusted to give optimum  
response times over the network medium, as follows: 
 
For rapid transfer of data over a lightly loaded LAN connection, set Packet size to 8000 and set Packet count 
to 50. 
 
For a Direct Modem to modem connection, to allow a timely response to user-initiated activities, set Packet 
size to 1000 and Window Size to 5  
 
In the case of Dial-up Networking, where the medium is a 'LAN', but the underlying mechanism is a modem, 
use the Modem settings (1000 & 5) above. 
 
If you experience reductions in transfer rate, such as on a heavily loaded LAN, then  
a higher Packet count would be advisable, however, this will adversly affect the response  
time to operations like Parameter Downloads by the user. 
 
The minimum Packet count is 5 and the realistic maximum value is 500. 
 
User Name & Password: The user name and password to be used to connect to the Local.  
If these fields are left blank then the Username & Password will be prompted for when the connection is 
made, which is useful if many users will be using this connection. 
 
These will need to have been previously set up using the User Setup menu command on the Remote menu 
on the Local computer. 
Then click Save. 
 
Now clicking Connect on the Connections dialog will display the Network Status dialog: 
 

  
 
SpecView Remote will check to see if it already has a copy of the configuration which is running on the Local 
computer. There is the option of either copying the configuration which is running on the Local computer to 
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the Remote computer using the Update & Go Online button, or vice versa, using the Send Config back to 
local machine button. 
  
Full update takes the whole configuration, so that it can be worked on off-line at the Remote.  
 
A SpecView configuration can be created/modified on either computer. To do this on the Local computer 
SpecView's Configuration mode can be used directly. 
 
However, on the Remote computer, SpecView's Configuration mode is disabled, therefore, SpecView will 
need to be run in 'Stand-alone' mode. To do this, select the configuration and then hold the shift key down 
while clicking the Go Online Now button on the Configurations Found dialog box. 
 
Once the Update & Go Online button, or the Send Config back to local machine button has been clicked, it 
will then go on-line. Note that if the configuration is the same as it was last time then it will immediately go 
online, without the need to click a button. 
 
When a GDW is displayed on the Remote computer, the values of the variables on the GDW are sent from 
the Local computer. 
 
SpecView Local is able to process requests from multiple Remote computers simultaneously. 
 
The Local user will be unaware that a remote user is accessing it, other than by viewing the  
Remote Users Attached list, by using the View Connected Users menu command from the Remotes menu: 

  
 
Or via the Events Window, as the Event Logger will record all Network Login and Network Logout events and 
all values sent to the instruments by the remote user (Network Set Value). 
 
The reporting of these events can be disabled using the Event Logging menu command on the Setup menu. 
 

  
 

SpecView Networking - Runtime Functions (on Remote) 
 
The following will be 'seen' by other Remotes connected to the same Local computer: 
Changing values of variables being displayed on the GDW. 
Changes to Recipes using the Recipe Manager. These are only stored on the Local computer. 
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However, the following will not be 'seen' by other computers (Remotes or Locals): 

Swapping the GDW which is being viewed  
Changes to Trend chart(s), such as adding pens. Edits to Trend charts on the Remote will be overwritten the 
next time the connection is made. Therefore permanent changes need to be made on the Local. 
Viewing the Alarm/Event log windows. 
Viewing the Instrument Parameter List from the Instrument View. 
A restricted set of Preferences  
Converting a Logfile. This can be set up so that the resulting file will be written either to the Local or to a 
Remote computer. 
 

SpecView Networking - Runtime Functions (on Local) 
Certain functions are restricted to the Local computer, such as: 

Setting Users & User passwords from the Remote menu 
Displaying the View Connected Users dialog from the Remote menu. 
Going into Configuration mode. Note: This will disconnect all the Remote connections. 
 

SpecView Networking - Troubleshooting 
If you see the message "Local is not available or the connection failed."  
Then the following three checks should be made: 
1. Is the address (or network name) and port number right?  
To confirm this; on the Local, look at the title bar of the Remote Users Attached list, accessed by using the 
View Connected Users menu command from the Remotes menu. The address (or network name) and port 
number will be displayed in the title bar. Ensure this is what is being used by the Remote then click the Check 
button on the Remote to confirm it can reach the Local computer.  
2. Is SpecView Local running and is it in Runtime mode? 
On the Local has Networking been enabled? Ensure that, on the Local, at least one of the checkboxes for 
Network and Modem have been checked on the Preferences Remote tab. This is accessed by using the 
Preferences menu command on the File menu. 
3. Are there remote users setup (i.e. login names/passwords) and are there enough remote users setup? 
 
If you see the message "TCP/IP is not installed on this PC" and you are using 
Windows95  
Then the version of Windows Sockets (WinSock) will need to be upgraded to version 2.2 in order for 
SpecView to communicate using TCP/IP.  
To do this download the Sockets2 upgrade from: 

http://www.microsoft.com/windows95/downloads/contents/ 
wuadmintools/s_wunetworkingtools/w95sockets2/ 

 
If the Remote appears to be running slowly 
Then it is useful to look at the information on the Remote's Statusbar: 

  
The time is the time that the last updated value on the Local was updated, so this is the real data timelag. If 
this stops then there may be a network fault. The Tx and Rx show the data rate in kb (kilobytes) going across 
the connection. The Q shows the size of queue of data trying to be sent to the Local. If the queue size 
increases to above 20 then there may be a problem with sending data to the Local. 
The Local's Statusbar shows the same information as above, but for the total of communication with all 
Remotes. 
From the Local, using the View Connected Users menu command on the Remote menu, the dialog also has 
information about individual connections: 
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Note that the name of the computer and  port number are displayed in the title bar of 
this dialog. This can be used to check that these are correctly set on the Remote if 
there is difficulty making a connection. 
 

SpecView Networking - Minimum Requirements 
 
SpecView is a 32 bit Windows application that will run on Windows 95/98/NT/2000/Me/XP. 
 
Any computer that runs Windows and programs such as Word or Excel should run SpecView. A minimum of 
a Pentium with 64 MB RAM is recommended.  Normal SpecView activity does not put any great load on 
computer performance.  
 
For SpecView Remote the specification above applies.  
 
For SpecView Local, the number of simultaneously connected users affects the required specification. If there 
are going to be many, then more computer power is appropriate, hence at least a 400MHz Pentium processor 
would be required. 
 
It is almost impossible to exactly specify the requirements because the load on the computer is dependant on 
what the Local computer's configuration is, how much data it is acquiring, which screens the Remotes are 
looking at, how many Remotes are connected or what they are doing. Coupled with this are any Strategy 
Controller and Logging overheads. 
 
As a rough starting point, if the PC running SpecView already (before Local operation is enabled or used) is 
quick to respond in all areas, then a small number of Remotes should not impose any noticeable load. If the 
PC is already feeling 'slow', then it will be a little worse! 
 
The biggest single effect that may be seen is the situation where the data update rate on the Local PC 
appears to slow down when remotes are connected.  This will happen because one or more remotes may be 
asking for additional data across the Local PC's communications links to the connected instruments. This 
extra data means that the Local PC can only get data at a slower rate across saturated links. This can often 
happen if a remote user displays a large Parameter list, but the effect is no worse than a Local user 
displaying the same parameter list. 
 
It is important that the screen resolution of the Remote is comparable with that of the Local to allow the 
Remote to adequately display the contents of the Local's screen. 
 
For Windows95 the version of Windows Sockets (WinSock) will need to be upgraded to version 2.2 in order 
for SpecView to communicate using TCP/IP.  
 
To do this download the Sockets2 upgrade from: 
 
http://www.microsoft.com/windows95/downloads/contents/wuadmintools/ 
s_wunetworkingtools/w95sockets2/ 
 
Follow the instructions on the screen carefully, as there are several steps that need to be performed. 
 
Minimum Requirements for running SpecView (see page 192) 
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Starting SpecView and Instrument 
Definition/Detection 

Starting SpecView 
Double-Click the SpecView Icon to start the program, or run from Programs on the Start menu. 
 
If you do not have the copy protection key (called the dongle (see page 198)) connected then a dialog box to 
that effect will be displayed.  SpecView will be fully functional but a timer limits communication with the 
instruments to ten minutes.  This timer is reset each time configuration mode is entered. 
 
When SpecView starts up it displays a splash screen containing the logo and the Copyright.  This splash 
screen can be clicked on to jump to the Configurations Found dialog box (shown below). 
 

 
 
The Refresh button on this dialog box allows for the 
list to be refreshed to take into account any new 
configurations that might have been manually created 
after SpecView has been started. 
 
The Archive/Restore buttons allow you to Archive or 
Restore (see page 40)  entire configurations.   
 

 
If you have an existing configuration, which may be a demo configuration installed as part of SpecView, or 
previously Restored (see page 40), which you intend to run, then select it and click the Go Online Now! 
button, and continue from Runtime Mode - Using SpecView (see page 51)  

 
Alternatively, clicking either Test Comms for NEW config or New Manual Configuration will display the 
Input Required dialog box: 
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Enter a name for the configuration. SpecView will create a subfolder with this name in the SpecView folder 
(which is normally C:\SV32), the name you enter should follow the Windows file naming rules (see page 200) 
and should not be too long. 
 
Remember this name. This folder will be where all your log files and configuration files will be stored. Log 
Reports will also be stored here unless another folder is specified. 
 
Then continue from Instrument Definition/Detection (see page 41)  
 

Archive and Restore 

  
 
The Archive and Restore buttons allow you to Archive or Restore entire configurations.  This can be used for 
backup purposes, for sending configurations from one computer to another, or for technical support purposes. 
Archive 
SpecView creates a file known as a SpecView Archive, which has a filename extension of .SVA  
 
To create an Archive, exit from SpecView and run it again, then at the Configurations Found screen, select 
the name of the configuration to be archived and click the Archive button. 
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The default place (disk and folder) to create the archive is specified in Preferences - Runtime (see page 124).  
Use the Browse button to specify a different location. If the floppy drive is specified (A:\) and the configuration 
is too large to fit onto a single floppy disk, then the Archive process will automatically prompt for the additional 
floppies. Please ensure that you have a number of blank disks ready for use. 
Restore 
To Restore a SpecView Archive (.SVA)  file, start SpecView, then at the Configurations Found screen click 
the Restore button. 
 

  
 
Use the Browse button to locate the .SVA file to be restored. If the file is on floppy disk(s) then the Restore 
process will automatically prompt for them. 
 
NOTE: For that archives which use more than one floppy disk the restore process will ask for the last floppy 
of the set to be inserted first, then will ask for the floppies to be inserted in sequence. This is because certain 
information is written to the last floppy during the archive process, which must be read first during the restore 
process. 
 
Once restored, these configurations can, if required, be modified from Configuration Mode (see page 197). 
However modifications will only affect the restored Configuration folder, not the downloaded .SVA file, 
therefore the .SVA file can be considered as a backup which can be restored again if necessary. 

Instrument Definition/Detection 
The following sections describe in more detail how to setup SpecView to communicate with the instrument(s) 
either that you have currently connected see Auto Instrument Detection (see page 44) or which you intend to 
connect see Manually Defining Instruments (see page 41).  However, if you have already successfully done 
this then go to Runtime Mode - Using SpecView 

Manually Defining Instruments 
Instruments can be defined manually if they: 
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1 Are not physically connected to the computer for auto detection 
2 Are a special instrument that cannot be auto detected, 
 for example, Red Lion, Dupline and Omron. 
3 Are being added to an existing configuration 
 
For 1 and 2: 
 
After you have started SpecView click the New Manual Configuration button on the Configurations Found 
dialog box.  This will bring you directly into Configuration mode. 
 
For 3: 
 
Select your existing configuration and go directly into Configuration Mode (by pressing the SHIFT key while 
clicking the Go Online Now! button. 
 
Then continuing... 

Open the Variables List by clicking the tool  and then click the Show New button. 
The new list is displayed and the button changes to the Show Defined button. 
Click the appropriate  symbol and double-click the instrument you want 
 

   
 
Defining a new Instrument 
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1. Enter a name for the new Instrument 
2. Select the COM Port 
3. Enter the Address. For help click on Address 
Help.  
Modbus instrument addressing (see page 43)  
4. Click Create 
 

 
When all the new Instruments have been created click the Show Defined button to switch back to the 
defined Instrument Variables List 
 
You can now add an Instrument View  (see page 48) or individual numeric values  (see page 84) to the GDW 
 
Precautions Deleting and Creating Instruments 
When an Instrument  is defined in SpecView it is given a unique identity code (Unique ID) When any variable 
from that Instrument is used, SpecView identifies it by the Unique ID, NOT by name.  
NOTE: If an Instrument is deleted IT IS GONE FOREVER. All variables from that 
Instrument on GDW's, in Logging, on Trends will no longer be updated. 
Defining another instrument with the same name is NOT regarded by SpecView as the same Instrument, Be 
Careful. 
 
Adding Instruments to the Database 
Special configuration tools are used to define the database. These are available, for some drivers only, to 
qualified users. 
It is not possible to add variables to defined instruments from within SpecView. The configuration tools are 
required.  For help with this contact your SpecView supplier. 
 
This is now configured as if the instrument was connected and you had chosen Automatic Configuration by 
clicking the Test Comms for NEW config button.   
 
Therefore you can now skip the next section, and go straight to Configuration Mode  (see page 79) below.  
 

For Instruments using the Modbus Protocol 
 
If the instrument you are using uses Modbus protocol you need to know how the instrument is configured. 
If there is a choice between Modbus or J-Bus protocol choose J-BUS 
If there is a choice for Data Bits choose 8 (EIGHT) 
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If there is a choice for Parity choose NONE 
If there is a choice for Stop Bits choose 1 (ONE) 
The format of the address specification for Modbus is: 
AA,PT;O 
Where: 
AA: Two-digit address of the instrument in decimal. 
P: Number of decimal places for user defined items (see Note 1 below). 
T: Type of protocol: J for J-Bus, M for Modbus (see Note 2 below). 
O: (Optional) Address offset (see Note 3 below). 
Examples: 
1,1J Address 1, 0 decimal place, J-Bus parameters 
2,1J;2 Address 2, 1 decimal place, J-Bus parameters, offset by 2 
10,0M 0 Decimals, Modbus parameters 
 
Note 1 (Decimal Places): 
0 / 1 / 2 / 3 SpecView will put a decimal place in the position indicated by this setting. The setting affects 
those variables where the number of decimals required is based on an instrument setting such as the range 
that has been selected. Some items, such as Output Power are fixed at a given number of decimal places 
and are not affected by this setting. 
AutoDetect may assume 0 decimal places when detecting instruments.  This might result in values being 10 
or 100 times too large on displays.  If this is the case, then edit the address for the instruments from AA,0T to 
AA,1T (See below for the meaning of this). 
 
Note 2 (Protocol):  
If in ANY doubt, do not enter anything for this item. SpecView will add it for you. 
There is often confusion between Modbus "Registers" and "Addresses". With SpecView the user does not 
need to fully understand the difference but the correct setting MUST be made here. When "J" (for J-Bus) is 
used the "Address" that has been pre-defined by SpecView is sent to the instrument. When "M" (for Modbus) 
is used ONE is subtracted from the pre-defined address. SpecView pre-defined instruments ALWAYS 
assume the address and NEVER the register. Unless advised otherwise by SpecView either leave the letter 
out or use "J". 
 
Note 3 (Address Offset): 
Some instrument companies use an address structure so that a particular instrument view can be re-used 
with the appropriate address offset. This feature is also used with SpecView's "Generic Modbus" instrument 
views. The addresses for each instance of the instrument are the same, offset by a fixed number. See 
Generic Modbus for more details. Also, where this feature is required for a specific instrument, refer to the 
help for that instrument. 
For Instruments using Modbus TCP/IP 
The address, as detailed above, is prefixed with the full IP address followed by a colon. 
For example: 192.168.1.99:1,2J 

Automatic Instrument Detection 

Auto Detection - Overview 
What does "Automatic Instrument Detection" mean? 
Conventional supervisory systems require you to define each variable that you want to access from your 
computer.  Many instruments have an "Instrument Identity" code that SpecView asks for.  When the 
instrument responds SpecView uses its built in database (see page 41) to create an "Instrument View" that 
gives access to everything.  Some instruments have hundreds of parameters.  In larger systems this can 
mean tens of thousands of tags.  Defining this manually could take weeks. 
 
Click the Test Comms for New Config button, to detect your instruments automatically.  
The Input Required dialog box is displayed. 
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Enter a name for the configuration. SpecView will create a subfolder with this name in the SpecView folder 
(which is normally C:\SV32), the name you enter should follow the Windows file naming rules (see page 200) 
and should not be too long. 
 
Remember this name. This folder will be where all your log files and configuration files will be stored. Log 
Reports will also be stored here unless another folder is specified. 
 
When you have entered a name for the configuration and clicked OK, the Ports and Protocols dialog box is 
displayed. 
 

  
 
Either select the protocol required for the COM port or use TCP/IP Auto Detection (see page 46) which is 
available for some types of instrument. 
 

Auto Build GDW View 
When this box is checked an Instrument View is created automatically for each instrument found. 
Do NOT use this feature if you: 
• Have more instruments connected than can fit on one screen 
• Intend to rename your instruments 
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Instead: 
• Let SpecView detect your instruments 
• After scanning all ports click Stop which will enter Configuration Mode 

• Open the Variables List tool   
•  Rename each instrument and add Instrument Views to the GDW(s) as required 
 
Click Start Scan (see page 46)  
 

Start Scan 
 

Click   
When there is an Instrument View displayed on the GDW for each of the instruments which are connected 

then click the   to stop the automatic scanning.   Or if you have instruments on other COM ports 
then click the Skip to Next Port button to continue scanning on the next COM port. 
 
There is also auto detection for TCP/IP (see page 46) 
 
If you encounter problems then check your wiring and instrument setup (see page 5)  
 
This is now setup.  Therefore, you can now go straight to Configuration Mode (see page 79) below.  

 

TCP/IP Auto Detection 
TCP/IP Auto Detection for instruments connected via TCP/IP works only with Instruments supporting 
ModBus/TCP, either natively or via an Ethernet Bridge. 
 
Native instruments are: 
• ModMux MMTCP-xxx range 
• Honeywell HC900 
• Honeywell TrendView Recorder 
• Eurotherm Chessell 5000 recorder 
 
Ethernet Bridges allow any Modbus RTU device to be communicated with by Modbus TCP/IP. Some 
examples of these Bridges are: 
• ModMux TCPCONV 
• Lantronix CoBox 
• Honeywell Ethernet bridge 
 
The Modbus protocol specifies a "Slave Address", for RS422/485 devices, this is the address of the 
instrument over comms. For ModBus/TCP, the slave address is still relevant in the following cases: 
 
For native instruments, there is only one slave address per IP Address because there is only one instrument. 
In this case the "Slave Address" is usually 1. 
 
For Bridge connected instruments, there can be up to 255 discrete Modbus Slaves connected through the 
one IP addressed bridge, so the Slave Address has the usual meaning. 
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In SpecView's Autodetect setup we can specify a start and end IP Address. SpecView will start at the 
beginning IP Address and scan Slave addresses 1 to 255 on that IP address before moving to the next IP 
address. 
 
In the case where each IP address is a native ModBus/TCP instrument this scanning can be unnecessary, as 
there is only ever one Slave Address to be found. In this case the [Skip to Next IP] button can be used in a 
similar way to the existing [Skip to Next Port] button.   
 
It is useful to think of each IP Address as a separate COM port, where it is clear that there is only one 
instrument attached to a port then looking for 254 more is not required. 
 

  
 
Firstly, if all the instruments to be autodetected are accessible via TCP/IP then set the Protocol for all the 
COM ports to <None>. 

 
Protocol: 
Select the relevant protocol for one of the instruments to be detected. 
 
Port: 
The 'port' field should be left as 502 unless there is a specific reason to change it. Port 502 is the standard 
Modbus TCP/IP port. 
 
Timeout: 
Due to limitations inside the ModBus TCP/IP protocol and the Internet in general, scanning for Slave 
Addresses on a single IP Address can take a long time. The 'Timeout' field is used to control this. For a LAN, 
the default of 5 seconds is suggested, meaning that one slave address per 5 seconds is tested. For testing 
across the Internet, a value higher is recommended, such as 25 seconds. 
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Begin: and End: 
The Ending IP Address is set to the same as the start address by default, this allows for quick scanning of a 
single IP addressed native instrument or a string on a single bridge. 
 
The Honeywell HC900 Autodetect is pre-set as there can only be one Slave Address on any given IP 
Address, so it will always skip to the next IP Adreess (if any) when an HC900 is found. 
 

Click  once the instrument view(s) have been displayed on the GDW (which may be behind the 

Ports and Protocols dialog box) then click   The following dialog will be displayed: 
 

  
 
to finish scanning for instruments click OK. To scan for more instruments click Cancel. 
 
Once this process is complete Autodetect cannot be used to add further TCP/IP instuments to this 
configuration. It is necessary to either add additional instruments manually (see page ...). If the autodetect 
scanning is required to confirm the exact address for instrument(s) then create a new configuration and 

autodetect them. Then using the Variables List   tool select the name of the instrument 
then click Properties. The address field will show the exact address to use to manually (see page ...) add that 
instrument to a pre-existing configuration. 
 

Add/Rename Instruments 
To change the name and/or address of an Instrument OR 
To add an Instrument View to the GDW 

Open the Variables List b clicking   on the toolbar,  then 
• Double-Click an instrument name in the Variables List OR 
• Single Click an instrument name and click Properties OR 
• Right Click an instrument name in the Variables List 
 

  
 
NOTE:  The names of existing Instrument Views will NOT be changed. To get an 
Instrument View with the new name, click Add to GDW and delete the existing 
Instrument View on the GDW by selecting it and pressing the Delete key. DO NOT 
CLICK THIS DELETE BUTTON. 
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Decimal Points 
Some protocols (examples include Modbus (see page 43), Red Lion and Yokogawa Green Series) do not 
provide the computer with information about decimal points. Therefore when SpecView auto detects 
instruments it will assume NO decimal places for Modbus and Red Lion and ONE decimal place for 
Yokogawa Green series.  
 
Some instrument values are known by SpecView to require a decimal point and this will be added 
automatically. Other instrument values MAY need one or more decimal points depending on how the 
instrument is configured. These values take their decimal point requirements from part of the address (see 
page 43) details.  
 
When you start SpecView, if the reading is ten or a hundred times too big/small (for example,  
123.4 instead of 1234), then you will need to edit the instrument address. 
 
To change the decimal places for a specific variable on a GDW use the Dynamic Attributes (see page 86) 
menu command. 

 
Name (of Instrument) 
Names can be any length and include spaces and special characters (# : ; * etc.) 
NOTE: Do not make them too long. That will make list boxes very wide. 
 
Port 
Select the communications port (COM1 to COM9) that this instrument is (to be) connected to. 
 
Address 
Type in the address for this instrument. Click Address Help if you are not sure. 
 
Add to GDW 
Click this button to add an Instrument View to the GDW. Any changes to Name, Address or COM Port are 
also saved. 
 
Help for Instrument / Address 
Help for your instrument(s) may be included if provided by the instrument manufacturer 
Address Help  will detail how to define the address SpecView uses to communicate with this instrument. 
 
Rename Only 
Saves any changes made to Name, Address or COM Port without adding a new Instrument View to the 
GDW. 
 
Delete Instrument 
NOTE: Please read Precautions Deleting Creating Instruments under Manually 
Defining Instruments (see page 41) before deleting Instruments 
 
Clicking the button will delete the Instrument.   
 
To continue with Configuration go to Configuring SpecView (see page 79) 
If you have the configuration the way you want it go to Runtime Mode - Using SpecView (see page 51) 
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Using SpecView 

Runtime Mode 
Click the Go Online Now! button to go into Runtime Mode (see page 199) with the highlighted configuration. 

  
 
This will happen automatically when the countdown ends. Click the Stop countdown button to cancel the 
countdown. 
NOTE: To go directly into the Configuration Mode (see page 79)  of the highlighted 
configuration, press and hold the shift key while clicking the Go Online Now! button 
Actions are initiated by clicking on an object (variable, Bar chart or button) on the GDW, double-clicking on a 
variable in a Parameter List or by using the Runtime Menu (see page 58) 
• GDW's (see page 79) are communicating with the instruments 
• Current or Historical Data is displayed on the GDW 
• Data Logging (see page 134) is storing values for use in Log Reports 
• Recipes may be selected, edited, saved and loaded 
To change a value click the one you want to change. For example, click the 390 Set Point for zone 2 
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During Runtime the values of variables can be changed by any of the following: 
The instrument 
The user via data entry (see page 52) 
Strategy Controller or Button actions (see page 160): 
     Parameters: Alter Value Interactively   
Parameters: Copy From… To    
Parameters: Download Specific Value    

Parameters: Math Function    
Recipe: Download Specific Recipe 
DDE (see page 168) 

Data Entry 
Any writeable variable's  value which is displayed on the GDW can be changed by just clicking on it 
 
See: 
Data Entry Numeric (see page 52) 
Data Entry Text (see page 54) 
Bar Chart Setup (see page 112) 
 

Data Entry - Numeric 
Used for changing numeric values on the GDW 
 



Using SpecView       53 
 

  
The current value is shown which is used as the start point for the new value 
To change the value: 

Click the  buttons OR 

Use the numeric keypad and then click   
NOTE: Each time you click the up/down buttons the new value is sent to the 
instrument.   
Time variables are entered in the selected format  or   
If you make a keypad error click the Erase button: the current value will be re-read into the New Value field. 
If the value is not accepted by the instrument an error code will be displayed. Check that a valid number is 
being sent. 
Error Codes (see page 174)  
 
Decimal Places 
To change the decimal place resolution of the value sent with each up/down click and select from the list: 

  
To permanently change the decimal places of a numeric variable edit the Dynamic Attributes (see page 86) of 
the variable. 
 
Auto Close 
To speed data entry check the Auto Close box 

  
This applies to all data entry boxes 
The box will close automatically when SpecView gets confirmation that the entry has been accepted. 

Data Entry - Boolean 
Click the button required 
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To change the wording on the buttons edit the Variable Properties using the Variables List tool 

  
Error Codes (see page 174) 

Data Entry - Enumeration 
Used when there are several choices of discrete settings 

  
Double-Click (or single-click and click Send) on the required value 
NOTE: Some instruments immediately change the data back to a default setting. This 
will cause a write error. Check to see whether the instrument has accepted the 
expected result.  If not, maybe the wrong number of decimal places have been 
entered. 
Error Codes (see page 174) 

Data Entry - Text Strings 
Fixed text cannot be edited. Text variables from instruments and SpecView Text User Variables can be edited 
in Runtime mode. 
Click the text to edit: 
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Click the Keyboard button to use an on-screen keyboard 
When the text has been entered click the Send button 
Error Codes (see page 174) 

Data Entry - Date and Time 
Date and Time variables from SpecView Date and Time User Variables can be edited in Runtime mode. 
Click the Date and Time to edit: 
 

  
 
This dialog box shows entry of both Date and Time, there are also dialog boxes for entering the Date and 
Time separately, as shown below: 
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When the Date and/or Time have been entered click the Send button 
 
If an error occurs see: Error Codes (see page 174) 

Parameter List 
The Instrument View on the GDW is a representation of the instrument itself and as such the buttons on it 
have similar functions.  
 
Typically one of the buttons on the Instrument View  will display the complete Parameter List showing the 
values for all the variables for the instrument. 
 
The particular button on the Instrument View  that displays the Parameter List depends on the specific 
instrument, so some experimentation may be needed. 
 
Once the Parameter List is shown, if some of the parameters appear to be missing then it may be because it 
is just the abbreviated list of frequently required variables. To display the full list use the Options Menu and 
select the Short List menu command. All the parameters will appear. Click again to toggle back to the short 
list mode. 

 
The Full Names check-box on the dialog box switches between a mnemonic and full name mode 
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To change a value: 
• Single-click a variable and then click Alter OR 
• Double-Click a variable 
 
Click the Print… button to save the file to disk for future printing. To send the file directly to the printer use the 
name of the printer, for example LPT1: as the filename. 
 

Trend Charts 
 

  
 
To see the scale of any Pen, click the label; for example, Zone 2.PV.  However, this will only become 
noticeable if the Pens have different scales.  This can be made more obvious if the Pens have different 
colors. 
Cursors (the vertical lines) are used to display exact times and values 
To edit the chart click [Setup] (see page 108) 

Trend Chart Cursors 
These are the vertical lines which appear on the chart. 
Single-click anywhere on the body of the chart to get a cursor. 
Click the cursor time(s) to remove the cursors 
The time at the cursor is shown and the numeric values under the labels show each value at that time: 
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Double-click the chart and a second cursor appears. The time between the cursors is shown and the numeric 
values change to the difference in value between the cursors: 
 

  
 
For further details on Trend charts (see page 108) which includes adding horizontal grid lines. 

Runtime Menubar 

Runtime Menus 

  
 
Accessed from the Enter Runtime Mode menu command on the Configuration Mode's File menu (see page 
66). 
 
See: 
File Menu (see page 59) 
Logging Menu (see page 60)  
History Menu (see page 60) 
Recipe Menu (see page 61) 
Alarm/Event Menu (see page 61) 
Password Menu (see page 61) 
Remotes Menu (see page 62) 
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Options Menu (see page 62) 
Zoom Menu (see page 63) 
Window Menu (see page 64) 
Help Menu (see page 64) 
 

File Menu (Runtime) 
 

  
 
Open  
Use this command to open a previously saved GDW 

  
 
Close  
Closes the current GDW. This is the same as the SpecView: Exit Program (see page 105) button attribute. 
Configuration Mode  
Switches to the SpecView Configuration Mode (see page 197)  
Preferences  
Shortcut: Ctrl + E 
Displays the Preferences (see page 124) dialog box. 
 
Print  
Shortcut: Ctrl + P 
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Click the OK button to print the current screen (GDW) to the printer shown. 
 
Print Setup  
NOTE: Landscape mode is recommended for GDW's containing Trend charts 

  
Use this dialog box to select and setup the printer. 
NOTE: To change the default settings use the printer setup in Windows Control 
Panel  
 
Exit  
Shortcut  Alt + F4 
Exits (closes) SpecView 

Logging Menu 

  
Logged data is converted into Log Reports (see page 137) using this menu command  

History Menu 
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This menu starts Historical Replay (see page 142)  

Recipe Menu 

  
Use this menu to open the Recipe Manager for this GDW. See Recipes (see page 114)  
The Recipe Manager can be displayed by the Recipe: Show Recipe Manager (see page 105) button attribute. 

Alarms Menu 

  
 
Use this menu to display the Alarm Window which list the Alarms (see page 86) which have occurred. 
When the Alarm Window is displayed it can be resized. SpecView remembers the last position and size. If the 
Alarm Window is not visible use the Reset Window Position menu command. 
The alarm list can be displayed by the Alarms: Show Alarm List (see page 98) button attribute. 
 
The Alarm Window can be disabled using the Preferences - Alarm (see page 126)  
However, the Alarm Window can be viewed from the Alarm/Event menu when desired. 
NOTE: that with the Alarm Window set to not pop-up, there is no other indication 
from SpecView that the alarm has occurred.  Use the SpecView.NewAlarm variable or 
your own variables to warn the user by some other means. 
 
The Alarm Window position can be re-set using the Preferences - Settings (see page 127)  
 
View Alarm Window 
Use this menu function to display the list of current and old alarms. 
 
Reset Window Position 
If the Alarm Window has been dragged off the screen use this menu command to reset the position. The 
Alarm window position can also be reset using Preferences - Settings (see page 127) 
 
View Event Window 
Displays the list of events recorded by SpecView 
The Event list can be displayed by the Events: Show Event List (see page 99) button attribute. 
 

Password Menu (Runtime) 

  
Use this menu to Log In to SpecView with a Password. 
Password Log In can be accessed by the Password: Log In or Log Out (see page 104) button attribute 
Log In / Log Out 
Select the user from the list and enter the password 
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For setting up passwords in Configuration mode see Passwords  (see page 130) 
 

Remotes Menu 

  
 
Further details Specview Networking - Local (see page 31) 
 

Options Menu 

  
 
Short Param List  
This menu command toggles the parameter list on Instrument Views (see page 198) between Short List and 
Full list modes. Full List mode lists ALL the parameters for the instrument, whereas Short List mode displays 
just some of the most frequently used parameters. 
NOTE: Full List mode is not the same as the Full Names checkbox on the Parameter 
List (see page 56) dialog, which toggles between Full variable names and 
abbreviated variable names. 
Access to the Full Parameter List can be restricted by Password Log In Level (see page 130) 
 
Setup COM Port 
Displays the COM Port Setup dialog box and allows the COM port(s) settings to be changed during Runtime. 
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Toggle DEBUG on COM1 
Enable/disable debug information on COM1 by setting the driver command: DEBUG=1 
It is not recommended to change this setting unless under the direction of a SpecView representative. 
 
Toggle DEBUG on COM2 
Enable/disable debug information on COM2 by setting the driver command: DEBUG=1 
It is not recommended to change this setting unless under the direction of a SpecView representative. 

 
 

Zoom Menu 
 

  
 
Up  
Enlarge the size of the graphics & text within the GDW. Repeatedly selecting this keeps on enlarging. 
 
Down 
Reduce the size of the graphics & text within the GDW. Repeatedly selecting this keeps on reducing. 
 
100% 
Restore to the original size. 

 
NOTE: Do not click the Trend chart cursors (vertical lines) when zoomed 
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Window Menu (Runtime) 

  
Cascade and Tile commands are standard Windows commands to arrange open Windows. 
Arrange Icons has no function in SpecView. 
Select any open GDW listed to switch to that  GDW. 

Help Menu (Runtime) 

  
 
SpecView Help 
This menu command starts SpecView's help system and displays the contents page. 
 
Using Help 
Starts the help system for Windows, which will explain how to use the help system for maximum 
effectiveness.  
About SpecView 
 

  
Displays the SpecView version and build information. Click Release Notes for the details on this version.  
 
If you need to contact SpecView's Technical Support (see page 188) you may be asked to click the 
Technical Information button to provide further details of your specific installation. 
 
Registration Info 
Displays the serial number and status of the SpecView Dongle. 
This dialog box is used to upgrade the Dongle. 
Click Enable Further Options  (see page 176) to upgrade the dongle 
 
Release Notes 
Details changes made to SpecView such as new features and fixed problems. 
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Configuring SpecView 

Configuration Menubar 

Configuration Menubar & Toolbar 
 

  
 
Accessed from the Configuration Mode menu command on the Runtime Mode's File menu (see page 59). 
 
The configuration menus and menu commands are individually described below.  However, for detailed 
information on how to configure SpecView see Configuring SpecView (see page 79) 
 
See: 
File Menu (see page 66) 
Edit Menu (see page 68) 
Draw Menu (see page 70) 
Object Menu (see page 71) 
View Menu (see page 72) 
Passwords Menu (see page 74) 
Setup Menu (see page 74) 
Window Menu (see page 77) 
Help Menu (see page 78) 
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File Menu (Configuration) 

  
 
New 
Shortcut: Ctrl + N 

Toolbar:  Opens a new blank GDW  
Instrument Views and Variables can now be added to this new GDW by clicking on the Variables List tool  

  and a button can be used to swap between GDW's at Run Time as is described in the 
Quick Start Guide. 
 
Open (Configuration) 
Shortcut: Ctrl + O 

Toolbar:   Opens an existing GDW. Same function as File Open (Runtime mode) (see page 
59) 
 
Close (Configuration) 
Closes a GDW  
 
Save 
Shortcut: Ctrl + S 

Toolbar:   Saves a GDW This will save all changes made. 
NOTE: There is no "Replace Existing?" warning dialog box, so to save as a different 
name use Save As…  on the File menu.   
 
Save As 
Saves a GDW with a new name. This is useful if you want to make an exact copy of a GDW and then edit the 
variables. 
Editing Dynamic Attributes (see page 86) 
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Set As First GDW 
This only applies where a configuration contains more than one GDW. 
Click this menu command to make this GDW the first window when entering Runtime mode. 
If this is not set, then the last GDW to be edited will be the first one opened when entering Runtime mode. 
Auto-open on Runtime 
Click this menu command to tell SpecView to open (start) this GDW when entering Runtime mode 
NOTE: Be sure to click this menu command if the GDW has a Trend chart. If you do 
not, the GDW will have to be opened in Runtime mode before the Trend chart will 
start to be drawn. 
 
Enter Runtime Mode 

Toolbar:   Exits Configuration Mode and enters Runtime mode. You start communicating 
with the connected instruments. 
 
Preferences 
 
Shortcut: Ctrl + E 
Click this menu command to display the Preferences dialog box (see page 124) to modify SpecView's 
settings. 
 
Print (Configuration mode File menu) 
Shortcut: Ctrl + P 

Toolbar:   Prints the current GDW. Use the Print Setup menu command to change your printer settings.  
 
Print Preview 
Previews the printed page 
 
Print Setup (Configuration mode File menu) 
Use this to change the printer settings, such as using landscape format. 
 
Print to JPG 
Prints the screen to a .JPG (Jpeg format) file. 
 
Recently Used File List 
Shows the four last GDW's that were edited. Clicking on one will open it. 
NOTE: If the GDW was in another configuration all dynamic links will be removed. Do 
not open a GDW from another configuration unless you only want to use the 
background. 
 
Restart SpecView 
Restarts SpecView as if the user had exited and started it again. 
 
Exit SpecView 
Shortcut: Alt + F4 
Closes all GDW's and SpecView. 
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Edit Menu 

  
 
Undo 
Shortcut: Ctrl + Z 
NOTE: Undo will only undo a move of an object.   
 
Cut 
Shortcut: Ctrl + X 
Cuts the selected object and puts in on the Window's clipboard 
 
Copy 
Shortcut: Ctrl + C 
Copies the selected object and puts it on the Window's clipboard 
NOTE: Do not copy Dynamic objects (Instrument Views, Trend / Bar charts or 
variables) as the Dynamic Attributes (see page 86)  will be lost. 
SpecView has a quick way to copy drawing objects - Quick Copy (see page 92) 
 
Paste 
Shortcut: Ctrl + V 
Pastes the contents of the Window's clipboard on the GDW. 
NOTE: The selection will be pasted into the same location on the GDW as the Cut or 
Copy was taken from. Hence copied items will be overlaid on each other and will 
need to be dragged into the correct position. Objects in front behind others (see 
page 92) 
 
Delete 
Shortcut: Del(ete) key 
Deletes the selected object(s) 
NOTE: Do not forget that SpecView does not support Undo for deleted objects. 
 
Replace 
If a GDW has been duplicated for use by another indentical instrument, then this function can be used to 
rename all the instrument variables on the GDW from, for example, "Furnace A"  to "Furnace B".  
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Select All 
Shortcut: Ctrl + A 
Selects all the objects on the GDW.   
NOTE: This is useful to find stray objects such as very small drawing objects put 
down by mistake. 
To de-select the objects just click the background. 
 
Properties 
Shortcut: Alt + Enter 
Shape Properties (see page 92) 
Edits - depending on the selected object: 
• Shape properties of a drawing object 
• Text attributes 
• Trend chart attributes 
• Bar chart attributes 
There is no function for grouped objects or Instrument Views  
 
Dynamic Attributes 
Shortcut: Ctrl + D 
NOTE: This is only relevant to values of variables displayed on the GDW during 
Configuration mode as XXX, not to the names of the variables or other objects (for 
example, Trend charts or bitmaps) on the GDW. 
Select the object by SINGLE clicking on it. Then use the Edit - Dynamic Attributes menu or the shortcut key. 
The Dynamic Attributes dialog box is displayed for the selected variable. 
 
Color Dynamics 
Shortcut: Ctrl + Y 
Select the object by SINGLE clicking on it. Then use Color Dynamics… from the Edit menu or the shortcut 
key. 
The Color Dynamics (see page 87) dialog box is displayed 
 
Insert New Object 
Displays the Insert New Object dialog box which allows items created by other Windows applications to be 
displayed on the GDW. 
 
Links 
Displays the Edit Links dialog box to allow items created by other Windows programs to be added to a GDW, 
for example, Excel spreadsheets. 
However, this menu command will only be enabled if the Link box was checked on the Insert New Object 
dialog box. 
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Object 
This menu command will only be enabled if an object has been inserted onto the GDW using the Insert New 
Object  dialog box, and that object is currently selected. 
It will then display a submenu with menu commands appropriate for that type of object. 

Draw menu 
These menu commands and Tools are used to draw graphics on a GDW 
You can also add Bitmaps (see page 94) (.bmp files) to a GDW 
If you are not familiar with standard Windows drawing functions please read Drawing Basics  (see page 90) 
 
Menu: 

  
 
Toolbar: 

  
 
These drawing functions are described in greater detail under Drawing Basics (see page 90) below, see: 
Select (see page 93) 
Line (see page 93) 
Rectangle (see page 93) 
Round Rectangle (see page 93) 
Ellipse (see page 94) 
Polygon (see page 94) 
Bitmap (see page 94) 
Text (see page 95) 
Button (see page 96) 
Trend Chart (see page 96) 
Bar Chart (see page 96) 
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Object Menu 

  
Line Color 
The word Line" applies to both lines and the outlines of the other drawing objects 
Changes the color of an already selected line AND chooses the color for all lines you draw from now on 
during this Configuration Mode session because the default values will be restored when exiting 
Configuration Mode. 
 
Line Thickness 
The word Line" applies to both lines and the outlines of the other drawing objects. 
Changes the thickness of an already selected line AND chooses the thickness for all lines you draw from now 
on. You can also get the Shape Properties dialog box by double clicking on the object. The default values will 
be restored when exiting Configuration Mode 
 
Fill Color 
Canges the fill color of an already selected object AND changes the fill color of all objects you draw from now 
on. The default values will be restored when exiting Configuration Mode 
 
Text Font 
Sets the default Text Font (see page 84) for text objects added to the GDW during this editing session 
The default values will be restored when exiting Configuration Mode 
 
Group 
Shortcut: G 

Toolbar:  and on the Object Menu:  
Objects may be grouped together for moving and saving 
Selecting, Grouping and Saving  (see page 91) objects 
 
UnGroup 
Shortcut: U 

Toolbar:  and on the Object Menu: 
A previously grouped object may be ungrouped for editing 
Select the object 
Click the UnGroup tool (or click this menu command) 
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Align Left/Top/Right/Bottom, Distribute evenly horizontal and vertical 
If a number of objects on the GDW are selected (but NOT grouped), then these menu commands will align or 
distribute the objects evenly. 
 
For align, all objects are aligned with the one furthest in the direction specified; for example, if a number of 
objects are Aligned Left, then it uses the left-most one to align all the others to. 
  
For Distribute, all the selected objects are distributed between the outermost two objects in the selection. 
 
Move To Front 
Shortcut: Ctrl + (numeric keypad) Plus 
Moves the selected object in front of ALL other objects 
Objects In Front / Behind others (see page 92) 
 
Move To Back 
Shortcut: Ctrl + (numeric keypad) Minus 
Moves the selected object behind ALL other objects 
Objects In Front / Behind others (see page 92) 
 
Move Forward 
Shortcut: (numeric keypad) Plus 
Moves the selected object up one layer 
Objects In Front / Behind others (see page 92) 
 
Move Back 
Shortcut: (numeric keypad) Minus 
Moves the selected object back one layer 
Objects In Front / Behind others (see page 92) 
 
Save Object 
NOTE: Do not include variables in saved objects  
Grouped Objects  (see page 91) may be saved for re-use 
Objects are saved in a file with the extension .gdo (graphical display objects) 
 
Load Object 

Toolbar:   
Loads a previously saved object 
 
Name 
Used for SpecView diagnostic purposes only 

View Menu 
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Grid Lines 
Shortcut: Ctrl + G 
Toggles the editing grid on and off. 
The purpose of the Grid is to help with alignment of objects when positioning them with respect to each other, 
as objects will appear to jump by the Grid Size setting (see below), which saves having to move the mouse 
quite so precisely. 
The Grid lines themselves are drawn at intervals of ten times the actual Grid size for clarity. 
 
Grid Size 
Changes the Grid spacing 
NOTE: If you are putting values in tables set the grid to a larger number than the 
default value of 5 before starting 
Enter the value for a new grid size. A larger number = a coarser grid. 
The Grid lines themselves are drawn at intervals of ten times the Grid size for clarity. 
Paper Color 
Changes the color of the GDW background 
NOTE: If you are going to print the GDW leave background as white to save ink 
 
Show Objects 
This toggles the highlighting of objects which have been inserted using Insert New Object… from the Edit 
Menu.   
 
Toolbar 
Toggles the Toolbar On and Off 
 
Status Bar 
Toggles the Status Bar (at the bottom of the screen) On and Off 
NOTE: Turning Off the Status Bar in Configuration Mode will hide it in Runtime mode 
 
Resize Screen 
If the GDW was created on a computer with a different screen resolution it will be necessary to resize the 
GDW to fit the current resolution. 
 
Resize 1024x768 » 800x600 
Resize 800x600 » 640x480 
Resize 640x480 » 800x600 
Resize 800x600 » 1024x768 
Resizes this GDW from the first resolution to the second 
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Variables and Instruments 

Toolbar:   
Toggles the Variables List On and Off  
 
Zoom 
Zooms the current GDW. This is useful for detailed editing and precise positioning of objects. 
 
Zoom 100% 
Returns the GDW to normal size 
 
Zoom 150% 
Zoom 200% 
Zoom 300% 
Zoom 400% 
Zoom 500% 
Zooms the GDW to the specified percentage of normal size 
 
Recipe Mode 
Toggles the Recipe Mode (see page 199) On and Off 
NOTE: You can also cancel the Recipe Mode by clicking the Right mouse button 

Password Menu (Configuration) 

  
These commands are detailed in Passwords (see page 130)  

Setup Menu 
 

  
 
Database - Show Logging in Variables List 
Shows, in the Variables List (see page 80), which variables are logged 
To add/delete a variable to/from logging 
 
NOTE: If the Show Logging in Variables List menu command is enabled, then the 
Show Alarm in Variables List menu command will be disabled. 
 

Open the Variables List (see page 80) by clicking  on the toolbar 
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The crosses show which variables are logged. Click the box to check/uncheck each one 
NOTE: To include ALL the variables on a GDW in logging see the "Set All items on 
this GDW as Logged" menu command from the Database submenu on the Setup 
menu (see page 74)  
 
See Disk Space for Logging (see page 136) for file size details, as logging more variables will increase disk 
space requirements. 
 
Database - Show Alarm in Variables List 
Shows, in the Variables List (see page 80), which boolean variables will be considered alarms when they 
become true. 
To add/delete a variable to/from alarm monitoring 

Open the Variables List (see page 80) by clicking    on the toolbar 
 

  
The crosses show which variables are Alarms 
Click the box to check/uncheck each one 
NOTE: Any boolean can be selected. If you want to be alerted when a loop has been 
put into manual mode you can check Auto/Manual. 
 
Database - List GDW Dynamics to CSV 
Used for SpecView diagnostics only 
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Database - Save Logging + Alarm Details 
Used for SpecView diagnostics only 
 
Database - Load Logging + Alarm Details 
Used for SpecView diagnostics only 
 
Database - Set All items on this GDW as Logged 
Adds ALL the variables on this GDW in logging. 
NOTE: Use this feature if you want to Historically Replay ALL the variables on this 
GDW 
To remove any unwanted variables from logging, use the Show Logging in Variables List menu command 
from the Database submenu on the Setup menu (see page 74) 
 
Export Variables List 
Exports a list of all currently defined variables and their properties to a .CSV (Comma Separated Variable 
format) file which can then be edited using Excel and saved again as a .CSV file, then subsequently imported 
using the Import Variables List menu command from the Database submenu on the Setup menu. 
 
This is useful if a large number of changes need to be made to the variables list. For example, some 
instruments have numerous data registers, which must be accessed indirectly using an address offset. These 
variables will then need to be renamed accordingly, for example, registers named with numbers D000 to 
D255 with an offset of 2560 will need to be renamed to D2560 to D2815 which can be done quickly using the 
features in Excel. 

 
Import Variables List 
Imports a list of all currently defined variables and their properties from a .CSV file which has been edited 
using Excel and saved again as a .CSV file. 
 
Event Logging 
Sets the actions and events, which will be included in the Event Log 

  
 
Strategy Controller 
Displays the Strategy Engine (see page 146) setup box 
 
Setup COM Ports 
Displays the COM Port Setup dialog box and allows the COM port(s) settings to be changed during Runtime. 
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Check COM Port 
Checks whether the COM Port is available and working. 
Does NOT check communications. The port MIGHT be a modem. 
 
Swap COM Ports 
This allows the COM ports for multiple instruments to be re-assigned without manually editing each 
instrument. 
 

Window Menu (Configuration) 

  
Cascade 
Standard Windows function to Cascade all open windows 
Tile 
Standard Windows function to Tile all open windows 
Arrange Icons 
This has no useful function with SpecView. (It is a standard Windows function and is not used by SpecView) 
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Help Menu (Configuration) 

  
 
SpecView Help 
Help Menu: This menu command starts SpecView's help system and displays the contents page. 
 
Using Help 
Help Menu: Starts the help system for Windows 
 
About SpecView 

Toolbar:   
Displays the SpecView version and build information. 

  
 
Displays the SpecView version and build information. Click Release Notes for the details on this version.  
 
If you need to contact SpecView's Technical Support (see page 188) you may be asked to click the 
Technical Information button to provide further details of your specific installation. 
 
Registration Info 
Displays the serial number and status of the SpecView Dongle. 
This dialog box is used to upgrade the Dongle. 
Click Enable Further Options (see page 176) to upgrade the dongle 
 
Release Notes 
Details changes made to SpecView such as new features and fixed problems. 
 
Technical Support 
For further information see contacting Technical Support (see page 188) 
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Configuring GDWs - Graphical Display Windows 

Configuring SpecView 
Here are the basic steps in setting up SpecView. The order can be changed to some degree and each step 
can be edited at any time. 
Firstly, you will need to select either Manual or Automatic Instrument Detection: 
1a.  Manual Configuration (see page 41) of instrument(s):  
 This is only required in the following cases: 

• If the instrument(s) are not physically connected to the computer for auto detection 
• If the instrument(s) are special such that they cannot be auto detected 
• If the instrument(s) are being added to an existing configuration 

 Define the instruments you are going to be using by clicking the Show New button to display the full list 
of available variables 

Or: 
1b. Auto Instrument Detection (see page 44)  
 
Then: 
2.  Add/Rename Instruments (see page 48) 
     Edit the names of each instrument if required. 
3.  Create your GDW(s) (see page 80) 
Define any SpecView User Variables required 
Create / Import any graphics 
Add Buttons to the GDW's to switch between them 
Put numeric values on the GDW 
Add Trend and Bar Charts 
4.    Add or remove any variables from Data Logging (see page 134) 
5.    Choose variables to be included in Recipe (see page 199) 
6.    Configure the (optional) Strategy Controller (see page 146) 
 

GDWs - Graphical Display Windows 
These are the screens you look at using SpecView. 
GDW's are created or edited in the Configuration Mode and used in the Runtime Mode 
Data is shown on a GDW in four ways: 
• Instrument Views  
• Numerically  
• As a Pen on a Trend chart 
• Bar Chart 
The Extruder Graphic shown below uses SpecView drawing tools to arrange data in an unambiguous way 
and shows both numeric values and Bar charts 
Creating and Editing GDW's (see page 80)  

Extruder Graphic 
This is an example of a graphic made with SpecView's drawing tools with both Bar Chart and Displays 
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For further information see: 
Creating / Editing GDW's (see page 80) 

Creating / Editing GDW's 
GDW's contain background graphics and variables 
Managing Instruments and Variables (see page 80) 
Menus and Toolbar (see page 65) 
Creating a background graphic (see page 70) 
Adding numeric values to a GDW (see page 84) 
Adding a Trend chart to a GDW (see page 96) 
Adding a Bar Chart to a GDW (see page 96) 

Variables List 
The Variables List is used to: 
• Define and/or edit connected instruments 
• Add Instrument Views and/or individual Numeric Values (see page 84) to the GDW 

Open the list by selecting Variables & Instruments from the View menu OR click  on the 
toolbar 
• Double-Click the name of an instrument to Rename or to put an Instrument View on the GDW 
• Click the  symbol to expand that instruments variables 
The list below shows the instruments defined in THIS configuration. To add more instruments (see page 41) 
click the Show New button to display the list of available instruments in the database. 
NOTE: Please read Precautions Deleting and Creating Instruments (see page 41) 
before deleting Instruments  
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You can resize and position the list. The size and position is remembered when you close the list. 
 
The position of the Variables List can be reset using Preferences - Settings (see page 127)  

SpecView Variables 
The first Instrument shown in the Variables List Variables List  is SpecView, these are the variables that exist 
only in SpecView but have all the same properties as other variables and can be; 
• Logged 
• Included in Recipes 
• On Trend / Bar Charts 
SpecView boolean variables are used as switches to control events in the Strategy Controller 
There are two kinds of SpecView variables, Pre-Defined and User: 
SpecView Pre-Defined Variables 
 
  
 
SpecView User Variables 
SpecView User Variables are variables that exist only in SpecView, not in the connected instruments. They 
are sometimes called Software Tags or Dummy Gates.  
Examples include: Text for "Batch Numbers", "Material ID" "Customer Name", Times for timers, log report 
start and stop times, booleans for automation. 
To define a SpecView Variable: 

Click the Variables List tol  and click the Show New button, then the  symbol next to 
"SpecView Variables" 
Double-Click the variable type you want to create 
 

  
 
Give the variable a name together with an initial value using the displayed dialog boxes. The initial value is 
only used when the variable is displayed on the GDW for the very first time, subsequent SpecView runs will 
use whatever was the last value of the variable. 
Click the Show Defined button and then the  symbol next to "SpecView" and your new variable will be 
listed under "User Variables" and then grouped by type.  Clicking on the  symbols will expand these lists. 
The user variable you have just created can now be added to the GDW in the same way as the instrument 
variables, by either double-clicking it or selecting it and clicking the Add Item button. 
 
Text Variables are used for text that is editable in Runtime mode 
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Time variables may have a value entered manually from a GDW, or have its value set by a Button Attribute or 
Strategy Controller Action (see page 97) 
DateTime and Date variables may only be set to current computer values using the Parameters: Download 
Specific Value (see page 102) button attribute 
 
The Countdown Timer may be written to as a time variable and it will count down from that value. 
NOTE: Countdown Timers are not stopwatches. They have no reset function or 
start/stop capability. They are always running towards zero from the last value set. 
They do NOT count when SpecView is not running. When SpecView is re-started 
they will resume from their last value. 
 
SpecView User Variable Names 
Enter a name for the User Variable 
It can be any length but shorter names are more manageable 

  
Use the Keyboard button to get an on-screen keyboard 
When you click OK you will be asked to enter a default value 
It is not possible to enter a default value for Date and DateTime variables 
 
Boolean default value box 
NOTE: You can change the names of the boolean states from On/Off to something 
more logical for your application by using the Properties (see page 84) of the defined 
variable.  

  
 
Number (with decimals) default value box: 
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Time default value box (and Countdown Timer) 

  
 
Text default value box: 
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Date and DateTime User Variables 
Date and DateTime user variables can only have the current computer date and time copied to them by using 
the Parameters: Download Specific Value (see page 102) button action in a Button Attribute or Strategy 
Controller Action (see page 97) 
 

Adding Numeric Values to a GDW 
NOTE: All numeric values are put on the GDW in the top left corner. Move objects 
out of the way before adding values, otherwise they all appear on top of each other.  

Remember you may need to group them using "G" or the Group tool      

Open the Variables List  by clicking    on the toolbar  
Remove the check mark from  if you DO NOT want the name included with the variable  
Click the  symbol by the Instrument you want 
 

  
 
Double-Click the variable you want to add to the GDW 

With Name:  Without Name:    
In either case, the XXX's will be the value of the variable in Runtime mode 
 
The text font and color will be that defined using Text Font menu command on the  
 the Object menu (see page 71) 
See Text Justification (see page 95) fo details on aligning text 
 
NOTE: When a variable is first displayed on a GDW the name of the variable and its 
value are separate objects with their own set of eight Handles to show they are 
selected. 
To move either of them drag from the middle of the object. 
To move both of them together see Selecting, Grouping and Saving (see page 91) 
objects. 

Variable Properties 
• Change the name of a variable parameter 
Add / Delete a variable from: 
• Data Logging 
• Alarm Checking (booleans) 
• Short List 
• Scaling (Real numbers) 
• On/Off Labels (booleans)  

Open the Variables List by clicking    on the toolbar,  then 
Single Click the variable name and click Properties OR right Click the variable name 
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Name Information 
Edits the names of variables such as alarms using the Variables Properties dialog box 
Example: Change "Alarm 1 Status" to "High Alarm" 
 
Attributes 
Edits the attributes of a variable using the Variables Properties dialog box 
Check the Logged box to add a variable to logging 
Check the Alarm box to have SpecView monitor this boolean as an alarm (see page 86); this option will be 
grayed-out if this variable is not a boolean. 
Check the Short List box to have the variable included in the Short List mode 
Checking all the "Apply to … All" boxes will change the attributes on the same variables of ALL identical 
instruments in the configuration. 
 
Scaling 
Scales a real number using the Variables Properties box 
Example 1 - Changing °C to °F: Enter 1.8 for scale and the offset to 32 
Example 2 - Scaling a variable that is returned un-scaled, such as 65535 (FFFF Hex). To scale to 0-500 units 
set Scale to 500/65535 ( 0.00763) and the offset to 0 
For a change like this it would also be appropriate to change the variable's name from, in this example, 
"Temp C" to "Temp F".   

Boolean Names 
On the Variable Properties (see page 84) dialog box 
Edits the names that appear on the boolean data entry box  
Enter the name for the 0 or Off state and for the 1 or On state 
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Alarms 
An alarm is a status flag within an instrument, which is typically set when a value goes beyond a setpoint. 
SpecView will display the Alarm dialog box and write an entry into the Alarm logfile when an alarm status is 
received from an instrument  

 
SpecView Boolean User variables (see page 200) can also be set to be alarms by selecting the boolean 
variable in the Variables List (see page 80), clicking the Properties button and checking the Alarm attribute 
checkbox. This will cause SpecView to display the Alarm dialog box and write an entry into the Alarm logfile 
when this boolean variable becomes true. 
 
Using the menu command Show Alarm in Variables List from the Setup menu (see page 74) causes the 
Variables List (see page 80) to indicate which boolean variables, both Instrument & User variables, have their 
Alarm attribute set. 
 
Alarms are configured using Preferences - Alarm (see page 126), by an action from a button or via the 
Strategy Controller (see page 146). To view the Alarm dialog window at any stage during Runtime, use either 
the Alarm/Event menu (see page 61) or the button action Alarms: Show Alarm List (see page 98) 
 
Using the Strategy Controller's Run External Program (see page 105) it is possible to launch a program when 
an alarm occurs, for example, one which pages the operator. 
 

Dynamic Attributes Dialog Box 
This is accessed from the Dynamic Attributes menu command on the Edit menu (see page 68). 
 

  
 
Dynamic Attributes - Variables 
The variable associated with an object on the GDW may be edited in this box. No variables list is presented to 
choose from, just edit the name. 
For example, If you want to make a GDW for Furnace 2 that is identical to Furnace 1 then… 
1. Use the File menu - Save As command to make a copy of the GDW 
2. Single click an item to select it 
3. Use the Edit - Dynamic Attributes menu OR the shortcut: Ctrl+D 
4. Edit the name Furnace 1.Setpoint to Furnace 2.Setpoint 

If the new name is not valid this box will appear:   
Check the spelling on the Variables List 
 
In Recipe / Level 
In Recipe is checked if this variable is included in this GDW's Recipe (see page 199)  
Removing the check WILL REMOVE THE VARIABLE FROM RECIPE 
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Adding the check WILL NOT PUT IT BACK. 
Variables can only be added to Recipe using the Recipe Mode (see page 114)  
The Level determines the order that the values will be sent to the instruments (see page 121).  
 
Scan Rate 

  
Sets the rate SpecView gets the value from the instrument. Use this setting to change the rate at which the 
value of a variable is read over communications. 
The times associated with the four settings are defined under the File Menu - Preferences (see page 124) 
 
Display Format 

  
Sets the number of decimal places used to display a numeric value on a GDW. 
Free means that the display will take the value reported by communications 
NOTE: Some instruments send data to SpecView with the correct number of decimal 
places identified. Others, such as Modbus, do not tell SpecView how many decimal 
places the variable has. The driver will have a setting in the address field to tell 
SpecView how many decimal places to use. This is accessed from the Variables List 
(see page 80) Add/Rename Instruments box 
 
The Edit Dynamic Attributes also allows for the setting of attributes from many objects in a selection (not a 
group). This allows quick changes of Recipe level or scan rate for a number of items. 

Color Dynamics 
This box allows you to setup how an object, button or grouped object will change color based on the value of 
a variable 
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 When this box is checked the outline color of the object will change to the 
selected color. Unchecked the outline color will stay the same. 
Up to four color changes per variable can be specified so that with the default fill color a total of five colors are 
available. 
NOTE: A different variable and test can be selected for each level. The last one 
defined will have priority over the others 
 

Insert New Object 
Accessed from the Insert New Object menu command on the Edit menu (see page 68). 
NOTE: Use this command with caution. SpecView can only offer limited support as it 
uses features outside our control. This command has been known to cause 
problems with SpecView. Make a backup of your configuration before proceeding.  It 
is particularly recommended not to use this for inserting bitmaps.  Use the 

 tool instead. 
 
SpecView does not allow you to access another program using this feature in Runtime mode so it should be 
primarily used for graphics objects.  
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This will insert a new object from another Windows program into the GDW. 
The box below inserts an existing object. 

  
 

Edit Links 
 
Accessed from the Links menu command on the Edit menu (see page 68). 
NOTE: Use this command with caution. SpecView can only offer limited support as it 
uses features outside our control. This command has been known to cause 
problems with SpecView. Make a backup of your configuration before proceeding 
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Drawing Basics 

Drawing Menu and Toolbar 
The Draw menu and Tools are accessed from the Configuration mode menubar. 
They are used to draw graphics on a GDW 
You can also add Bitmaps (see page 94) (.bmp files) to a GDW. 
 
Menu: 

  
 
Toolbar: 

  
 
See: 
Select (see page 93) 
Line (see page 93) 
Rectangle (see page 93) 
Round Rectangle (see page 93) 
Ellipse (see page 94) 
Polygon (see page 94) 
Bitmap (see page 94) 
Text (see page 95) 
Button (see page 96) 
Trend Chart (see page 96) 
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Bar Chart (see page 96) 
 
SpecView uses most standard Windows rules for drawing, see: 
Selecting, Grouping and Saving Objects (see page 91) 
Shape Properties (see page 92) 
Selecting objects in front or behind others (see page 92) 
Quick Copying of Drawing Objects (see page 92) 
 
NOTE: Do not use Cut, Copy and Paste (or Ctrl Copy) to move or duplicate objects 
that have variables. This includes Instrument Views, Trend and Bar Charts. 

  
Click the tool for the type of object you want 

The pointer will change to  OR   OR OR depending on the tool 
Click on the screen (and HOLD DOWN THE MOUSE BUTTON ) where you want the top left part of the object 
, and drag the mouse down and to the right .  
Release the mouse button when you have the size you want. 
NOTE: The POLYGON (see page 94) tool follows different rules from lines, rectangles 
etc. 
 
The cursor does not automatically change back to the pointer after you draw the object. Use the: 
Left mouse button to draw another object OR 
The Right Mouse Button to get the normal pointer (Select Tool) OR 

Click  on the toolbar  
 
Use the Shift key to: 
• Snap lines to vertical, horizontal etc. 
• Snap rectangles to squares 
• Snap ellipses to circles 
NOTE: Once drawn use the Handles to adjust the object 
• Use the corner ones to resize with the same aspect ratio 
• Use the corner ones while pressing the Shift key to change the aspect ratio 
• Use the side ones to adjust width/height 
Back to Draw Menu (see page 70) 

Selecting, Grouping & Saving drawing objects 

Use the Select Tool   OR the right mouse button to get the standard pointer 
 Click an object to select it 
To select (or de-select) multiple objects press and hold the Shift key and click the object(s) 
OR 
Click away from any object and drag the mouse while holding down the mouse button. 
All objects touched  by the dotted rectangle will be selected. 
NOTE:  SpecView draws an imaginary box around each object. Touching the object 
means touching this imaginary box. You may select objects (especially lines drawn 
diagonally) that you do not expect to be included. 
When more than one object has been selected they may be Grouped (Object Menu - Group OR  

  OR  "G") 
All objects Selected:  
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After Grouping: 

    
 
Objects in front/behind others (see page 92) 
  
Grouped objects may be saved and reused with the Save Object and Load Object menu commands on the 
Object Menu (see page 71) 

Shape Properties 
Double Clicking (or Alt+Enter) on an object will bring up the shape properties box 

  
Outline Weight changes the line thickness of the border. 0 = No Border 
Click the Fill box, to remove the check mark and to fill the object with the currently selected Fill Color 
Click again, adding the check mark to remove the fill color 
NOTE:  With no Fill, the object is transparent - you can see objects underneath. 
To mask objects, fill the object with the Paper Color. 

Objects in front / behind others 
Objects can be arranged in layers, one on top of another. If an object is masked by another, then 
it will need to be moved out of the way.  
 
The easiest way to do this is to select the one that is in the way and then use Move to Back or Move Back 
from the Object menu, which will reveal the one behind. 
 
However, an alternative way to select the object(s) underneath is to click the top object 
WITHOUT MOVING THE MOUSE  click again. The object underneath will be selected even though you might 
not be able to see it.  (If you hold the mouse button and drag, the object underneath will move) 
Subsequent clicks without moving the mouse selects successive layers down. 
This shows the second object selected:  
 

  

Quick Copying of Drawing Objects 
NOTE:  Do not use this feature to copy ANY objects with variables. This includes 
Trend and Bar Charts, Instrument Views or any grouped object containing variables, 
as the variable information will be lost. 
To make a copy of a drawing object (or Grouped object): 
1. Press and hold the Ctrl key 
2. Click the object and STILL HOLDING THE LEFT MOUSE BUTTON 
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3. Drag the mouse 
A copy of the selected object will be made 
To copy an object between GDW's use either: 
• The Edit menu (Cut, Copy, Paste) OR 
• Ctrl + X (Cut), Ctrl + C (Copy), Ctrl + V (Paste) OR 
• The Object menu (Save / Load Object) 

Select Tool 

Use the Select menu command from the Draw menu (see page 70) OR click   
Go to Drawing Basics for general instructions (see page 90) 
Selects the normal Pointer (or Cursor) and de-selects any drawing tool. 
NOTE:  The right mouse button has the same action as this function. It is a useful 
and quick way to de-select a drawing tool. Try drawing a rectangle and then click the 
right mouse button. 
Click an object to select it.  

 Eight Handles show that the object is selected. 
Moving the pointer to one of the handles allows you to re-size the object.  

Line Drawing Tool 

Draw menu -  Line OR   
Go to Drawing Basics for general instructions (see page 90) 

The cursor changes to  Click and hold the left mouse button, then drag the line to the desired length and 
direction. Click the right mouse button when you have drawn all the objects you want. 
Press and hold the shift key to snap the line to regular angles 
Use the Ctrl Copy feature to make exact copies of the object 
Double-Click the object to edit the Shape Properties 

Rectangle Drawing Tool 

Draw menu - Rectangle OR    
Go to Drawing Basics for general instructions (see page 90) 

The cursor changes to  Click and hold the left mouse button, then drag the rectangle to the desired size. 
Click the right mouse button when you have drawn all the objects you want. 
Press and hold the shift key to snap to a square 
Use the Ctrl Copy feature to make exact copies of the object 
Double-Click the object to edit the Shape Properties 

Round Rectangle Drawing Tool 

Draw menu - Round Rectangle OR   
Go to Drawing Basics for general instructions (see page 90) 

The cursor changes to  Click and hold the left mouse button, then drag the rectangle to the desired size. 
Click the right mouse button when you have drawn all the objects you want. 
Press and hold the shift key to snap to a square 
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 Use the extra Handle in the top right corner to change the radius of the corners  
Use the Ctrl Copy feature to make exact copies of the object 
Double-Click the object to edit the Shape Properties 

Ellipse Drawing Tool 

Draw menu - Ellipse OR    
Go to Drawing Basics for general instructions (see page 90) 

The cursor changes to  Click and hold the left mouse button, then drag the ellipse to the desired size. 
Click the right mouse button when you have drawn all the objects you want. 
Press and hold the shift key to snap to a circle 
Use the Ctrl Copy feature to make exact copies of the object 
Double-Click the object to edit the Shape Properties 

Polygon Drawing Tool 

Draw menu - Polygon OR    
Go to Drawing Basics for general instructions (see page 90) 
NOTE:  This tool uses different rules from the other drawing tools. 
1. At the start point of the polygon click and release the mouse button. 
2. Move the mouse to the next apex and click and release again. 
3. Repeat for the all the apexes. 
4. To finish the polygon EITHER double-click the left button OR click the right button or press the Esc 
key. 
Polygons may be re-sized by clicking on an apex and dragging the mouse 
Use the Ctrl Copy feature to make exact copies of the object 
Double-Click the object to edit the Shape Properties 

Bitmaps on a GDW 

Draw menu - Bitmap OR   
Go to Drawing Basics for general instructions (see page 90) 

  
Locate the bitmap file and click OK 

 The bitmap will appear on the GDW 
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Double-Click the bitmap to edit its Properties 

Bitmap Properties 
NOTE:  Some video cards are known to have problems sizing bitmaps so SpecView 
Bitmaps are fixed to their original size by default 
 

  
 
Uncheck the Fix to Original Size box. Then click OK, the bitmap can now be re-sized.  

Text on a GDW 

Draw menu - Text OR   
Use this command to put static text on a GDW (NOT editable in Runtime mode) 
(To put editable text on a GDW use a SpecView Text User Variable (see page 81)) 
Go to Drawing Basics for general instructions (see page 90) 

The cursor changes to . Click on the GDW where you want the text: 
The Text Attributes box will appear 
Click the right mouse button when you have added all the text objects you want. 
Use the Ctrl Copy feature to make exact copies of the object 
Double-Click the object to edit the Text Attributes 

Text Attributes 

  
Text Item 
Enter the text you want to appear on the GDW 
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Choose Font 
Selects the font for THIS text. To change the font for ALL text you are going to put on the GDW, use Text 
Font on the Object Menu (see page 71)  
  
Choose the Font, Style, Size and Color  
 
Justification 
Align the text for best appearance: 

  
NOTE:  Numeric Values added to a GDW that INCLUDE the name are LEFT justified. 
Numeric Values added to a GDW that DO NOT include the name are RIGHT justified 
Object Name - Text 
This information is for SpecView diagnostic purposes only 

Trend Chart Drawing Tool 

Draw menu - Trend Chart OR    
Go to Drawing Basics for general instructions (see page 90) 

After clicking the tool the cursor changes to   
Use the tool as you would to draw a rectangle. As you move the mouse the Trend chart appears: 

  
When you release the mouse button the Trend Chart Attributes  (see page 108) box will appear. Use this to 
set up the Trend chart.  

Bar Chart Drawing Tool 

Draw menu - Bar Chart OR    
Go to Drawing Basics for general instructions (see page 90) 

After clicking the tool the cursor changes to   
Use the tool as you would to draw a rectangle. When you release the mouse button the Bar Chart Setup (see 
page 112) box will appear. Use this to set up the Bar Chart. 
 

Buttons - Drawing on a GDW 

Use the Button menu command on the Draw menu (see page 70) OR click   
Go to Drawing Basics for general instructions (see page 90) 
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Buttons are used for specific actions such as switching to another screen (GDW), controlling Recipes and 
starting other programs. 

The cursor changes to  Click and hold the left mouse button, then drag the button to the desired size. Click 
the right mouse button when you have drawn all the buttons you want. 
Double-Click the button to edit the Button Attributes (see page 97)  
 
Once the Button Attributes have been defined the button can be made to change color on an event see Color 
Dynamics (see page 87)  
 
Buttons can also have multi-line text, different fonts or bitmaps on them. 

Button Attributes & Strategy Controller Actions 

Available Attributes/Actions 
Button Attributes and Strategy Controller Action use the same mechanism in the Strategy Controller (see 
page 160) 
 
This box selects the action that will happen when the button is clicked (in Runtime mode) 

  
Button Caption 
This is a function of the Button Attributes dialog box 
Enter the text you want on the button 
 
Function Keys 
This is a function of the Button Attributes dialog box 
Select a Function Key to have the same action as clicking on the button 
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Button Bitmap and Resize to fit text check boxes 
Allows the button to contain a bitmap. 
 
Button Text, Font & Background Color  
Allows the button's font and color to be defined. 
 
Button Action 
For further details see: 
Alarm: On/Off (see page 98) 
Alarms: Show Alarm List (see page 98) 
Events: Show Event List (see page 99) 
GDW Control: Close this and Swap To GDW (see page 99) 
GDW Control: Close this screen (see page 99) 
GDW Control: Swap to another GDW (see page 99) 
GDW Control: Zoom in (see page 99) 
GDW Control: Zoom Out (see page 99) 
GDW Control: Print Screen (see page 99) 
History: Start Replay (see page 100) 
Logging: Convert Specific Log File Format (see page 100) 
Logging: On/Off (see page 100) 
Logging: Purge Log Files (see page 100) 
Logging: Show Log File Convert Manager (see page 100) 
Parameters: Alter Value Interactively (see page 100) 
Parameters: Copy From… To (see page 101) 
Parameters: Download Specific Value (see page 102) 
Parameters: Math Function (see page 103) 
Parameters: Show Full Parameter List (see page 104) 
Password Log In or Log Out (see page 104) 
Recipe: Download Specific Recipe (see page 104) 
Recipe: Show Recipe Manager (see page 105) 
Recipe: Show Recipe Manager (Read Only Mode) (see page 105) 
Recipe: Show Recipe Manager (Read Only Send To Mode) (see page 105) 
Recipe: Show Recipe Manager (Send To Mode) (see page 105) 
SpecView: Exit Program (see page 105) 
SpecView: Run External Program (see page 105) 
SpecView: Write Line to file/printer (see page 106) 

Alarm On/Off 
This Button Attribute turns alarm (see page 86) checking On and Off and sets the rate at which alarms are 
checked 

  
 
A rate of 5 seconds (the default) means that SpecView will check the booleans identified as alarms every 5 
seconds. A value of 0 seconds will disable alarm checking. 
Adding variables to Alarm Monitoring (see page 74) 

Alarms: Show Alarm List 
This Button Attribute will open the alarm (see page 86) list (duplicates the function of the View Alarm Window 
menu command on the View menu) 
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Events: Show Event List 
This Button Attribute will open the event list (duplicates the function of the View Event Window menu 
command on the Alarm/Event menu) 

GDW Control: Close this and Swap To GDW 
This Button Attribute will swap to another GDW and close this GDW 
NOTE:  Use this action when swapping from a GDW that is only used occasionally 
such as setup screens.  This is because a GDW left open will automatically be 
refreshed in background and this wastes communications bandwidth. 
 
Choose which GDW to swap to off the drop down list: 
 

  
 
NOTE: This will clear the trace on any Trend chart(s) on the currently open GDW. 
 
To swap to another GDW screen without closing and clearing the trace line(s) use GDW Control: Swap to 
another GDW (see page 99) 

GDW Control: Close this Screen 
This Button Attribute will close this GDW 

GDW Control: Swap to another GDW 
This Button Attribute will swap to the GDW selected in the drop down box 
NOTE:  Use this action when swapping from a GDW that is used frequently, 
especially ones with Trend charts. All variables on a GDW left open will be updated 
in the background. 
 

  

GDW Control: Zoom in 
This Button Attribute will zoom in, enlarging the size of the graphics & text within the GDW. 
This duplicates the function Zoom - Up on the Zoom menu (see page 63) 

GDW Control: Zoom Out 
This Button Attribute will zoom out, decreasing the size of the graphics & text within the GDW. 
This duplicates the function Zoom - Down on the Zoom menu (see page 63) 

GDW Control: Print Screen 
This Button Attribute will cause the selected GDW to be printed. 
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History: Start Replay 
This Button Attribute will start Historical Replay  (see page 142) on this GDW 

Logging: Convert Specific Log File Format 
This Button Attribute will convert a specific log format (see page 137) 
 

  

Logging: On/Off 
This Button Attribute turns data logging On and Off. It is usually used as an Action in the Strategy Controller  
The logging rate will be changed to this value when the button is clicked 
A value of 0 seconds turns off data logging 

  
NOTE:  This button action only changes the logging rate for THIS Runtime session. 
To change the default log rate use Preferences - Logging (see page 126).   

Logging: Purge Log Files 
This Button Attribute will cause the log files older than the specified number of days to be deleted. 
Logging is enabled/disabled and the logging rate is specified in Preferences - Logging (see page 126) 

Logging: Show File Convert Manager 
This Button Attribute displays the Log Report Setup (see page 137) box (same action as the Logging - 
Convert Log File menu) 

Parameters: Alter Value Interactively 
This Button Attribute will have the same action as clicking on the variable 
Choose the desired variable from the Variables List     
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Parameters: Copy From.. To 
This Button Attribute will value of the first variable to the second variable 
In the example below the setpoint of Barrel Zone 2 will be copied to Barrel Zone 3: 

  
The Copy Value Button attribute (or Strategy Controller action) will copy a value from one parameter to 
another.  In general, the source and destination of the copy should be the same type, but some type 
conversions are allowed, as below: 
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Copy FromType Copy To Type Result 
Float (Real) Int Decimals are truncated 
Time Number (with 

decimals) 
Number of seconds is used, for example, copying 00:01:02 gives 
62.0 

Float Time Number of seconds is used, opposite of above 
Any Type Text The Text is setup with what would normally be displayed on a 

GDW for the Copy From type.  For example, copying a time might 
give text with the contents "00:01:02".  Copying a boolean type 
might result in the word "Manual" in a Text variable.  A DateTime 
might give "Sunday, July 8, 1997 08:00:00" 

Text Float The first number found in the text is used.  For example, if the Text 
contains "66.1", then 66.1 is used.  If the text contains "4 5", then 
4.0 is taken. If the text has "1.2Fred", then 1.2 is taken. 

Text Integer See above, but no decimals are used. 
Other type conversions not listed above will not work as expected. 

Parameters: Download Specific Value 
This Button Attribute will immediately download the value to the instrument 
The settings below will cause the Adapter instrument to be set to Manual: 
 

  
 
The box below shows how to set a SpecView DateTime user variable to the current computer date and time: 
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Parameters: Math Function 
The Math Function Button Attribute (or Strategy Controller action) allows limited amounts of mathematical and 
other operations to be performed on Parameters. 
Math functions always take the form of: 
 "Copy From Parameter" <Math Function> "Operator Parameter" -> "Copy To Parameter" 
The settings below will write the value of Screw Speed x Drive Ratio to Roll Speed 

  
The parameters chosen for the 'From', 'Operator' and 'To' fields should usually be of the same type. For 
example, you cannot take a date, divide it by a boolean and put the result into a text type. There are however, 
some exceptions listed in the table below. If you must do math on items of different types not listed below, 
then use the appropriate Copy Facilities to copy the value(s) to the correct type first. 
NOTE:  This feature can be used to extract part of the text, such as one read from a 
barcode reader. 
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CopyFrom 
Type 

MathFunction Operator 
Type 

CopyTo 
Type 

Comments 

Time Any Float Time Appropriate math is done on the time, e.g Multiply a 
time by 2.0 

Text Add Text Text Concatenation.  Use to add 2 pieces of text 
together. 

Text Subtract Integer Text Left or Right function.  If the Integer is positive, the 
Left-most "x'" characters are taken.  If the integer is 
negative, the Right-most "x" characters are taken.  
Examples:"ABCDE" Subtract 2  ->  "AB""ABCDE" 
Subtract -2  ->  "DE" 

Text Divide Integer Text Mid function.  The characters from the "x"th position 
onward are taken, until the end of the text (First 
position is 0).  Example:"ABCDE" Divide 2  ->  
"CDE" 

Text Multiply Text Integer Find function.  The integer is setup with the position 
of the first occurrence of '"Operator Text" in the 
"Copy From" text.  If the text is not found, -1 is 
used.  Example:"ABCDE" Multiply "BC"  ->  
1"ABCDE" Multiply "FRED" -> -1 

Bool Add Bool Bool AND function. 
Bool Subtract Bool Bool NOT function.  Note that the Operator Parameter is 

not used, but must be specified.  Use the same 
parameter for the Copy From and the Operator.  
The "Copy To'" boolean is setup with the opposite 
state of the "Copy From'" boolean. 

Bool Multiply Bool Bool OR function. 
Bool Divide Bool Bool XOR function 

 
The following three math functions use variables of type integer or number (with decimals): 
 
• The Abs Math Function takes the first Copy From value and puts into the Copy To variable the absolute 

value (the positive value) of it.  However, it is also necessary to specify the second Copy From variable so 
set it to be the same variable name as the first.   

 
• The Max Math Function takes the two Copy From values and puts the higher value into the Copy To 

variable.  
 
• The Min Math Function takes the two Copy From values and puts the lower value into the Copy To 

variable. 
  
Doing math on types not listed above or not of the same type will usually result in no action being performed.  
Occasionally however, unpredictable results may occur.  To avoid confusion, only perform math on items of 
the same type, or those listed above.  

Parameters: Show Full Parameter List 
This Button Attribute will display the parameter list of the selected instrument. Whether the full list or short list 
will be displayed is determined by the Options menu 

Password: Log In or Log Out 
This Button Attribute will display the Password login dialog from the Password menu (see page 61). 

Recipe: Download Specific Recipe 
This Button Attribute will download the selected Recipe. It allows you to download a Recipe from any other 
GDW. Often used as the action following a Time Based Strategy Controller (see page 146) event. 
First select the GDW the Recipe is on, then choose the specific Recipe 
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Recipe Download Booleans 
SpecView User Variables (booleans) can be set on success or fail of a Recipe download. 
This most often used when a Recipe is downloaded unattended using the Strategy Controller (see page 146) 
NOTE:  The user must arrange for the booleans to be turned off, either manually or 
using the Strategy Controller 

Recipe: Show Recipe Manager 
This Button Attribute will display the Recipe Manager  (see page 115) (The same action as the Recipe - 
Recipe Management menu) 

Recipe: Show Recipe Manager (Read Only Mode) 
This Button Attribute will display the Recipe Manager (see page 115) in the Read Only mode 

Recipe: Show Recipe Manager (Read Only Send To Mode) 
This Button Attribute will display the Recipe Manager in the Read Only - Send (see page 120) To mode 

Recipe: Show Recipe Manager (Send To Mode) 
This Button Attribute will display the Recipe Manager in the Send To (see page 120) mode 

SpecView: Exit Program 
This Button Attribute will cause SpecView to exit 
This action is usually only used with the Strategy Controller 

SpecView: Run External Program 
This Button Attribute will start another program 
Example: To start your own custom help program called myhelp.hlp that is in your SpecView folder enter: 
C:\windows\winhlp32.exe c:\specview\myhelp.hlp 
(Change paths as appropriate) 
 
This command has the ability to accept the name of variables in the line.  Each variable should be enclosed in 
double-percents, like this, showing an example of using SpecView.Time: 

%%SpecView.Time%% 
 
Another example, run the program "C:\TEST.EXE" passing in the number contained in "Zone1.PV": 
C:\TEST.EXE  %%Zone1.PV%% 
 
You can have multiple variables, as long as they are always enclosed in the double-%% 
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SpecView:  Write Line to file/printer 
This Button Attribute will write a line of text allowing the writing of fixed text and SpecView variables into files.  
Files can be appended to or recreated each time. 
 
Click the Visual Editor button to edit the line to be printed: 
 

  
 
Either specify a filename to write to in the Filename box or use a SpecView Text variable from the list of 
currently defined Text variables for the filename. 
 
On some printers it is possible to print directly to the printer by setting the filename to the name of the printer, 
for example, "LPT1:", or for a network printer "\\print server\epson"  a Form Feed can be added to the end of 
the text using the Control Codes drop down menu, described below. 
 
It is also possible to write to a COM port by setting the filename to, for example "COM2:". 
 
Check the Append box to append to an existing file, or check the Replace box to overwrite or create a new 
file. 
 
The Command box defines the line(s) to be written to the file. Any text can be entered together with variable 
names, which are added using the Choose button. These will be enclosed in a pair of percent signs, such as: 
%%varname%% and will be substituted at runtime. 
 
The number of decimal places to be used for Numbers (with decimals) is specified in Preferences - Runtime 
(see page 124) under Line Writer DP. This setting will then apply to all Numbers (with decimals). 
 
NOTE: The Line Writer requires that any variables you include in the %% items are 
on a screen (GDW) that is always open.  
 
If you fail to put a variable on a GDW, then it will probably not appear in the file.  The reason for this is that the 
last known value for the variable must be available at the time the Line Writer needs to write the line.  The 
Line Writer cannot read the value over comms because this may take several seconds (or minutes in cases 
of timeouts with bad comms). By putting the value on a GDW, SpecView will usually have the value available. 

 
The line written always has a <CR> and <LF> automatically added to the end, but these can also be added at 
any point in the line to generate multiple lines. 
 
Use the Control Codes drop down menu to add typical control codes such as <HT> (Horizontal Tab) but for 
the more obscure codes, type the decimal code into the Special Characters box and click Add Code.  These 
codes may be required, for example, for printer control or for other non-SpecView software to pick up and 
process such as Visual Basic programs. 
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See below for a list of ASCII special characters (or search the web for "ASCII character codes") 

 
Dec Code  Dec Code 
00 NUL   16 SLE 
01 SOH   17 CS1 
02 STX   18 DC2 
03 ETX   19 DC3 
04 EOT   20 DC4 
05 ENQ   21 NAK 
06 ACK   22 SYN 
07 BEL   23 ETB 
08 BS   24 CAN 
09 HT   25 EM 
10 LF   26 SIB 
11 VT   27 ESC 
12 FF   28 FS 
13 CR   29 GS 
14 SO   30 RS 
15 SI   31 US 
 
Making your own 'Log Files' 
 
Making a form of .CSV file is easy with the Line Writer. These three separate Line Writer commands illustrate 
the concept - note the commas between the %% to cause commas to be output in the file. 
 
Call the file, for example LOG.CSV, and append to it each time: 
 +LOG.CSV Time,Zone1,Zone2 
 +LOG.CSV %%SpecView.Time%%,%%Zone1.pv%%,%%Zone2.Pv%% 
 +LOG.CSV %%SpecView.Time%%,%%Zone1.pv%%,%%Zone2.Pv%% 
Provided that the last 2 lines are done independently by the Strategy controller, the file may look like this: 
 Time,Zone1,Zone2 
 12:10:34,560.1,580.0 
 12:11:34,560.2,579.9 
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Trend Charts 

Trend charts graph (or plot) variables with respect to time 
Adding a Trend chart to a GDW 
To edit the attributes of a Trend chart: 
• In Configuration Mode double click anywhere on the chart 
• In Runtime mode click the [Setup] label in the top right of the Trend chart 
Click the areas on the picture for specific help... 
 

  
 
Maximum number of Trend chart Pens 
There is no limit to the number of pens on a Trend chart BUT the number of labels that can be shown is 
limited by: 
• The length of the label 
• The width of the chart 
• The Font selected for the chart 
If more pens are defined than can be shown on the top line of the chart: 
• A ">" symbol to the right of the last label indicates that not all the label is displayed 
• A "+" sign to the right of the right of the last numeric value indicates that not all the defined pens are 
shown 
Page Print 
When this box is checked the whole GDW is printed including any graphics, Bar charts, numeric values, etc. 
If you just want a full page Trend chart: 
• Make the Trend chart as big as you can on the screen 
• Set the defaults for your printer to landscape mode 
NOTE: Use a white Paper Color (Accessed from the View Menu (see page 72)) as a 
background for the GDW and a white chart. Background colors and detailed graphics 
will use a lot of ink when printed. 
 
Add/Edit (Pen) 
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All defined instruments previously selected using the Variables and Instrument list will be shown in the 
window  
Click the Plus sign alongside the Instrument to expand the variables list, then pick from the defined variables 
shown by double-clicking 
Fill in Min and Max parameters for the Trend chart.(These can be changed during run time if required) 
 
Variable (Trend chart) 
To assign a variable to a chart Pen: 
1. Click the Plus sign alongside the Instrument to expand the Variables List   
2. Double-Click the required variable 
The Pen label will be automatically assigned, however you can modify this if required to your own label. 
Note that for variables with decimal places only one decimal place will be shown on the Trend chart. 
 
Label (Trend chart) 
The Pen label is the name of the Pen as displayed on the Trend chart. The default assigned by SpecView is 
the same as the variable. This can be edited by clicking in the Label box. 
If you cannot see all the Pen labels defined shorten the Pen labels OR select a smaller (or narrower) font 
 
Min / Max scales for a chart Pen 
For each Pen enter the minimum and maximum scale values. 
Click a Pen label during (Runtime mode) and the scale displayed on the chart y-axis will change to: 
• The Pen color 
• The scaling for that Pen 
 
Pen Color 
Pick a color from the standard windows chart. This will be the line and label color within the chart 
Click OK and repeat for as many variables you wish to chart.  
 
Edit (Pen) 
To edit an existing Pen, highlight the Pen to be edited in the Pens list in the Trend Chart Attributes dialog box 
and click the Edit button, or just double-click the Pen and the Pen Attributes box will be displayed. (Repeat for 
any further editing). 
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Delete (Pen) 
Use this button to remove an existing Pen from the Trend chart. 
After deleting Pen(s) click the OK button to save the changes NOT the Cancel button. 
 
Move Up / Move Down (Trend chart) 
Enables the eventual position of the Pens listed along the top of the Trend chart to be moved in relation to 
one another. Up is to the left, and down is to the right. 
 
Font (Pen) 
The smaller the font the more Pens are available.  
 
Time Span (Trend chart) 
Time ranges are available from 1 minute to 48 Hours; click the box to display the list and select the one most 
appropriate for your use. 
Check the page print to print full page charts on a printer. 
 
Axes color (Trend chart) 
Select a color from the standard windows chart. The time and variable axis will be displayed in the color 
selected. 
 
Chart color (Trend chart) 
Select a color. The whole of the Trend chart will be displayed in this color. 
NOTE: Use white if you intend to print the chart. 
 
Auto-open on Runtime 
This menu command on the Configuration mode File menu (see page 66) should be used if a configuration 
has more than one GDW defined which contain Trend Chart(s). 
In this case the menu command should be used on each of the GDW's to ensure that their traces start 
whenever SpecView goes into Runtime mode. 

 
NOTE: Be sure to click this menu command if the GDW has a Trend chart. If you do 
not, the GDW will have to be opened in Runtime mode before the Trend chart will 
start. 
 
Horizontal Grid Lines 
To add horizontal grid lines to the Trend chart use Preferences - Runtime (see page 124). 
from the File menu while in Configuration mode.  
The setting of Trend Grid Segments draws horizontal lines to divide the Trend chart into this number of 
segments, for example, 4 = divide into quarters, as shown below: 
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Bar Charts 

Bar Charts display variables as a moving vertical or horizontal bar 

  
Adding a Bar Chart to a GDW 

The mouse pointer changes to:  Click and drag a rectangle to the shape you want for the Bar chart. When 
you release the mouse button the Bar Chart Setup bx automatically appears 
NOTE: Bar Charts can be used with boolean (on-off) variables. Set the bottom value 
to 0 and the top value to 1. This can be used to indicate alarms (see page 86). 
 
Bar Chart Setup 
 

  
 
Bar Chart - Variables List 
Choose the variable to be displayed on the chart 
 
Bar Chart - Orientation 
Vertical charts grow up / down with increasing values 
Horizontal charts grow left / right with increasing values 
 
Growth Direction 
Determines the growth direction with increasing value 
Use the Grow Up and Down check box (Left and Right) for variables that can go negative such as 
Deviation/Error and Output  Power in heat/cool controllers 
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Bar Chart - Click Bar Action 
If the variable is writeable, checking this box will allow the variable to be changed by clicking on the chart 
 
Bar Chart - Scales 

Shows a scale on the chart:   
 
Bar Chart - Show Value in Bar 

Shows the numeric value of the Variable in the chart:   
NOTE: Use a light chart color to make the numbers more visible   
 
Bar Chart - Font and Color 
Sets the Font and outline Colors for the Border, Scales and Values shown on the chart 
NOTE: To make the chart disappear when empty, set this outline color to the same 
as the GDW Paper Color (accessed from the View Menu (see page 72)) 
 
Bar Chart - Fill (empty) Color 
The color of the empty part of the chart is set by the Fill Color from the Object Menu. 
Firstly ensure that the Bar Chart Setup (see page 112) dialog does not have the Transparent box checked. 
ingle Click the chart to select it (Do NOT double-click) 
On the Object Menu select Fill Color 
Choose the color from the palette 
 
Bar Chart - Top (Left) and Bottom (Right) Values 
Sets the minimum and maximum values of the displayed chart 
For ± Variables (Deviation, Output Power with heat/cool) set the Bottom (Left) value to a negative number 
 
Bar Chart - Color When Up (Left) and Down (Right) 
Sets the color for the value part of the chart 
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Recipes 

Recipes - Overview 
A Recipe is when SpecView saves values of selected variables (that you can write to) so they can be later 
reloaded to the connected instruments. Recipes give these benefits: 
• Snapshot current process values when good product is being made 
• Exactly reproduce previous machine setup 
• Review and edit complex programmer profiles 
• Eliminate operator error in setting machine parameters 
• On-screen display of which Recipe is loaded 
• Sae and reload instrument setup parameters 
 
Each screen (GDW) in SpecView can have one Recipe associated with it.  When the Recipe mode is 
selected a highlight appears around all the variables selected for Recipes.   
 
The Recipe defines the set of variables, and there can only be one of these per GDW, but there can be up to 
1295 different sets of values for these variables which are saved as files to disk.  However, each set of values 
may not need to set all the variables, therefore in order to set only some of the variables at a time the value 
N/C (No Change) can be used.   
 
Recipe names may be any length and include spaces and any special characters. 
 
A description, which for example, may include special instructions to the operator, can be associated with 
each set of Recipe values. 
 
Button actions or the Strategy Controller can make use of Recipes.    
 
The order that values are downloaded into variables can be defined using  Recipe Levels (see page 121)  
 
SpecView will automatically retry Recipe value downloads if there is a failure. 
See: 
Selecting Variables to be Included in Recipe (see page 114) 
Recipes - Using (see page 115) 
Recipe Warning (see page 116) 
Recipe Names (see page 117) 
Recipe Description (see page 117) 
Recipe Hide this box (see page 117) 
Recipe Save & Save As (see page 118) 
Recipe Import/Export (see page 118) 
Recipe Send (see page 119) 
Recipe "Send To" (see page 120) 
Source and Target Instruments (see page 120) 
Recipe Send To: Warning (see page 120) 
Recipe "Send To" Problems (see page 120) 
Setting the Recipe download order (see page 121) 
Preferences - Recipe (see page 126)  

Selecting Variables to be Included in Recipe 
NOTE: In order to be able to do this you must first have setup a GDW containing all 
the variables which you intend to put in to the Recipe. See: Adding Numeric Values 
to a GDW (see page 84)  
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In Configuration Mode open the GDW which is to have the Recipe 

Select Recipe Mode: Click  on the toolbar (or View Menu - Recipe Mode) 
The cursor changes to a knife and fork and any variables that have already been selected will highlight. 
To add or remove a variable, click the value with the knife and fork cursor. However, make sure that the 
variable is not Grouped  (see page 71) with other items on the GDW. 

  
NOTE: As you move the cursor over each variable the Status Bar shows the name of 
the variable 
Be sure NOT to select any variables that are Read Only. 

Recipes - Using 
Recipes are Setup (see page 199) in the Configuration Mode 

To do a Recipe action during Runtime Mode either click   

OR click  which is a button which has been previously defined in Configuration Mode to 
perform the required Recipe action. 
The Recipe dialog box will appear. 
 
If no items have been selected in Configuration Mode for Recipe for this GDW this box will appear: 

  

The variables need to be selected using  on the toolbar in Configuration Mode 



116       SpecView 2 

  
 
To define the values for each variable click the highlighted values on the GDW itself and enter the new value.  
Do this for each variable. However, if a variable does not need to be changed in this set of values, just click 
the No Change button on the data entry dialog box for that variable. 
 
Then click the Save As… button to save the set of values to a name. This name can then be used when in 
Configuration Mode for button actions or by the Strategy Controller.   
 
You can define numerous different sets of values (up to 1295), each given a different Recipe Name (see page 
117), but typically only a few sets are needed for most requirements. 
 
If the Recipe dialog box has been hidden using the Hide this box button, then  

click  OR   to restore the Recipe box. 
NOTE:  Those items in the Recipe will show Color Dynamics (see page 87) based on 
the Recipe value.  This can cause confusion in some cases if some color dynamics 
are a result of the Recipe and others are not. 

Recipe Warning 
The highlighted values on the GDW are no longer updated once the Recipe dialog box is on the screen. 
When a Recipe has been selected on the list or if a highlighted variable has been edited the values shown 
are no longer current.    
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Recipe Names 

  
 
Click a Recipe name and the highlighted values on the GDW will change to the stored values. 
Click the Send button to write the values to the instruments 
If required, the values may be edited before sending (click a value on the GDW to edit it). The changes may 
be stored by clicking Save (overwriting the existing Recipe) or Save As (save as a new Recipe) 

Recipe Description 
Any text may be typed into the description box.  
The description is part of the Recipe so be sure to click the Save tool after you exit the description box. 

  

Recipe Hide this box 
The Recipe box may be covering some of the Recipe variables on the GDW. The Hide this box button hides 
the Recipe box while you edit the Recipe values. 
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Click  OR   to restore the Recipe box. 

Recipe Save & Save As 
New Recipes: 
Click the Save button when the <Current Values> line is highlighted OR 
Click the Save As… button.  In either case you will be asked to enter a name: 

  
 
Names may be any length and include any characters 
(SpecView assigns the file names. A maximum of 1295 Recipes are allowed per GDW) 
NOTE: This is the same data entry box as used for Configuration names and 
SpecView text user variable names. 
  
Existing Recipes: 
The Save button saves the current values overwriting the old ones.   
NOTE: There is NO "overwrite existing" warning dialog box. 
 

Recipe Import/Export 
Recipe Import and Export are used to save a recipe to a file in a format that may be edited using Microsoft 
Excel and then subsequently imported into SpecView. This allows you to distribute recipes to other SpecView 
users in an easy to use manner. The exported recipe is in Comma Separated Value (CSV) format and can be 
directly edited in Excel. Editing restrictions are detailed below. 
Recipe Import 
The Import button on the Recipe Management screen is always enabled. 

  
 
The recipe which is imported does not relate to the one which is currently selected. It is just used to create 
the default name. Hence the default name will be the <name of the recipe currently selected>.CSV 
If a folder is not specified then the recipe CSV file will be imported from the current configuration folder. 
Alternatively use the Browse button to select a folder and file to import from. 
The file selected must be in CSV format and have been exported using the Export button from within 
SpecView. 
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When you click the OK button you will be prompted to discard any outstanding changes. Then the recipe CSV 
file will be read. 
Each line representing a recipe item is validated to ensure that it can be imported correctly. If not then an 
error is displayed and you may cancel the import if required. 
The number of recipe items being imported is checked, if it does not match the items currently in recipe then 
you are prompted. If there are fewer then the remainder will have their values set to "No Change". Extra items 
in the CVS file will be ignored. 
  
Recipe Export 
The Export button is only available once a recipe to be exported has been selected on the Recipe 
Management screen. 
The Export will prompt for a file name, the default will be the <name of the recipe>.CSV 
If a folder is not specified then the recipe CSV file will be saved in the current configuration folder. 
Alternatively use the Browse button to select a folder and file to save to. 

  
Editing the exported recipe 
The recipe CSV file can be edited before importing it back into SpecView.  
This can be done using MS-Word or a text editor, such as Notepad or WordPad, as well as Excel  
The name of the recipe on the first line may be changed and the recipe item’s new value in the 4th column. 
However, do not remove any of the commas that separate the columns, or change the data in first 3 
columns as these are used by SpecView to match up the recipe items when importing the recipe. 
Whole lines can be removed if you wish to remove a recipe item from recipe, but be aware of the importing 
issues detailed above. 
 

Recipe Send 
(See also Send To (see page 120)) 
Sends the values shown on the GDW to the instruments. 
A progress box is displayed. 
If an instrument does not accept the value sent by SpecView: 

  
Recipe Send: Auto Continue 
SpecView will continue to send the Recipe and ignore all future write errors 

 
Recipe Send: Abort 
The Recipe send is aborted 
NOTE: Values already sent will be the values in the instruments. Previous values are 
not restored. 
 
Recipe Send: Continue 
Clicking Continue will resume the Recipe send. The loading will pause again if there is another write error. 
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Recipe "Send To" 

  
 
Select Source and Target Instruments.  Problems? (see page 120)  

Source and Target Instruments 
If more than one instrument has Recipe values on the GDW they will be shown in the Source Instrument 
window. Select one and then select one or more Target Instruments to receive the values associated with that 
source instrument.  
Then select the next Source Instrument and select target(s) for its values, and so on. 
In this example, the values for "Furnace 1" on the GDW will be sent to Furnace 1, 2, 4 and 5. 
When all required targets have been selected, click the Send Now button 
NOTE: At least one target must be selected. 

Recipe Send To: Warning 
No Target Instruments have been selected for the Source Instrument "Furnace 2" 

Recipe "Send To" Problems 
If at least one Target Instrument has not been selected for each Source Instrument: 

  
Click Yes or No as required. 

 
If an instrument does not accept the value sent by SpecView: 
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Recipe Send To:  Skip Entire Instrument 
SpecView will not attempt to send any more values to that target instrument 

Setting the recipe download order 
 
It is sometimes necessary to send values to instruments in a specific order. Examples are: 
• Setting a controller to manual BEFORE setting the output power 
• Setting a programmer segment or step number BEFORE writing to target time and setpoint  
 
NOTE:  Setting the Recipe download order is only required if the order of the 
download matters for the particular instrument variables used by the Recipe. 
 

  
In this picture all these variables have been selected for Recipe. It is required that the following order is 
followed: 
1. The first segment number 
2. The first target SP and Time 
3. The second segment number 
4. The second target SP and Time 
5. And so on… 
SpecView supports up to 99 download levels which specify the order.  Any number of parameters may be 
sent at any level. It is advisable to leave one or two spare levels at the top. So typically the first item (the first 
segment number, in this example) will be set to level 3, the next to level 4 and so on.  The reason for this is in 
case you need to add something in the future that needs to be set first. 
To set the download level: 

First ensure  is not enabled on the toolbar. 
• Single-click the value to select it 
• Press the shortcut: Ctrl + D or use the Edit - Dynamic Attributes menu command 

  



122       SpecView 2 
Select the required level 
SpecView will send the Recipe in the specified order. 
There is a pause between levels to allow the controller enough time to register the values and be ready for 
the next data. This pause is adjustable in Preferences - Recipe  (see page 126)  
 

Then click the Save tool  and the Runtime tool  to save and run. 
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Preferences 

Preferences Dialog Box 
In earlier versions of SpecView modifications to SpecView's program settings had to be done by hand by 
editing the Settings.ini file. It is now strongly recommended to use Preferences... from the File menu instead.  
 
The Preferences dialog box, accessed by Preferences on the File menu, allows modification of almost all the 
configurable items in Settings.ini. The exceptions is support for COM10 and above by setting the value of 
MaxPorts in the [COMMS] section of Settings.ini. This is initially set to 9, but can be increased up to 40 to 
allow the use of com ports from COM1: to COM40: 
 
For further details on the Preferences dialog box tabs see: 
 
Preferences - Runtime (see page 124) 
Preferences - Remote (see page 125) 
Preferences - Display (see page 125) 
Preferences - Alarm (see page 126) 
Preferences - Logging (see page 126) 
Preferences - Strategy (see page 126) 
Preferences - Recipe (see page 126) 
Preferences - Startup (see page 126) 
Preferences - History (see page 127) 
Preferences - Settings (see page 127) 
Preferences - Web Server (see page 127) 
Preferences - Logfile Conversion (see page 127) 
Preferences - DDE (see page 128) 
Preferences - Debug (see page 128) 
 

Preferences - Runtime 
• *GDW Refresh Rate 1/10s: 4 
The rate at which values on a GDW page are redrawn 
• *Low Scan Rate 1/10s: 100 
The speed of this Scan rate at which values are obtained over the wire. 
• *Medium Scan Rate 1/10s: 20 
The speed of this Scan rate at which values are obtained over the wire. 
• *High Scan Rate 1/10s: 10 
The speed of this Scan rate at which values are obtained over the wire. 
• *Ultra High Scan Rate 1/10s: 5 
The speed of this Scan rate at which values are obtained over the wire. 
• Trend Grid Segments: 0 
Puts in horizontal lines to divide into this number of segments  
(for example, 4 = divide into quarters) 
• *Comms Back Off Multiplier: 20 
If a value can't be accessed over comms, then this number is multiplied by the scan rate and used as a 
'delay' factor before retrying. 
• Parameter List PPS: 15 
When the Instrument View's parameter list button is clicked on in Runtime Mode, this is the number of values 
read per second (Points Per Second) in order to display the parameter list. 
• Disable Config Access: Disabled 
Used to Disable access to Configuration Mode. 
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• Hide Status Bar: Disabled 
Used to Hide the Status Bar to maximize screen space. 
• Single Click Alter: Enabled 
In Runtime Mode this is used to determine if values can be changed by just a single-click or a double-click. 
This is useful if Maximized is disabled on the Startup tab (see below), and there are other windows on the 
screen to click between, as single clicking on a variable by accident will popup the variable change dialog 
box. 
• Disable COM Port Settings Popup: Disabled 
Used to Disable COM Port Settings dialog box 
• Archive/Restore Directory: 

This defaults to the folder that SpecView is installed in, but it can be set to any drive and folder. 
• Line Writer DP:  

The Line Writer (see page 106) is either a button or strategy controller action type. This specifies the 
number of decimal places to be used.  

NOTE: * indicates: A change will not take effect until next entry to Runtime mode 
 

Preferences - Remote 
• Network - IP Port Number  
• Timeout 
Further details SpecView Remote (see page 32) 
 

Preferences - Display 
• Time Format HMSC: No Milliseconds  
(Other options: 1 Millisecond place/2 Millisecond places/3 Millisecond places) 
Whether or not to display Milliseconds in time variables. 
• N/A Value: XXX 
This is what is used to represent the variable's value in Configuration Mode or  
when the value cannot be read from the instrument in Runtime Mode. 
• Recipe No Value: N/C 
N/C stands for No Change. It is only possible to have one set of Recipe variables per GDW, but each Recipe 
can have many sets of values (Max 1295). However, not all of the variables will need to be set in each set of 
values, so this is what is used to indicate the variables which are not to be set.  
• Date Format: %A, %B %d, %Y 
The % sequence used to format date variables, see below. 
• Date Time Format: %H:%M:%S %A, %B %d, %Y 
The % sequence used to format date and time variables, see below. 
• Blank Value: [ ] 
What is displayed when a text value is blank 
 
Date and Time Format Specifications 
 
%a Abbreviated weekday name  
%A Full weekday name  
%b Abbreviated month name  
%B Full month name  
%c Date and time representation appropriate for locale  
%d Day of month as decimal number (01 – 31)  
%H Hour in 24-hour format (00 – 23)  
%I Hour in 12-hour format (01 – 12)  
%j Day of year as decimal number (001 – 366)  
%m Month as decimal number (01 – 12)  
%M Minute as decimal number (00 – 59)  
%p Current locale’s A.M./P.M. indicator for 12-hour clock  
%S Second as decimal number (00 – 59)  
%U Week of year as decimal number, with Sunday as first day of week (00 – 53)  
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%w Weekday as decimal number (0 – 6; Sunday is 0)  
%W Week of year as decimal number, with Monday as first day of week (00 – 53)  
%x Date representation for current locale  
%X Time representation for current locale  
%y Year without century, as decimal number (00 – 99)  
%Y Year with century, as decimal number  
%z, %Z Time-zone name or abbreviation; no characters if time zone is unknown  
%% Percent sign 
 

Preferences - Alarm 
• *Enabled: Enabled 
Whether alarms (see page 86) are enabled 
• *Rate: 5 
The alarm rate 
• Popup Enabled: Enabled 
Whether an alarm displays the Alarm dialog box 
NOTE: * indicates: A change will not take effect until next entry to Runtime mode 
 

Preferences - Logging 
• *Enabled: Enabled 
 Whether logging is enabled 
• *Rate (secs): 60 
The logging rate 
NOTE: * indicates: A change will not take effect until next entry to Runtime mode 
 

Preferences - Strategy 
• *Enabled: Enabled 
Whether or not the Strategy Controller is enabled 
• *Rate: Medium (Low/Medium/High/Ultra-High) 
The speeds for these settings are defined on the Runtime tab. 
NOTE: * indicates: A change will not take effect until next entry to Runtime mode 
 

Preferences - Recipe 
• Recipe Level Delay 1/10s: 5 
The delay between downloading each of the 99 Recipe levels 
• Recipe Retries: 1 
The number of times a Recipe download is attempted before reporting failure. 
• Sequence Recipe Directory (PC3000 Only): 
The folder where the sequence Recipes are stored 
• Select Invert: Disabled 
In Configuration Mode when the 'knife and fork' button is clicked the Recipe 
values are highlighted by a box being drawn round each of them. However,  
on a very complex GDW screen layout the boxes may overlap too much. 
So this feature has been provided to highlight the values using reverse video 
rather than a box. 
 

Preferences - Startup 
• *Maximised: Enabled 
Whether or not SpecView starts with its window using the whole screen. 
• *Configuration Timeout: 20 
The number of seconds to countdown on startup 



Preferences       127 
 
• *Port: 1 
The default printer port on which to detect the dongle 
• *Timing: 0 
This is a timing value for the dongle. It is not recommended to change this  
• *Auto Update of Parameter Lists: Enabled 
Whether or not SpecView will read new values added to an instrument's definition. It is not recommended to 
change this  
• *Title screen delay: 5  
The duration that the copyright logo splash screen is displayed during start-up while instrument definitions are 
being loaded 
NOTE: * indicates: A change will not take effect until next entry to Runtime mode 
 

Preferences - History 
• Auto Pause on Short Trend charts: Enabled 
Historical replay will be paused when the Trend chart line(s) hits right-hand edge of the Trend chart on the 
GDW with the shortest overall duration on the horizontal axis 
• Auto Pause on Long Trend charts: Enabled 
Historical replay will be paused when the Trend chart line(s) hits right-hand edge of the Trend chart on the 
GDW with the longest overall duration on the horizontal axis 
• CPU Replay Factor: 10 
A number (where the units are undefined) which defines how much CPU is used by Historical Replay. The 
bigger the number the more CPU and hence the faster it goes, but the slower other functions in SpecView will 
run while a Historical Replay is in progress 
 

Preferences - Settings 
•  [Reset Variables List Window Position:] 
•  [Reset Password Options Window Position:] 
•  [Reset Alarm Popup Window Position:] 
•  [Reset Event Popup Window Position:] 
•  [Reset Parameter List Window Position:] 
Resets the respective dialog box window's position 
• List Font: Arial 
The font to be used 
• List Font Size: 9 
The font size to be used 
• Show Name On Move: Enabled 
In Configuration Mode moving an XXX shows the name of the variable on the status bar 
 

Preferences - Web Server 
SpecView has a built-in Web Server which can be enabled. 
A screen-shot is taken every 5 seconds; this rate can be modified  (see Update Rate below). 
The screen-shot uses the specified JPEG Quality, where 100 is maximum definition, but uses much greater 
bandwidth. This screen-shot is then made available via the Web Server. 
• Enabled: Disabled by default 
• IP Port Number: 80 
• Update Rate: 5 secs 
• JPEG Quality: 70 (Range: 5 - 100)  
 

Preferences - Logfile Conversion 
• Thread Priority: Slow 
This is how much CPU priority is given to logfile conversions  
• Inhibit Progress Display: Disabled 
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Whether or not to display the Progress dialog box for logfile conversions 

Preferences - DDE 
• *Application Name: SpecView (see DDE application name) 
• *Variable Topic: var (see DDE topic name) 
NOTE: * indicates: A change will not take effect until SpecView has been restarted 
 

Preferences - Debug 
NOTE: Do not change any settings unless under the direction of a SpecView 
representative - or corruption of your configuration may occur. 
 
• Debug Mode: 0 
• *Enable Strategy Debug: Disabled 
• Special Mode 0: Disabled 
• Special Mode 1: Disabled 
• Special Mode 2: Disabled 
• Special Mode 3: Disabled 
• Special Mode 4: Disabled 
• Old Ordering: Disabled 
• Disable Invalid Ports: Enabled 
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Passwords 

Passwords - Overview 
NOTE:  Passwords are optional.  If you do not need them skip this section. 
 
SpecView has the facility of password protection, which can be used as detailed below. 
• Up to 5 levels of password access 
• Any item may be password protected 
• Adjustable inactivity timeout 
• Hierarchical or Non-hierarchical operation 
• Menu command blocking 
• Windows / PC key blocking 

  
 
GDW Setup (see page 130)  
User Control (see page 132)  

GDW Setup 

  
Each GDW must be setup for variables to be available for change. Just because a variable has been marked 
as ACCESSIBLE at a level on one GDW does NOT mean it is ACCESSIBLE on another. 
 

  
 
Selected Object Access Levels 
• SpecView provides (up to) 5 levels of log-in access. 
• Level 0 = ALWAYS locked - only the Password menu command is available 
• Level 1 (Operator) is the next level 
• Level 5 = ALWAYS unlocked - everything is available 
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Select All / UnSelect All Buttons 
These buttons provide a quick way to Select / UnSelect all the objects on a GDW 
 
Disable Password System (Default = On) 
When checked (default) the password system is not active and the system is unlocked at all times. 
This is useful during configuration development when switching frequently between Configuration mode and 
Runtime mode. 
 
Disable Window Controls 
When checked the Window's menus are hidden and the maximize/minimize controls are disabled. 
 
Allow Configuration Mode 
When NOT checked the Configuration Mode menu command is not available on the File menu. 

 
Short List Only 
• When checked the parameter button on Instrument Views is restricted to the short list 
• The Options menu command is disabled 
NOTE:  Since the variables that appear on the short list can be customized the user 
can restrict access to chosen variables. 
 
Hierarchical Behavior 
When checked each level behaves in a hierarchical way; i.e. When an object is marked as ACCESSIBLE at 
level 3, it is ACCESSIBLE at levels 1 and 2 
NOTE:  The following example should be studied in order to understand how this 
behavior could be confusing. 
• An object, say Zone 1.Setpoint, is marked as accessible at Level 1 (Operator) 
• It is therefore accessible at all higher levels 
• The user switches to Level 4 (Configuration) 
• The user clicks by mistake on Zone 1.Setpoint, de-selecting it 
• Seeing the mistake, the user clicks again on Zone 1.Setpoint to re-select it…. 
 
• However, since de-selecting it LOCKED it at Level 4 AND ALL LEVELS BELOW, re-selecting it only 
made it accessible at Level 4 - it is STILL LOCKED AT LEVEL 1. 
 
• You MUST return to Level 1 and re-select it at that level 
 
Password Timeout 
Select a time for the inactivity timeout. 
Inactivity is defined as not accessing a variable. Moving the mouse is not activity. 
The time left on the timeout is shown in the status bar 
 
Timeout Returns To 
Select the required action: 
• Last Logged In Level 
• Level 0 (all Locked) 
• Level 1 (Operator) 
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Selecting Objects for Access 

  
 
When the GDW Setup menu command is selected the cursor changes to the padlock shown above. 
 
Click those objects you want TO BE ACCESSIBLE  at the level shown. 
Each object selected will highlight (as shown above) in either reverse video or with an outline box. (As for 
Recipe, the highlight type is defined by the Select Invert check box in Preferences - Recipe (see page 126)) 

User Control 

  
This is used to enter the names and passwords of the users of the system 
1. Selecting the User Control menu command brings up the "Password Setup" Users box appears 
2. Then click the Add or Edit buttons to get the Add/Edit User Password box 
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Up to 5 levels of user access are provided - use as many (or as few) as you wish 
NOTE:  Use only the levels you know you need.  Too many levels can be counter-
productive. 
The designations "Operator" and "Configuration" are provided only as a reminder that higher numbers mean 
a higher level of access in hierarchical mode. 
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Data Logging 

Data Logging - Overview 
Data logging functions in SpecView are in two parts: 
1 Specifying which items to log to the hard disk 
2 Using the logged data to create reports and replay GDW's (Historical Replay option) 
Data Logging is a background function. Variables do not have to be on an open GDW 
to be logged. Conversely, a variable on an open GDW may not be being logged. 
Three types of data may be logged: 
Variables (see page 134) This is the saving of the values of all variable types 
Alarms (see page 140) SpecView time stamps and saves all items marked as alarms (see page 86) 
Events (see page 141) SpecView records all actions of specified types made by the user. 
Data logging is active by default when SpecView is started. Which variables are logged by default has 
been pre-configured by SpecView as part of the initial instrument definition. Typically this is only specified for 
control instruments: Process Value, Set Point and Output Power are the normal selections For indicators / 
data acquisition modules Process Value is selected. To see what variables are being logged use the Show 
Logging in Variables List menu command on the Database submenu from the Setup menu. This is described 
in Data Logging - Variables (see page 134) 
The logged data is used for two purposes: 
Historical Replay (see page 142) of a GDW 
If an item has no value when using Historical Replay it is probably not included in 
logging. Add the variable to logging as described in Data logging - Variables 
Creating a text file Log Report (see page 199)  
If an item not available for a log report it is probably not included in logging. Add the 
variable to logging as described in Data logging - Variables 
Log Reports may be stored on any drive/folder in your system 
See Disk Space for Logging (see page 136) for file size details 
Changing the Logging Rate (see page 136) 

Data Logging - Variables 
Variables are any items in the Variables List. Types include numbers, integers, boolean (on/off), date, time 
and text. This topic tells you how to see what variables are being logged and how to add or remove a variable 
to/from logging. 
Only variables that have been selected for logging will be available for Log Reports 
and Historical Replay. 
Which variables will be logged selected using the Setup menu (see page 74) 
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When the checkmark is by the "Show Logging in Variables List" a box will appear alongside each item in the 

variables list. To open the Variables list use the tool   
In the picture below the gray box alongside the instrument name means that at least one variable in that 
instrument has been selected for logging. The cross in the white box means that the variable has been 
selected for logging. 

  
 
To ADD a variable to logging click on the empty box by the variable. 
To REMOVE a variable from logging click on the x in the box by the variable 
Variables may also be selected for logging by using the Properties dialog box. 
The Properties box should be used to select the same variable in multiple 
instruments. For example, if you have a large number of the same instrument and 
you want to add Working Setpoint to logging for each of them you should use the 
"Apply to All" feature of the Properties box. 
 
To view the Properties box open the Variables List and click on the variable you want with the RIGHT mouse 
button OR select the variable with a SINGLE click and then click the Properties button. 
In this picture the variable Zone5.Process Value is being logged. If the Apply Log To All box is checked then 
the Process Value parameter of ALL the same type of instrument will be included in logging. 

  
 
All the variables on a GDW can be added to logging with a single command using the "Set All items on this 
GDW as Logged" menu command: 
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This feature is most useful when a GDW is frequently used with Historical Replay 
and it is desired that all the variables replay. This is typical of an Overview screen. 
HOWEVER, use caution! Once selected, the only way to remove an item from logging 
is to use the "Show Logging in Variables List" method described above. For 
example, If used on a GDW that has several hundred items for a ramp/soak program, 
all those items will be added to logging with a single mouse click. 
 
Creating Log Reports (see page 137)  

Disk Space for Logging 
The data is stored by SpecView in the Configuration Folder This location is fixed. 
Log files are always stored in the Configuration folder. To backup the files to another 
location such as a network drive, a batch file triggered by a Strategy Controller event 
should be written. The Strategy Controller topic shows an example. 
The amount of space taken up by log files depends on how often you log data and how many variables have 
been selected for logging.  
The SpecView logging system uses 5 files per day, all with the prefix YY_DDD (year_day-of-year): 
.LOG file - variables data 
.IDX file - index file used in report conversion and historical replay 
.LNM file - names of logged variables 
.ALM file - alarm (see page 86) data 
.EVT file - event data 
The exact size of log files depends on the type of variables logged (text strings take more space than 
integers, for example). A typical variable logged every minute (default value) will take about 25KB of disk 
space per day. So, 100 variables will take about 2.5MB per day. 

Data Logging Rate 
By default data logging is running when in the Runtime Mode 
SpecView stores values of selected variables at Logging Rate. Logging turned off by setting the rate to 0. The 
default rate is 60 seconds.  
The rate may be changed using: 
1 The Preferences dialog box 
2 A Button Attribute 
3 A Strategy Controller event 
The Preferences dialog box is used to permanently change the rate. It is accessed from the File menu in 
either Runtime mode or Configuration mode. 
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NOTE: The new rate will NOT be used until the Runtime mode is restarted. I.e. you 
must go to Configuration mode and back to Runtime for the change to take effect.  
Using a Button Attribute or Strategy Controller event to change the rate it is a temporary change. The next 
time the Runtime mode is entered the rate will return to that specified in the Preferences dialog box. 
NOTE: Use caution when adjusting the rate this way. Disk space is inexpensive. If 
you forget to change the value back you may have logging disabled or at the wrong 
rate without realizing it. There is no indication of the active logging rate. 

Log Reports 
A Log Report is a text file in CSV (Comma Separated Variable) format. Most Windows operating systems 
have this file type registered to Excel. This means that double clicking on a file of this type will automatically 
start Excel and open the file into it. For help in using this type of file please consult your Windows advisor. 
NOTE: To be available for inclusion in a Log Report a variable must be selected for 
Data Logging (see page 134). 
There are two steps to generating a log report: 
1. Choosing the Report Format (see page 138) 
2. Choosing a Start & Stop date/time for the report 
Use the Logging menu (below) OR an on-screen button if one has been defined: 

  
The Log Report Setup (see page 137) dialog box is displayed. 

Log Report Setup 
This box is used to convert logged data into a Log Report 

  
 
Step 1: Choose a Report Format. 
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Step2: Enter the "Start From" Date and Time and "Stop At" Date and Time 
(If you click on one of the "Log Files Available" the start and stop times of that file will be entered 
automatically. 
When you have chosen the Report Format & Start/Stop Time click Generate 
Log Files Available 
A list of all log files available on the system is shown in the dialog box. They include start date and time and 
end date and time of the files. A file is created every day. 
Start From - Stop At 
Enter the time & dates for the start and stop times of the desired report. 
If a report has been previously generated, SpecView will use the stop time & date of the previous report as a 
suggested start time for the next report. 
By checking the current time box the current date and time will be entered in the Stop At boxes. 

Log Report Format 
This box sets up the variables that will be included in THIS report, the name of the file generated, where it is 
stored and the start/stop times. 
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Format Description 
Name the format for easy identification: "Line 1 - PV's only"  "Line 2 Barrel Zone diagnostics"  "Furnace 3 Run 
Data" 
An unlimited number of formats can be defined. 
 
Replace Format and Add to format list 
These buttons save the report format 
When creating a new format click Add to format list 
If you edit an existing format you can save the edits by clicking Replace Format OR save as a new format by 
editing the name and clicking Add to format list 
 
Choosing Variables 
Select the variables you want in this report: Click on the ones you want and then click Add-> If you select 
one you do not want, click on it again to de-select it. The order in the "Order In Report" window is the order of 
columns in the text file produced when the report is "generated". 

 
Log Report: Include  /Event Log 
To get a printable report of either the event or alarm log check these boxes 

   
Each will generate a Comma Separated Variable file using the same name as defined in the "Output File 
Name" but with the extension .cse (events) & .csa (alarms).  The files will be in the location specified in the 
"Output File Path" 
 
Output File Name 
NOTE: Standard file naming conventions (see page 200) must be followed. Long file 
names are supported if the name is taken from a SpecView text variable. All log files 
are in the format "Comma Separated Variable" format. 
Extensions used are: .csv for values; .cse for events; .csa for alarms 
 

Option 1 (default) - Select (up to) the first six characters of the file name 
Choose any characters: e.g. line1-    furn1-   
The files will have the names: line1-02.csv; furn1-05.cse 

Option 2 - Select the specific file name 
The file will always use the same name and the previous file will be overwritten. 

Option 3 - Get the name from a SpecView string user variable 

  
The value entered by the operator for "Lot ID" will be the file prefix for the log/alarm/event report(s).  
Log Report: Output File Path 
Specifies where to put the log files. This can be any folder on any drive available to the SpecView computer - 
i.e. it can be any drive on a network. 
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Default selects the configuration folder. 

Start Time / Stop Time 
This area defines the Start and Stop Time/Date of a report. 
Manual Report Generation 
The radio buttons for "Last Conversion of any kind" and "Current Time" are selected as the default values. 
These are typically used when reports are being generated manually. When a report is generated manually 
the stop time is remembered. When the Log Report Setup dialog box is next selected this time is 
automatically entered as the "Start From" date and time. 
The routine generation of a log report simply requires the user to select the Log Report Setup box (either from 
the Logging menu or from a Button Attribute) and clicking the Generate button. 
NOTE: This feature is disabled when the report is generated automatically by either a 
Button Attribute (Logging - Convert specific log format) OR by a Strategy Controller 
action. When using these features the Start and Stop time must be obtained from 
SpecView Date/Time User Variables (see below) 
Automatic Report Generation 
One of the most popular features of SpecView is to generate log reports automatically when an event occurs. 
The Strategy Controller option is needed to achieve this. The two most common are: 
1 At a fixed time period (every day; every shift; every week etc.) 
2 At the end of a batch process 
To do this it is necessary to define two SpecView Date/Time user variables. One is used as the Start time and 
one as the Stop time. 
To define the user variables: 
1 Open the Variables List 
2 Click the Show New button 
3 Click the  symbol by SpecView Variables 

4 Double-Click DateTime 
5 Enter a name for the first variable ("Batch Start") and click OK 
6 Click Close on the default data entry box 
7 Repeat these three steps to create the second variable ("Batch End") 
See SpecView variables for more details. 
On the Log Format Setup box click the Var: radio buttons: and select the user variables 

  
 It is then up to the actions defined in the Strategy Controller to get the desired values to these user variables. 
See Strategy Controller for examples on doing this. 
 

Data Logging - Alarms 
CAUTION: SpecView's alarm monitoring MUST IN NO WAY be used as a safety 
feature! Use fully redundant approved safety devices only! 
Which boolean variables are monitored as alarms is set up using the Setup menu (see page 74) 
In a similar way to select/remove variables from logging: 
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The Variable List will show which variables SpecView is checking as alarms: 

  
Clicking on a blank square will ADD the variable to alarm checking (only boolean variables can be selected) 
Clicking on an "X" will REMOVE the variable from alarm checking. 
The rate at which they are checked is defined in the Preferences (see page 124) dialog box. The default 
value is every 5 seconds. 
If instrument(s) are disconnected from communications by either being removed or 
turned off, alarm checking can cause excessive slow down of communications to the 
remaining instruments. It may be necessary to set a slower rate for alarm checking, 
turn it off (remove the "enable" check) or remove specific variables from alarm 
checking. 
When an alarm condition is detected the "New Alarms" window appears: 

  
Clicking the Acknowledge button time stamps the "Time Acknowledged" column and displays the "Alarm 
History" window: 

  
 
This shows all the alarms since runtime was last entered. If SpecView is just re-started (either the program or 
by coming from configuration mode) all of TODAY's alarms are shown. 
There is no way to clear or delete alarms 
This window cannot currently be printed 
To get a printable report of the alarms, convert any log format (see page 138) for the time span required with 
the "Include Alarm Log" checked. 
Logrpt.csa opened in Excel: 

  

Data Logging - Events 
A very powerful feature of SpecView is to record all specified actions made by the user in RunTime. Any 
changes made to the connected instruments are logged.  
Which events are logged is set up using the Event Logging menu command on the Setup menu (see page 
74) 
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These are the default settings. 
NOTE: the settings available for the Strategy Controller. This is a very powerful tool 
for helping to debug complex strategy events and actions.  
To view the Event Window in runtime use the  menu command 

  
The event list shown will include all the events since the runtime mode was entered. If SpecView is closed or 
configuration mode is entered the current days events will be shown. 
This window cannot currently be printed 
To get a printable report of the events, generate any log format (see page 138) for the time span required with  
"Include Event Log" checked. 
This is an example of a event report ".cse" file opened in Excel: 

  
 

Historical Replay Option 
Accessed from the History (see page 60) menu during Runtime. 
Historical Replay is an option for SpecView. If the option has not been purchased you are limited to replaying 
the last 4 hours of data. 
You can upgrade (see page 176) your copy of SpecView by phone. Contact your SpecView distributor for 
details. 
 

Historical Replay 
When Historical Replay is started SpecView makes a copy of the GDW and shows the Replay Control Panel. 
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Historical Replay - Start Time 
The six " - XX h " buttons set the start time at 1 to 24 hours back from the current computer time 
The "Other" button lets you choose the start date & time from the log files in the configuration 
 

  
 
Enter a start date & time in the boxes 
NOTE: Click on any of the "Log Files Available" and the start time of that file will be 
inserted automatically 

Historical Replay - Rate 

  
1x to 240x sets the rate at a multiple of real time. If data has been logged (see page 126) every minute 
(default) 60x will give one point per second on the replay GDW. 
"Max" should only be used for trend chart replay. Numeric & Bar Charts are not refreshed at this rate.  

Historical Replay - Options 

    
"Auto Pause" will stop the historical replay when the trend chart has filled with new data 
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If there are two (or more) charts on the GDW that have different time spans, as specified in the Trend Chart 
Attributes (see page 108) dialog, check the box for the one you want to pause the replay. 
The "CPU  'Max' load Factor" allocates a percentage of the CPU time for replay activity. The bigger the 
number the faster the trend chart(s) will fill but other computer activity will slow. Experiment to get the best 
performance for your computer. 
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Strategy Controller 

Strategy Controller - Overview 
The Strategy Controller is used to automate functions in SpecView such as: 
• Automatic Recipe Downloading 
• Automatic Report Generation 
• Turning a Variable On/Off when an event occurs 
• Setting Variables to new values 
• Timing events such as Down Time 
• Counting events 
• Implementing cascade control 
• Performing multiple adjustments from a single click such as incrementing several set points at once 
 
Using the Strategy Controller involves two steps: 
1. Defining an Event 
2. Defining one or more Actions to go with the Event 
This may also be thought of as an "IF - THEN" statement. 
NOTE: There is no ELSE function in the Strategy Controller.  
If an event is defined such as: 
"Zone1.Process Value > 200  Turn On Outputs.Relay3"  
SpecView will do nothing when the value falls below 200. A second event 

"Zone1.Process Value <= 200  Turn Off Outputs.Relay3"  
must be defined. 
 
EVENTS are tested continuously and in no particular order  
ACTIONS are executed in the order that they are shown in the list 
The manual will lead you through a typical example and then explain the function of each item available in the 
Strategy Controller. More examples are at the end of the section. 
The first example is shown in step-by-step detail. It is strongly suggested that the user follow through this 
example, even if it is not relevant to the application, to become familiar with the concepts of the Strategy 
Controller.  

Example: Automatic Log Report 
This example will show the steps for a simple log report. A more complex example that incorporates some 
extra features is described later in this section. 
To use the Strategy Controller you must first plan the steps needed and define any SpecView variables that 
will be required. In this example we want to watch a programmer controller to see when it starts a program 
and note the time it starts. When the program is complete we want to note that time and create a log report 
that covers the duration of the run. These steps are required: 
1 Create two SpecView Date/Time user variables, one for the start time and one for the stop time 
2 In runtime, define the log report format that you want to use for the file (See the Data Logging section 
for details) 
3 Define the first Strategy Controller event that watches for the start of the program 
4 Define an action to time stamp the program start 
5 Define the second strategy controller event that watches for the end of the program 
6 Define an action to time stamp the program end 
7 Define a second action to generate the log report 
 
Step 1: Create two SpecView Date/Time user variables, one for the start time and one for the stop time 
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Open the Variables List by clicking the tool   

  
 

 
 
 
Double click on DateTime 
and enter the name 
Program Start Time.  
 
Click OK to create the 
user variable. The 
DateTime data entry box 
will appear 
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Since the Strategy Controller is going to be 
setting the values for us it is not necessary to 
enter any default value. Click the Close button. 

 

Repeat the above steps to create a second 
user variable called Program Stop Time. 

 

Step 2: Define the log report format that you want to use for the file 
In runtime, create the Log Report Format to be used for the automatic report. (See the Data Logging section 
for more details) 

  
Note that Start Time and StopTime fields use the SpecView User Variables you created in Step1. 
 

Step 3: Define the first Strategy Controller event that watches for the start of the program 
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Back in configuration 
mode select the menu 
Setup - Strategy 
Controller 

 
 
The Strategy Engine box is displayed 

  
 

  

 
 
Click the Value based button 
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The Value Based 
Event box is 
displayed 

In the Description 
window enter: 

Watch Program 
Start 
NOTE: Put a 
number in front of 
the description so 
that you can 
specify the order 
the events are 
shown in the list. 
(this is for 
convenience - list 
order has no 
impact on how 
events are tested) 

 

  

Then click the Choose button to select the variable that the Strategy Controller will monitor 

 

  
 

The Variables List will appear. Find the variable that you want to monitor to determine the start of the log 
report. 

In this case, the parameter is "Program Status". The type of instrument that you are using will determine 
which parameter you want. If in doubt, please contact the instrument manufacturer. 

 
 
Click the arrow to drop down the list for "Test to Perform" 
In this case we want "= (Equal To)" 
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Next Click the Set Value button. The type of 
parameter that you selected to watch will 
determine the type of dialog box that appears. 
In this case it is an "enumerated" variable, 
which gives you a list to choose from. 
Double click the one you want, in this case 
"Run" 

 
 
 
The Value Based Event box 
should now look like this. 
 
 
 
 
 
 

Click OK to close this box 
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Your Strategy Engine Setup box should now look like this 

  
 
Step 4: Define an action to time stamp the program start 
Click the Add button on the Action side of the box. The Action dialog box is displayed: 
 

  
 
Enter a description, such as "Time Stamp Program Start". Then click the arrow to drop down the list of 
available actions: 
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You want to set a value to a specific parameter so choose "Parameters: Download a Specific Value" 

The Variables List 
appears. Click the plus 
sign by SpecView, the 
plus sign by User 
Variables, the plus sign by 
DateTime. 
Click on "Program Start 
Time". 
We want to have 
SpecView copy the 
current time to this 
variable so click on the 
white square by current 
time to put in the check 
mark, as shown in the 
picture. 
Click OK. 

 
 

  

The dialog box should now 
look like this. 

 
Step 5: Define the second strategy controller event that watches for the end of the program 
Click the Add button on the Event side of the box. Enter a description. Click the Choose button and select 
the variable to watch that will tell SpecView that the program is complete. Select "= [Equal To]" for the Test to 
perform. Click the Set Value button and choose the appropriate value. The box should look something like 
this, depending on the variables you have chosen. 
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Step 6: Define an action to time stamp the program end 
Click the Add button on the Action side of the box. Enter a description. Choose "Parameters: Download 
Specific Value" as the action type. Select "Program Stop Time" and check the "Current Time" box. 

  
 
Step 7: Define a second action to generate the log report 
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Click the Add button 
again on the Action 
side of the box. 
Enter a description 
and select "Logging: 
Convert Specific Log 
File Format" as the 
action type. 

 

 

 

 

 

Choose the log format 
you defined in Step 2. 

 
 
The Strategy Engine Setup box should now look like this: 
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The setup is now complete. Click OK to save the strategy. 
NOTE: Strategy events in SpecView are "Edge Triggered". This means that the event becomes true when 
SpecView sees that occurrence of the event conditions. When SpecView is started (either by starting the 
program or by going into RunTime from Configuration Mode) all the events are checked. If an event is true, 
the Strategy Controller will execute the actions associated with that event. In this example, if the program is 
already running when SpecView is started "010 Watch Program Start" will trigger and the time stamp will be 
done. If this is a problem extra strategy steps and intermediate boolean variables must be used to prevent 
unwanted triggering of the event. An example of this is shown later in this section. 
 

Event Type 
"Value Based" events test the value of a Variable against either a constant or another Variable 
"Time Based" events monitor Time, Day, Date, Day of Week etc. 

Value (Variable) Based Event Setup 
Examples (see page 161) 
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Description is a text field to identify the event. Events 
are listed in alphabetical order so it is a good idea to 
use a numeric prefix so that related events may be 
grouped together in the list. 

 
When the "Log to Event Log" box is checked 
each occurrence of the event will be time 
stamped in the Event Log. (If the event log has 
been set to record specified events)   
 
"Value to Watch" is where the varible is selected that SpecView will continuously "watch". This can be any 
variable, including SpecView variables, from the Variables List. 

  
 

  

 
This is where the type of test SpecView will apply is specified. 
"Changed" means any change to the variable. This includes time, boolean 
functions and values. 
"Comms Error" will become true any time SpecView does not receive a 
response from the instrument when the variable is requested. This can be 
used to alert an operator that communications has been lost or corrupted. 

 
The "Value to test against" may be a constant value OR the value of another variable. 
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A constant value would be used when the test is always the same. 
Other Variable is used when two values are to be compared such as Zone 1.Process Value > Zone 2.Process 
Value. 
Or if a test involves comparing a value to a setpoint that requires adjustment. For example, a counter is to be 
reset when the count value exceeds a particular value, and that value is to be set by the user. A SpecView 
variable would be defined called "Count Reset Value" that is put on a GDW. The Strategy Controller event is: 
"Counter.Value > SpecView.Count Reset Value" 

 
Event Control allows an AND function with a secondary boolean 

  
For example: Zone 1.Process value < 200 AND Furnace.Door = Open 
If it is required to AND a variable that is not a boolean, such as a number, an intermediate event must be 
defined. 
For example, Zone 1.Process Value > 250 AND Zone 3.Process Value > 300 
A SpecView boolean user variable must be defined "Zone 3 over 300" 
A strategy controller event/action: "Zone 3.Process Value > 300  Parameters: Download Specific Value of 
On to SpecView.Zone 3 over 300" turns on the boolean. 
A second event: "Zone 1.Process value < 200 AND "SpecView.Zone 3 over 300 = True" completes the 
required statement. 
In such an example do not forget to have an event to turn OFF the boolean since the Strategy Controller has 
no implied ELSE function. 
 

  

When this box is checked the Strategy Controller will NOT test the event. 
 

 
The Startup Event is a special event that is always true when SpecView is 
started or RunTime is entered from Configuration Mode. It is not necessary 
to define any variable to watch or specify any test.   
 
 

Time Based Event Setup 
 
Examples (see page 165) 
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Description is a text field to identify the event. Events 
are listed in alphabetical order so it is a good idea to 
use a numeric prefix so that related events may be 
grouped together in the list. 

 
When the "Log to Event Log" box is checked each 
occurrence of the event will be time stamped in the 
Event Log. (If the event log has been set to record 
specified events)   

 
The time at which the event will trigger is determined by the settings in these lists 

  
This event will last for one second every Monday at 6 o'clock in the morning. If "Any" had been left in the 
"Second" field the event would be true any time between 06:00:00 and 06:00:59. 

  

 
Note the "Any 5, Any 10 etc. that are at the bottom of the Minute and Second lists. When 
possible, these should be used in place of the "Repeat Every" function described below. 

 
Use this setting with caution. 
The event will trigger every 6 hours with the setting 
shown. What SpecView does is compute when the next 
event should occur and automatically enter those values 
into the time and day fields. 

 

If the first event was set to be 06:00 on Monday, as shown above, and it is March 5, 2002 when the event is 
first triggered SpecView will compute that the next event will be: 

  
If SpecView is not in Runtime mode at that precise moment the event will be missed and will never be 
triggered again. 
The user will need to re-edit the Strategy Controller event to get it to trigger again. 
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It is recommended that a Value based event watching SpecView.Time with a test of Changed by a constant 
value of 6 hours be used instead of the above time based event.  
 
Event Control allows an AND function with a secondary boolean 

  
For example: Every Monday at 06:00 AND SpecView.AutoRecipeLoad = On 
If it is required to AND a variable that is not a boolean, such as a number, an intermediate event must be 
defined. 
For example, Zone 1.Process Value > 250 AND Zone 3.Process Value > 300 
A SpecView boolean user variable must be defined "Zone 3 over 300" 
A strategy controller event/action: "Zone 3.Process Value > 300  Parameters: Download Specific Value of 
On to SpecView.Zone 3 over 300" turns on the boolean. 
A second event: "Zone 1.Process value < 200 AND "SpecView.Zone 3 over 300 = True" completes the 
required statement. 
In such an example do not forget to have an event to turn OFF the boolean since the Strategy Controller has 
no implied ELSE function. 
 

When this box is checked the Strategy Controller 
will NOT test the event. 
  

 

Strategy Controller Actions 
For more details on these functions see the descriptions for Button Attributes (see page 97) 
Choose an Action off the list: 

  
If the "Event Log" box is checked the action will be time stamped in the event log each time it is executed. (If 
the event log has benn set up to record specified strategy items. This is the default setting of the event report) 
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Examples of Value Based Events 
Turn on a digital output on a New Alarm (see page 161) 
Simple Count Up Timer (see page 162) 
Cascade Control (see page 164) 
Automatic Log Report (with protection from unwanted triggers) 
(Contact SpecView for more examples) 

Turn on a digital output on a New Alarm 
SpecView can monitor any boolean variable as an Alarm, see Alarm/Event Menu (see page 61) 

 
This Strategy Controller example shows how to turn on a digital output whenever SpecView detects a new 
alarm. 

  
 
This event is watching the SpecView variable "SpecView.NewAlarm". When it is On (There IS a New Alarm) 
AND the SpecView user variable "Alarm Check On" the event will trigger. The use of event control would 
allow the user to disable this event by turning Off the SpecView.Alarm Check variable.  
The appropriate action is shown below - The variable "Digital I/O. New Alarm Relay" will be set to On 
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Count Up Timer 
 
Many timing functions can be done using a SpecView User Variable (see page 81)Countdown Timer. A value 
can be set to the Countdown Timer by: 
• Entering a value to it on a GDW 
• Assigning a value as an action following a strategy event 
It is sometimes more convenient to use a count up rather than count down timer and this can be made using 
the Strategy Controller: 
1. Define two SpecView time user variables; name one "Timer" and the other "Time 1s". Give the "Time 
1s" variable a default value of 1 second. It is then not necessary to put it on any GDW. 
2. Add a Value Based event called "Every Second". The "value to watch" is SpecView.time and the 
"Test to Perform" is changed by the Set Value of 1 second. 
3. Add an action called "Count Up". Use Parameters: Math function: COPY FROM SpecView.timer ADD 
SpecView.time1s COPY TO SpecView.timer 
The event occurs every second and one second (the value of SpecView.time1s) is added to the value of 
SpecView.timer. 
The Strategy Controller boxes for this example are shown below 
Event: 

  
Action: 
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A similar example would be to watch a specific function in an instrument and count the number of times it 
occurs. 
If it is desired to only have the time count at certain times (make it function like a stopwatch) the add the 
boolean function to the event as shown below: 
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Cascade Control 
The Strategy Controller can be used to trim the set point of one controller based on the output of another. 
This is used in many applications where the desired measurement is "thermally remote" from the heat source. 
Examples include: 
• Controlling from the internal (part) sensor of a furnace 
• Using "Deep/Shallow" thermocouples on an extruder barrel 
In this example the output of the "Master" controller is used to adjust the set point of the "Slave" controller. (If 
the master is a programmer type controler then "Master.Working SP" should be added to the "SpecView.SP 
Trim" instead of the "Slave.SP") 
(Using the SpecView user variable "cascade gain" gives more flexibility in tuning) 

Define two SpecView Floating Point (real) user variables, called "Cascade Gain" and "SP Trim" 
Add a value based event: Value to watch = Master.Output; Test to Perform = Changed 
Add an action Parameters: Math Function: COPY FROM Master.Output MULTIPLY SpecView.Cascade Gain 
COPY TO SpecView.SP Trim 
Add a second math function action: COPY FROM Slave.Setpoint ADD Strategy Controller.SP Trim COPY TO 
Slave.Setpoint 
The Strategy Controller boxes for this example are shown below 
Event: 

  
Action 1: 
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Action 2: 

  
 

Examples of Time Based Events 
This event will trigger every Monday at 6 o'clock in the morning: 
(Note that it is "Enabled" by a SpecView boolean user variable called "SpecView.AutoRecipeLoad". This 
means that this event will only trigger when that boolean is On) 

  
 
This event will trigger every 10 minutes: 
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NOTE: It is recommended to use this method to get a recurring event rather than use 
the "Repeat Every" function 
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DDE 

DDE (Dynamic Data Exchange) - Overview 
NOTE: DDE is an option for SpecView. If the option has not been purchased DDE will not function.  To find 
out if it is available see the list under Help - Registration Info (see page 78) 
 
You can upgrade your copy of SpecView by phone. Contact your SpecView distributor for details. 
DDE Application Name  (see page 168)  
DDE Topic Name  (see page 168)  
DDE Status Topic  (see page 168)  
SpecView DDE Restrictions (see page 169) 
Getting data from SpecView DDE (see page 169)  and  Example (see page 171) of getting data 
Setting data into SpecView DDE (see page 169)  and  Examples (see page 170) of setting data 
 
The SpecView DDE Server allows the retrieval and setting of Instrument parameters across the Windows 
DDE Interface. 
The SpecView DDE Interface is somewhat unorthodox in its implementation due to practical considerations. 
as follows: 
Normally, a DDE server would 'register' a whole set of topics and items for which conversations can be 
transacted.  For SpecView, this would mean that each and every variable in the SpecView Variables List     
would have to be registered, and furthermore, each one would have to be requested over the comms link to 
supply any DDE Client that happened along.  This is clearly unfeasible.  Consequently: 
The SpecView DDE Server registers no variables by default - nor does it request anything from the comms.  
When a DDE request comes in from a DDE Client, if it is the name of a variable or parameter that SpecView 
understands, then that variable begins to be requested over comms.  In the meantime, SpecView must have 
answered back to the DDE Client to allow the client to continue processing. SpecView can only answer back 
that the request succeeded - even if the instrument is down or the comms link has failed - this is because it 
could be up to 3 or 4 seconds before the comms engine knows (due to re-tries etc.) that the variable is not 
online. 
Return (see page 168) to DDE help topics 

DDE Application Name 
This setting defines the name that the SpecView DDE Server registers when SpecView starts. 
It is defined in Preferences - DDE (see page 128) 
Although you can choose anything for the application name, it is recommended that this setting be left as 
"SpecView" because some DDE clients facilitate the starting of the DDE Server by name - in the case of 
SpecView, this name must be "SpecView" so that SPECVIEW.EXE can be run in these situations. 

DDE Topic Name 
This setting defines the topic for which SpecView's DDE Server will 'listen' for requests for real time data on. 
It is defined in Preferences - DDE (see page 128) 
By default it is set to "var", meaning variables. 
The fixed Status topic is not affected by this setting. 

DDE Status Topic 
There are 3 items that SpecView registers for DDE under the Status topic: 
LastError The last reason for failure of a DDE request. 
ErrorItem The item that caused the above failure 
PokeStatus The running Status of the current (or last) poke command. 
NOTE: The upper/lower case of the requests is significant (unlike the variables). 
Examples: 
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1) Suppose a request is made for "Specview|var!ANameThatDoes.NotExist". 
This will cause "LastError" to be set to "Unknown Variable" and 
"ErrorItem" to be set to "ANameThatDoes.NotExist". 
2) A DDEPoke request to set a setpoint above the Setpoint High Limit for that particular instrument 
might result in the final PokeStatus being "Write Error 18023". 

SpecView DDE Restrictions 
For reasons explained in the Introduction to DDE  (see page 168), SpecView only supports the getting of data 
using the DDE Advise (see page 169) (or 'Hot' Link method). 
DDE Request is not supported for one-off conversations. 
Data can be Set into Instruments using the DDEPoke (see page 169) mechanism. 
DDEExecute is not supported. 
NOTE:  The CF_TEXT format is the only format supported by SpecView.  All data is 
sent in this text form. 
SpecView must be Online and showing a GDW for DDE Server activity.  If the SpecView is taken out of 
RunTime mode, then all DDE links are terminated. 
SpecView DDE can support multiple simultaneous clients, requesting the same data items, and at different 
speeds. 
Return (see page 168) to DDE help topics 

Getting data from SpecView DDE 
SpecView supports the DDE Advise mechanism for supplying DDE Clients with data.  (See restrictions (see 
page 169)). 
See the DDE Read Example (see page 171) 
SpecView listens on the "var" topic (or that setup by the user in Preferences - DDE (see page 128)) for an 
item that is the name of the variable you want to read.  The format of the item is: 
 Instrument <dot> parameter <comma> rate(optional) 
All items are not case sensitive, and the parameter can be either the short or long name of the parameter. 
The rate can be omitted, in which case 'medium' is assumed, or can be specified as M,L,H or U, meaning 
Medium, Low, High, Ultra-High rate.  The actual rate used depends on  
the settings (see page 124) for the config. 
For example: 
Zone1.pv   Gets process value at medium rate 
Zone1.Process Val  The same 
Zone1.PV,m   The same 
zOnE1.PROCess VAL,M Still the same. 
Zone1.PV,U   Gets the PV at the Ultra High Rate. 
When a request for a new variable comes in via the DDEAdvise mechanism, it is checked by SpecView to 
see that the variable exists.  If it does exist, then SpecView begins to request that variable over comms and 
from then on supplies the Client with the data at the given rate (or faster), until the Client signals that data is 
no longer required.  If the variable does not exist, then the SpecView DDE Status information reflects this. 
NOTE: Due to the potentially long startup time of any given request, a blank answer 
is sent back to the DDE Client first.  Thus, the very first item of data from SpecView 
should be ignored for each new item that is requested. 
In the event of comms errors or missing instruments, no data is sent across DDE. 
Return (see page 168) to DDE help topics 

Setting data into SpecView DDE 
Data can be sent down to the Instrument using the DDEPoke command. 
See the DDEPoke Examples (see page 170) 
Due to the fact that (A) there can be a significant time delay before the data is sent, and (B) the data may not 
be accepted by the instrument (over-range etc), the SpecView DDE Server reports back immediately that the 
DDEPoke succeeded.  It is the responsibility of the Client to only make one Poke request at any time. 
The Status of the write process is reflected in the SpecView DDE Status Information.  This DDE items can 
have one of the following values: 
• Idle 



170       SpecView 2 
• Writing 
• Written 
• Write Error X 
When a Client makes a DDE Poke request, it should monitor the PokeStatus item.  This will be changed as 
the state changes.  The Client will only know that the Poke request actually gave data to the instrument if the 
PokeStatus shows "Written".  If "Write Error X" is shown, then the write failed for the reason given. 
"Idle" is shown before the very first Poke request is actioned, and never afterwards (because "Written" or 
"Write Error" is shown after any Poke. 
Data is sent to SpecView using the CF_TEXT format, and SpecView formats it to the correct type depending 
on the variable prior to sending.  This may or may not require more or less decimal places for numbers that is 
supplied. SpecView will add or truncate  as necessary, so it is always best to send the full resolution to be 
written. 
Return (see page 168) to DDE help topics 

DDEPoke Examples 
The following example shows just the Poke section of making a DDEPoke request - the client program should 
include code to monitor the status of the Poke using the Status Hot Links provided by the SpecView DDE 
Status Information 
For Microsoft Excel and Microsoft Access, a small piece of BASIC code is required to be written. 
For Excel, a Macro (module) can be associated with a button (show me how to do this (see page 171)) and 
the following code assigned to that macro: 
 'This example uses 4 cells to define what and where to write to 

Set appToPoke = Worksheets("Sheet1").Range("B3") 

Set topicToPoke = Worksheets("Sheet1").Range("C3") 

Set itemToPoke = Worksheets("Sheet1").Range("D3") 

Set valuetopoke = Worksheets("Sheet1").Range("E3") 

On Error Resume Next 

Dim Chan 

Chan = DDEInitiate(appToPoke, topicToPoke) 

If Err Then 

    Exit Sub 

End If 

DDEPoke Chan, itemToPoke, valuetopoke 

If Err Then 

    Exit Sub 

End If 

DDETerminate (Chan) 
For Access, a button on a form can be used to cause a similar effect: 
 'This example assumes a small form with 4 input fields has been defined, and a button to call this. 

On Error Resume Next 

Dim Chan 

Chan = DDEInitiate(Me![App], Me![Topic]) 

If Err Then 

    Exit Sub 

End If 

DDEPoke Chan, Me![Item], Me![Value] 

If Err Then 

    Exit Sub 

End If 

DDETerminateAll 
Return (see page 168) to DDE help topics 
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Setting up an Excel DDE Poke Example 
This example is for Excel 2000: 
1. Open a new Sheet inside Excel 
2. Show the Forms Toolbar 
3. Choose the Button tool from the Forms Toolbar 
4. Draw out a button on the sheet 
5. When the Assign Macro dialog box appears, click New 
6. Type (or paste) in the example code from the previous help section (see page 170) in between the 2 
lines, for example: 
        Sub Button1_Click() 
 
        End Sub 
7. Save and close Microsoft Visual Basic 
8.  Click on the button with MB2, choose Edit Text to modify the button's label. 
9. Then set the cells to, for example, as follows: 
Set B3 to: SpecView 
Set C3 to: var 
Set D3 to the variable to be set, for example: 'Zone1.Setpoint 
Set E3 to, for example: '20.5 
10. Click your button to do the Poke. 
 
This example is for Excel 97: 
1. Open a new Sheet inside Excel 
2. Show the Drawing Toolbar 
3. Choose the Button tool from the Drawing Toolbar 
4. Draw out a button on the sheet 
5. When the Assign Macro dialog box appears, choose New Macro 
6. Type in the example code from the previous help section (see page 170) 
7. Save the Macro 
8. Then set the cells to, for example, as follows: 
Set B3 to: SpecView 
Set C3 to: var 
Set D3 to the variable to be set, for example: 'Zone1.Setpoint 
Set E3 to, for example: '20.5 
9. Click your button to do the Poke. 
 
Return (see page 168) to DDE help topics 

DDE Read Example 
An example of Excel reading some items from an Instrument called "Zone1" follow. 
See the important note at the bottom of this section. 
Type these formulas into cells on the Spreadsheet: 
=SpecView|Status!LastError  To get the Error Reason in case of an error. 
=SpecView|Status!ErrorItem  To get the Item for which the last error ocurred. 
=SpecView|var!Zone1.pv  Get the Process Val at medium rate 
=SpecView|var!Zone1.OP  Get the Output Power at medium rate 
=SpecView|var!'Zone1.pv,h' Get the PV at the high rate. The quotes allow Excel to not treat the comma 
as part of some strange formula. 
=SpecView|var!'Zone1.Output Power' Get the OP, using its full name. 
 
Since you are typing this into Excel as a formula, there are certain restrictions you must observe.  In 
particular, where the name of an Instrument or variable contains any character likely to affect Excel's formula 
engine, then the item must be enclosed in quotes so that Excel does not see it.  For example, suppose 
(hypothetically) you had named an instrument  "Zone + 2".  If you just type in: 
=SpecView|var!Zone + 2.pv 
Then this is a formula that takes "SpecView|var!Zone" and adds two to it. 
To get Excel to correctly read the formula, you need to put quotes in: 
=SpecView|var!'Zone + 2.pv' 
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This applies particularly to the following cases: 
"Output Power" - has a space. 
"Auto/Manual" - has a slash - could be seen as a divide. 
"inst.param,RATE" - the comma will confuse - so if a rate is specified, use the quotes. 
 
Return (see page 168) to DDE help topics 
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SpecView Error Codes 

SpecView Error Types 
The only place you should see an error code is if SpecView has had a problem writing to a variable. There 
are three areas of error codes: 
Write Errors (see page 174) 
Generic Errors (see page 175) 
Protocol Specific Errors (see page 175) 

SpecView Write Errors 
In general, if you get an error code in a data entry box such as 

  
SpecView has failed to write the value correctly. The most common cause is that the value being sent is 
outside the acceptable range for that parameter. Check that any limits are not being exceeded for that 
instrument. (Try entering the value on the instrument itself) The error codes below may help. Contact 
SpecView if you cannot resolve the problem. 
There are also generic Error Codes (see page 175)  
These error codes can be returned when attempting to write data to a parameter: 
3 Timeout - Response not received from controller 
18000 Internal IDF Error - Seek advice from SpecView 
18001 Address too long - Too many Characters in the address field 
18002 Address too short - Not enough typed in 
18003 Address is invalid for this Protocol 
18004 Incorrect information after the comma 
18005 Precision specification is incorrect 
18006 Parity Error at Instrument end 
18007 Rx Overflow on Instrument 
18008 Rx Overrun at Instrument end 
18009 Instrument message was corrupted 
18010 Tx Buffer overflow at Instrument 
18011 Instrument message was corrupted 
18012 Parameter value was incorrect for this parameter 
18013 Internal IDF Error - Seek advice from SpecView 
18014 Rx Buffer overflow at Instrument 
18015 Instrument message was corrupted 
18016 Write to read only parameter 
18017 Internal Instrument Error (Yokogawa) RJC error 
18018 Internal Instrument Error A/D Convertor Failure 
18019 Parameter value was incorrect for this parameter 
NOTE:  With Yokogawa UT550 and UT750 the setpoint is a read only variable. To 
change the SP you must edit Target SP 1-8, which are available on the parameter list. 
18020 Parameter value was incorrect for this parameter 
18021 Internal IDF Error - Seek advice from SpecView 
18022 Rx Buffer overflow at Instrument 
18023 Internal Instrument Error - Controller Busy 
18024 Data Over Range 
18025 Data Under Range 
18026 Internal Instrument Error - Burn Out 
18027 Internal Instrument Error - Unknown - Seek Advice 
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18028 Channel or Loop Number incorrect, or Internal IDF Error - Seek advice from SpecView 

18029 CPU Number Invalid 

18030 Operator Panel Address Invalid 
18031 Invalid Delimiter 
18032 Invalid Time To Live 
18033 Read To Write Only Parameter 
18034 Protocol Type Invalid 
18035 Invalid Time 
18200-18500 Protocol Specific Error Codes 

SpecView Generic Error Codes 
These are generic Error codes.  There are also Errors that apply specifically to writing variables to 
instruments.  They are listed here (see page 174). 
3 Timeout 
10001 Cannot Open Comms - Port In use 
10002 Cannot Open Comms - Port Setup Error 
10003 Cannot Open Comms - Port Characteristics Error 
10004 Failed Write 
10005 Incorrect Baud Rate 
10006 Cannot Initialize Windows Comms Subsystem 
10007 Cannot Save Config 
10008 Cannot Start System Timer 
10009 Cannot find Folder 
10010 Invalid Parameter 
10011 Invalid Function 
10012 Address Out of range 
10013 Data Out of Range 
10014 Parameter Write protected 
10022 Cannot Find Required DLL 
18000-18199 Write Errors (see page 174)  
18200-18500 Protocol Specific Error Codes 

Error Codes - Protocol Specific 
Error codes in the range 18200 to 18500 are reserved for Protocol Specific errors returned by the equipment 
connected.  Subtract 18200 to get the error code and then consult the Protocol or Instrument manual for 
details. 
For example, a ModBus Instrument could return Error Code 18208.  Thus, the Modbus error is 8, which is 
"Parameter to be modified is write protected". 
NOTE:  18210 - With Barber-Colman Series 7 controllers you must first click the REM 
button on the Instrument View to enable writing to any variable. 
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Upgrading SpecView 

SpecView is copy protected using a dongle, which is attached to the printer port of your computer. It contains 
all the options purchased with your copy. The user can add additional options. This is a two step process: 
1. Your copy of SpecView generates a code that you give to SpecView, by phone, fax or email 
2. SpecView gives you two or more codes that you enter 
Start by clicking on the Help menu command and then on Registration Info. 

  
Dongle Information 
 

  
 
Click Enable Further Options to begin the upgrade process. 
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Upgrade: Step 1 
 

  
 
When you are ready to contact SpecView click Step 1 to generate the code to give to SpecView. 
 
Upgrade Stage 1: Generate Code 
 

  
Click Generate the code now. Be ready to write down the code. 
Do not do this again until you have been given the new codes by SpecView. The codes you will be given will 
only be valid for this code you will generate now. 



178       SpecView 2 

  
Write down this code and give it to your SpecView contact. 
Click OK and then Exit. 
 
Upgrade Stage 2: Enter codes 
 
Open the Dongle Information box (Help menu; Registration Info) 
Click Enable Further Options 
Click Step 2: Enter Codes you have been given by SpecView 
Enter the codes from SpecView in the box shown below, clicking the Use Code button after each: 

  
NOTE:  After the first code has been entered the first 8 characters will remain - only 
12 characters are entered for subsequent codes. (Codes may be any case and 
spaces are not required) 
After the last code has been entered this box appears: 
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It is necessary to restart SpecView for the new options to be recognized. 
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OPC Client Support in SpecView 

OPC Client Support - Overview 
SpecView offers an OPC Client; initially the client only supports local OPC Servers (when support for remote 
OPC Servers is available this will be a free upgrade to existing OPC Client customers). It will support any 
OPC Server that provides an OPC Data Access standard 1 or 2 interface – this currently means that all OPC 
Servers are supported (if in doubt then check with your SpecView representative). 
 
In order for OPC to function you must have the OPC option in your dongle (see page 176) . 
 
Since OPC is treated within SpecView as another ‘channel’; you can mix OPC ‘instruments’ with COM port 
and TCP/IP based ‘instruments’.  
 
OPC is implemented in SpecView in both Configuration mode and Runtime mode. In Configuration mode you 
can use SpecView’s OPC Browser to view all of the OPC Servers currently available. This is achieved either 
by using the Test Comms for NEW Config (see page 44) button, then clicking the OPC button, for example: 
 

  
 
or the New Manual Configuration (see page 41) button, then clicking the Show New button on the Variables 
dialog box, then clicking the OPC button, for example: 
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See: 
OPC Browser (see page 181) 
Supported OPC Servers (see page 184) 
OPC - Fequently Asked Questions (FAQs) (see page 185) 
OPC - PC Specification/Performance (see page 186) 

OPC Browser 
 
SpecView’s OPC Browser will list the available OPC Servers, see below. If your OPC Server is not listed, 
then it may not be running, if so click the Cancel button on the OPC Browser screen, start up the OPC Server 
and then restart the OPC Browser. If you wish to use SpecView to monitor/control an instrument/controller 
(via an OPC Server) that has access levels in it, then you should set the required access level in the 
instrument/controller before you start up the OPC Browser. If this is not done, then when you try to create a 
SpecView instrument you may find that SpecView cannot retrieve the parameter(s), or tag(s), that you 
require. 
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When you click an OPC Server SpecView will ‘contact’ that Server and retrieve a list of ‘Groups’ and 
ultimately ‘Item IDs’, this process can take a long time. The ‘Groups’  and ‘Item IDs’ are pre-programmed 
and stored in a hierarchy by the OPC Server’s manufacturer. SpecView will then display this hierarchy, for 
example: 

 

  
 
You can then click the individual ‘Groups’ to open them up to see further ‘Groups’ or a list of their ‘Item IDs’, 
for example: 
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You can create a SpecView ‘instrument’ from any of the ‘Groups’ listed. If you have the multiport 

option in your dongle  (see page 176) then you can have ‘Groups’ from multiple OPC Servers. To create a 
SpecView ‘instrument’ you just click the ‘Group’ you wish to select and then click the Create Inst button. You 
will then be asked to give your new SpecView ‘instrument’ a name (one will be suggested using the group 
hierarchy, but you can override it). Once you have typed in a new name and clicked OK then SpecView will 
again contact the OPC Server to retrieve details about the ‘Item ID’ that it requires to build a SpecView 
‘instrument’. As a result of this process you will be informed if there are any ‘Item IDs’ that are not supported 
by SpecView (see below). 

Supported OPC Servers 
CALServer 
This server allows you to monitor/control CAL controllers – see http://www.cal-controls.com. You should be 
aware of the following issues: 
If you want to run this server alongside another OPC Server then start this server first as it does not like 
contending for COM ports with other software. 
You must set the access list to the level that you want to retrieve parameter/tags for, for example, if you wish 
to see Level 3 Registers and below then you must set the access level to 3. 
Most ‘Item IDs’ are supported as Text, which appear to be writeable, however the server accepts no writes. 
Numeric values are writeable. 
If any of your PC software crashes whilst this server is running then you will have to reboot your PC to get this 
server working again. 
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Hexatec 
This server allows you to monitor PC disc space – see http://www.hexatec.com. There are no known issues 
with this server. 
iTools 
This server allows you to monitor/control Eurotherm instrument/controllers – see  
http://www.eurotherm3.com/itools. There are no known issues with this server. 
KEPServerEx 
This server allows you to monitor/control a wide variety of instrument/controllers/PLCs –  
see http://www.kepware.com. There are no known issues with this server. 
Sunware’s OPC Servers 
Allen Bradley SLC500 (DF1 Protocol) OPC Server 
As yet untested with SpecView 
Mitsubishi A Type OPC Server 
As yet untested with SpecView 
Mitsubishi FX Type OPC Server 
As yet untested with SpecView 
Modbus (RTU/ASCII) OPC Server 
As yet untested with SpecView 
Nudam OPC Server 
As yet untested with SpecView 
Omron C Series OPC Server 
This server allows you to monitor/control Omron C Series instrument/controllers – see  
http://www.sunware.com.tw. You must have SpecView build #694 (or above) to use this server. There are no 
known issues with this server. 

OPC - Fequently Asked Questions (FAQs) 
I cannot see any OPC buttons anywhere in SpecView. 
You need to upgrade to the latest build of SpecView, go to http://www.specview.com 
The OPC Server I want does not appear in SpecView’s OPC Browser. 
You should cancel out SpecView’s OPC Browser and then start up the OPC Server; then go back into 
SpecView’s OPC Browser. If the OPC Server still does not appear in SpecView’s OPC Browser then try 
reinstalling the OPC Server. 
The SpecView ‘instrument’ I created does not have all of the ‘Item IDs’ in it that were 
listed in SpecView’s OPC Browser.  
This is either because: 
• The access level in the instrument/controller is not set high enough so that the ‘Item IDs’ can be 

accessed. 
Or: 
• Not all of the ‘Item IDs’ data types are supported (see Supported Data Types below). 
XXXs are shown for some ‘Item IDs’ but not all.  
The OPC Server is returning the value back for the XXX ‘Item IDs’ as bad, hence SpecView shows them as 
XXXs. Consult the OPC Server manufacturer for the cause of the bad value. 
I cannot connect to a remote server that I know exists and is running.  
Check that the case of the OPC Server and PC name you have typed in is correct and try again. 
If you are still having problems then it could be an authorization issue. Does the ‘remote’ PC, with the OPC 
Server running, have authorization for the PC with SpecView running on it.  In other words,  the user logged 
onto the PC with SpecView running must be setup as a user (with the same password) of the PC with the 
OPC Server running on it and possibly even logged in and running the OPC Server. This is all dependent 
upon which version of Windows you are running. 
NOTE: The following steps are taken at your own risk, beware that you will be editing registry settings; 
possibly losing personalized settings and rebooting your PC several times.  Read these instructions through 
VERY CAREFULLY before trying them: 
If you are still having problems then it could be that DCOM has not been configured on the OPC Server PC to 
“Enable remote connection”; to do this is rather involved and may require reboot(s) of your PC.  What you 
have to do is to run DCOMCNFG.EXE (which is normally found in your Windows SYSTEM folder). This in 
itself may require you to go to the Network icon in the Control Panel and set User-level access control 
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under the Access Control tab (and the Obtain list of users and groups from:  to be your Computer 
Name:  from the Identification tab) before DCOMCNFG.EXE will run.  NOTE:  This step will cause your 
PC to lose its Shares and personalized settings for all users.  DCOMCNFG.EXE has a tab called Default 
Security.  Go there and check that Enable remote connection is checked. If it is enabled then you have a 
separate problem; if it is not checked then check it and (probably after a reboot) go back to the Network icon 
in the Control Panel and set Share-level access control under the Access Control tab on your OPC 
Server. This whole process will have removed any Shares that you had setup on the OPC Server PC, so 
reset them as the last step. 
If you are still having problems then ensure that the following registry entry has the value 1 (this is 
documented in Microsoft’s article Q174024 “DCOM95 Frequently Asked Questions”): 
 HKEY_LOCAL_MACHINE\Software\Microsoft\Ole\LegacyAuthenticationLevel 
NOTE:  If you are still having problems then consult the OPC Server manufacturer. 
If you still have a problem then consult SpecView’s website http://www.specview.com  
 
Supported Data Types 
Currently SpecView only supports the following OPC data types: 
 
VT_BOOL 
VT_BSTR 
VT_DATE 
VT_FILETIME 
VT_I1 
VT_I2 
VT_I4 
VT_INT 
VT_R4 
VT_R8 
VT_UI1 
VT_UI2 
VT_UI4 
VT_UINT 
 
If your SpecView instrument does not contain the ‘Item IDs’ that you expect, then check with the OPC 
Server’s manufacturer to see if it is a type in the above list. 

OPC - PC Specification/Performance 
To provide some idea of the overhead that OPC puts on a PC we ran SpecView (build #693) and created 
configuration that included a Eurotherm 2404 connected to running iTools running on the same PC. 

Operating 
System 

Processor Memory 

(Mb 
RAM) 

Time taken to 
for OPC 
Browser to 
appear 

Time taken to load up 
the 
Eurotherm.ModbusServ
er.1 with Groups and 
Items in the OPC 
Browser 

Time taken to 
create an 
instrument for 
the 2404 with 
4,438 
parameters 

Windows 
XP 

AMD Athlon 1100 256 < 1 second < 1 second 16 seconds 

Windows 
2000 

Pentium III 450 380 3.3 seconds 3.8 seconds 34.1 seconds 

Windows 98 Pentium I 100 48 5.8 seconds 1 minute 39 seconds 3 minutes 54 
seconds 

The above test was used to give a worse case scenario – it is doubtful that any user would put 4,438 
parameters on open GDW's. However it is good at pointing out that using today’s low-end PC is best suited 
for OPC. 
 
Debugging 
SpecView can generate debug messages for errors generated by the OPC Browser. To turn debugging on or 
off use Preferences - Debug (see page 128) from the File menu. 
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SpecView Error Codes 
You will see these if you have turned debugging on and look at the debug.txt file in your configuration folder 
e.g. C:\SV32\default 

Error code Description Meaning 
18219 OPC Server status cannot be obtained The OPC Server must be shutdown and 

restarted. 
18229 OPC Server status indicates not running 

normally 
The OPC Server must be shutdown and 
restarted. 

 
OPC Error Codes 
You will see these if you have turned debugging on and look at the svdata.txt file in your SpecView 
installation folder e.g. C:\SV32 

Error code (in hex) Description Meaning 
0004000D OPC_S_UNSUPPORTEDRATE The OPC Server cannot handle the scan 

rate in your configuration. Change the scan 
rates in File->Preferences under the 
Runtime tab and retry. 

80010108 RPC_E_DISCONNECTED The OPC Server has gone off line. Go into 
configuration mode or exit SpecView. Then 
OPC Server must be shutdown and 
restarted. Then go online to SpecView. 

80040154 REGDB_E_CLASSNOTREG Upgrade to build #693 or above. 

If you are using a build of #693 or above 
then contact your SpecView representative 
to pass on your svdata.txt. 

800706BA RPC_S_SERVER_UNAVAILABLE OPC Browser is trying to connect to remote 
OPC Server. 

OPC Browser cannot connect to remote 
OPC Server as either it is not running or 
you do not have security access to it or 
access to DCOM. 

800706D3 RPC_S_UNKNOWN_AUTHN_SERVICE OPC Browser is trying to connect to remote 
OPC Server. 

OPC Browser cannot connect to remote 
OPC Server, as you do not have security 
access to it or access to DCOM. 

C0000005 Unknown Shutdown and restart your OPC Server. 
C0040007 OPC_E_UNKNOWNITEMID Contact your SpecView representative to 

pass on your svdata.txt. 
C004000C OPC_E_DUPLICATENAME Contact your SpecView representative to 

pass on your svdata.txt. 
 
Further information 
http://www.opcfoundation.org/ 
http://www.opceurope.org/ 
Microsoft’s article Q174024 “DCOM95 Frequently Asked Questions” 
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Technical Support 

Contact Information 
 
If you encounter a problem with SpecView, in the first instance please contact your SpecView supplier.  
NOTE: The latest versions of SpecView can always be obtained from our Web Site 
http://www.specview.com 
 
However, if you need to contact SpecView's Technical Support then use one of the following: 

 
• Electronic Support - e-mail and Web 
• Telephone Support in the USA Canada and other countries  not listed below. 
• Telephone support in the UK 
• Telephone support in Europe 
 
f you have problems with a specific configuration, it is most helpful if the entire problem configuration folder is 
saved to a single file and attached to an e-mail message. This can be done using the Archive/Restore (see 
page 40) button. This will allow our Technical Support team to run exactly what you are running. 
 
You may also be asked to click the Technical Information (see page 78) button to provide further details on 
your specific installation. 
 
Manual & Online help version 2.11 

USA Contact Numbers 
Telephone:  (360) 437-5100 
Fax: (360) 437-5112 
If dialing from outside the USA and Canada, the country code is (+1) 
Time zone: PST (GMT -8 Hours) 

UK Contact Numbers 
Telephone: (01825) 766 566 
Fax: (01825) 766 966 
Time zone: GMT 

Europe Contact Numbers 
Telephone: (+44) 1825 766 566 
Fax: (+44) 1825 766 966 
Time zone: GMT 

Internet Support 
Sales and application information:  sales@specview.com 
Technical Support:  support@specview.com 
World Wide Web page: http://www.specview.com 
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Licensing in SpecView 

SpecView uses a hardware dongle (see page 198) as a copy protection key.  

 
SpecView 32 may be downloaded at any time from the SpecView web site: http://www.specview.com at no 
charge.   
 
When used without a dongle there is a 10 minute limit on communications in each Runtime session.  This 
timer is reset each time the user enters Configuration mode and returns to Runtime mode.  It is not necessary 
to restart either SpecView or the computer.  All the functions within the standard software are available, 
including the save functions. 
 
It is possible to add software options to SpecView, such as Historical Replay (see page 142) and the Strategy 
Controller (see page 200) by upgrading the dongle (see page 176).  This can be done remotely - there is no 
need to send the dongle to SpecView.   
 
Remote computers used with SpecView's Networking option do not require a dongle to be connected to them. 
The dongle connected to the local computer will need to have been purchased for the required number of 
simultaneous remote users. 
 
Each dongle is considered to be a license to use the software. There is no concept of a 'Site Licence' within 
SpecView. 
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Minimum Requirements for running 
SpecView 

 
SpecView is a 32 bit Windows application that will run on Windows 95/98/NT/2000/Me/XP. 
A 16-bit application compatible with Windows 3.1 is available by special request. 
 
Any computer that runs Windows and programs such as Word or Excel should run SpecView, a minimum of a 
Pentium with 32 MB RAM (although 64 MB is recommended).  Normal SpecView activity does not put any 
great load on computer performance. Although, if a large number of Strategy Controller events are used or 
large numbers of Logfile conversions are taking place, then more computer power is appropriate. 
 
Communications ports should have 16550 UARTS or better. 
 
SpecView may be downloaded at any time from the SpecView web site: http://www.specview.com at no 
charge.  When used without a "Dongle" (copy protection key) there is a 10 minute limit on communications in 
each Runtime session.  This timer is reset each time the user enters Configuration mode and returns to 
Runtime mode.  It is not necessary to restart either SpecView or the computer.  No save functions are 
disabled. 
 
It is possible to add options to SpecView by upgrading the dongle.  This can be done remotely - there is no 
need to send the dongle to SpecView.  See the SpecView help system or manual for details. 
 
On Windows XP the following dialog may be displayed during installation of SpecView. This is because 
SpecView has yet to complete Microsoft's Windows XP compatibility testing. 
 

  
 
SpecView Networking - Minimum Requirements (see page 38) 
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Frequently Asked Questions (FAQ) 

FAQ - Index 
 
FAQ - Installation/Upgrade (see page 193) 
FAQ - Instrument (see page 193)  
FAQ - SpecView Runtime (see page 194) 
FAQ - SpecView Configuration (see page 194) 
 

FAQ - Installation/Upgrade 
Does SpecView work with Win95/98/NT/2000/Me/XP? 

 - Yes, this is detailed in Minimum Requirements (see page 192)  
Do I need to send back the dongle to get it upgraded?  
- No, once you have decided to upgrade (see page 176) and have raised an order 
- Use the Registration Info menu command from the Help (see page 78) menu  
- Click Enable Further Options.  
- Copy the Step 1 code, which is generated, to the order and fax it to us.  
- We will then give you the Step 2 code(s) to complete the upgrade. 
Will upgrading affect my existing configurations? 
- No, upgrading (see page 176) preserves existing configurations 
- However, as with all computer files, taking regular backups is a good idea.  
- To do this use the Archive (see page 40) button on the Configurations Found dialog to save an entire 
configuration. 
Can I copy SpecView to another PC? 
- Yes, it may be copied freely because, without a dongle (see page 198) connected, it will only operate in 
Runtime mode for 10 minutes. 
 

FAQ - Instrument 
Why am I getting XXX's on the screen where the instrument's values should be? 
- This is correct operation while in Configuration mode (see page 197).  
- However, if this occurs while in Runtime mode (see page 199) then: 
- Check the wiring between the instrument & the PC 
- Click the Variables List (see page 200) tool, select the instrument's name and click Properties 
- Check that the address for the instrument in SpecView is the same as the address setting on the instrument 
itself. 
- Check the instrument is connected to the correct COM port as specified in SpecView. 
- Use the Setup COM Ports menu command on the Setup menu (see page 74)  
- Check the Baud rate. 
- Check the instrument settings & refer to instrument user manual 
- Use Hyperterminal (see page 14) to test the COM port  
On my generic Modbus instrument how do I access higher registers?  
- Use an offset (see page 43) on the address specification by adding a semicolon followed by the offset, for 
example 1,0J;256 
Why are the instrument values shown 10 or 100 times too big (or too small) or 
without the decimal point positioned correctly? 
- Check the address (see page 48) specification to see if the number of decimal places is correct. 
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Why are the wrong values being returned from the instrument? 
- Check the instrument's manual, as some instruments return raw data (for example, Chessell & ABB Chart 
Recorders), which needs to be scaled. 
- This can be done from the Properties button on the Variables List (see page 80). 
 

FAQ - SpecView Runtime 
Can I monitor SpecView remotely?  
-Yes, use SpecView Networking (see page 31) 
How do I view previous Event Logs? 
- Use the Convert Log File menu command from the Logging (see page 60) menu 
- Create a Report Format which has Include Event Log checked.  
- This will create a .CSE file, which can be viewed using Excel. 
How can I restore the Historical Replay window to its original size? 
- Use File->Preferences Settings (see page 127) "Reset Historical Replay Window Position" 
Why am I getting steps or gaps on my Trend Chart rather than a smooth curve?  
- This could be because SpecView is busy trying to read non-existent instruments, or getting repeated comms 
failures. Maybe increasing the Comms Back Off Multiplier (see page 124) to 1000 may help. 
- Alternatively the PC could be busy, so check the loading on the PC.  
- Gaps can be caused by the PC's power save function. 
I am getting empty logfiles, what could be the reason for this? 
- Use the Show Logging in Variables List menu command on the Setup->Database submenu (see page 
74).  
- Then, using the Variables List (see page 80), check that the required variables are set as logged. 
- Or maybe the logging rate needs adjusting from Preferences Logging (see page 126) 
How can the rate that the values of variables change be increased? 
- Adjust Medium scan rate using File->Preferences: Runtime tab. 
- However, there are many factors affecting the rate that variables are acquired  
 - Blocking of comms based parameters (please see the appropriate protocol section for details on how to 
adjust these) 
- Network parameters for TCP/IP connections 
- OPC parameters for OPC servers 
Values are requested separately by the different parts of SpecView, at the rates specified below: 
Data Logger   Preferences - Logging (see page 126) - rate (default 60 secs) 
Screen   Preferences - Runtime (see page 124) - Medium scan rate (default 20 tenths of a 
sec) 
Strategy Controller  Preferences - Strategy (see page 126) - rate (default Medium as defined above) 
DDE   See DDE (see page 168) (default Medium as defined above)  
 

FAQ - SpecView Configuration 
How do I configure SpecView Networking (Remote/Local) 
- See SpecView Networking (see page 31) 
What can I do if Auto detect doesn't work for my instrument? 
- Use Manual Instrument Configuration (see page 41)  
How do I do a Stategy Controller event every second? 
- In the Strategy Controller (see page 146) create a Value Based event 
- Value to watch: SpecView.Time 
- Test to perform: Changed 
- Value to test against will default to Constant Value: 00:00:00 
How do I do a Strategy Controller event every minute? 
- In the Strategy Controller (see page 146) create a Value Based event 
- Value to watch: SpecView.Time 
- Test to perform: Changed,  
- With the constant value 00:01:00 
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My variables list box doesn't appear, why not?  
- It may be off screen,  
- use File->Preferences Settings (see page 127) "Reset Variables List Window Position" 
How do I animate a graphic using the Strategy Controller?  
- Set a SpecView User variable (see page 81) to represent the phase of the animation.  
- Create a number of shapes (see page 90) for the animation 
- Use Edit->Color Dynamics (see page 87) to make the shapes change color between the background color 
and another color, to make it 'appear' & 'disappear' according to the value of the user variable. 
How do I make clicking somewhere on a GDW do a button-type action? 
- Create a polygon (see page 90) with line width = 0 and position it appropriately 
- Create a button (see page 96) and position it off-screen with the required action 
- Change the name of the button to be the same as that of the polygon 
I've set the Fill Color of a shape but it isn't being filled, why?  
- Double-click the shape & uncheck fill-none box 
Why is it that using the Edit->Paste of an object doesn't appear to work?  
- It has been pasted over the top of the original, move it to one side. 
What can I do if comparing an instrument value (with decimal places) with an integer 
in the Strategy Controller doesn't work? 
- Comparisons of variables (see page 200) must be between variables of the same type. 
Can I get SpecView to page the operator when something happens?  
- Use the Strategy Controller (see page 146) action: SpecView: Run External Program 
- This can be used to run a separate package (for example, SMSPagemaster can be used in England to send 
a txt msg to a mobile phone). 
If copying objects doesn't preserve dynamic attributes, How do I copy them?  
- Setup the Color Dynamics (see page 87) after copying & pasting the object 
- Alternatively to copy whole GDW use the Save As menu command to save the GDW to another name 
- It is not recommended to copy & paste bar charts & objects with Color Dynamics attached. 
Can I copy a whole Configuration?  
- Yes, either use Windows Explorer to copy the Configuration folder (see page 39)  
- or use Archive/Restore (see page 40) 
Adding a bitmap to a GDW makes the GDW much larger, why?  
- This occurs if a bitmap (see page 94) is added using Edit->Insert New Object 
- It is recommended to use the Insert a Bitmap (see page 94) tool on the toolbar (or Draw->Bitmap... (see 
page 70)) instead.  
Can I write a line of text at the top of a logfile?  
- Use the SpecView: Write Line to file/printer (see page 106) action for a Button or via the Strategy Controller. 
- Use this to write the line you require to a file called, say, LINE.TXT. 
- Generate a log report to, say, REPORT.CSV 
- Create a file called, say JOIN.BAT, containing a line something like:  
COPY   LINE.TXT+REPORT.CSV   FINAL.CSV 
- Then use SpecView: Run External Program (see page 105) action to run JOIN.BAT. 
How do I archive logfiles? 
- There are 5 files which make up a day's logfiles (see page 134): .LOG .LNM .EVT .ALM .IDX  
- Using Windows Explorer go into the configuration subfolder and sort by name 
- All logfiles will be listed first 
- These can be copied or zipped as required. 
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Glossary of Key Terms used in 
SpecView 

Glossary Index 
Alarm (see page 196) 
Communications Ports "Com Port" (see page 197) 
Communications Protocol (see page 197) 
Configuration (see page 197) 
Configuration Mode (see page 197) 
Data Logging (see page 198) 
Dongle (see page 198) 
Dynamic Attributes (see page 198) 
GDO - Graphical Display Object (see page 198) 
GDW - Graphical Display Window (see page 198) 
Instrument (see page 198) 
Instrument View: (see page 198) 
Log Report (see page 199)   
Read Only Variable (see page 199) 
Recipe  (see page 199) 
Runtime Mode (see page 199) 
Strategy Controller (see page 200) 
Variable - Definition (see page 200) 
Variable Types (see page 200) 
Variables List (see page 200) 
Windows file-naming rules (see page 200) 
Writeable Variable (see page 200) 
 

Alarms 
An Alarm (see page 86) is an On/Off status within an instrument, or a boolean User variable which has the 
Alarm attribute enabled. When an alarm occurs SpecView will display the Alarm dialog box and write an entry 
into the Alarm logfile.  

COM Port Settings 
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Baud Rate 
If the BAUD rate is known then set it appropriately. 
If there is any uncertainty as to the BAUD rate used by the instrument then leave it set to "Auto". Left at "Auto" 
SpecView will test different BAUD rates for address 1 for the selected protocol. It then tests all addresses at 
9600 BAUD, then 19,200 BAUD etc. If your first instrument is set to higher than address 1 AND at other than 
9600 BAUD set the BAUD rate you are using. 

 
Parity 
The Driver settings will be the factory defaults for the selected protocol. Click the Help button on the Ports 
and Protocol box for details for the driver defaults. 
If your instrument is set to other than factory defaults, specify the Data bits, Parity and Stop Bits you need. 

Communications Ports "Com Port" 
A serial port on your computer. Usually RS232 but special cards may be used that have RS422 or RS485 
ports. Windows identifies ports with the term COM1, COM2 etc. SpecView supports up to COM9. 
Communication Ports are a hardware item in your computer and should not be confused with 
Communications Protocol. 
 

Communications Protocol 
The communication standard used by the instrument. This is how the software communicates with the 
instrument and is not related to the type of communications standard used by the port (RS232, RS485 etc.) 

Configuration 
A saved database of instruments, graphical screens (GDW's), Recipes, logging information etc. The 
configuration name is the name of a subfolder of the SpecView folder. 
 

Configuration Mode 
SpecView has two modes of operation:  Configuration mode and Runtime mode 
GDW's are created or edited in the Configuration Mode, see Creating and Editing GDW's (see page 80)  
When in Runtime mode use the File - Configuration Mode (see page 66) menu command to return to 
Configuration mode. 
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Data Logging 
Storing on disk the value of selected variables at a pre-set time interval. 
Data Logging in detail (see page 134)  
 

Dongle 
The dongle is a copy protection key available from your SpecView distributor that is required for all versions 
of SpecView. It is plugged onto the parallel (printer) port of the computer. The dongle is programmed for 
different versions and options and may be upgraded (see page 176) at any time. It will not affect the operation 
of the printer port. 
 

Dynamic Attributes 
These attributes are associated with a variable on a GDW. They are: 
• Scan Rate - The rate at which this value is read from the instrument 
• Recipe - Whether or not the variable is included in the Recipe 
• Recipe Level - The order in which the Recipe values are downloaded 
• Decimal Places - The number of decimal places shown for this variable 
 
See Dynamic Attributes (see page 86) dialog box 

GDO - Graphical Display Object 
Graphics made with SpecView's drawing tools can be grouped and saved as GDO's. The saved GDO's can 
be re-used in any GDW in any copy of SpecView. 
 

GDW - Graphical Display Window 
The window used to display data from the connected instruments. Graphics drawings are used so that the 
data may be arranged in a logical and unambiguous format. SpecView may have as many GDW's as disk 
space and Windows limitations will permit. 
Creating and Editing GDW's (see page 79)  
 

Instrument 
The complete device connected at a unique address on the communications link. A temperature controller, an 
indicator, a process controller, a PLC, a control system are all considered to be Instruments by SpecView. 

Instrument View 
A pictorial view of a connected instrument. In most cases it will look like and have buttons that operate in a 
similar way to the actual instrument when SpecView is in Runtime Mode. 
 

  
 
Adding Instrument Views (see page 80) to a GDW  
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Log Report 
A text file containing the values of selected variables over a time period. The file is in a CSV (Comma 
Separated Variable) format. This means that the data fields are separated by commas. This format is 
intended to be imported into a spreadsheet program such as Excel. 
Viewed with a text editor: 

  
The same file opened in Excel (use Type of File: Text Files (.prn .txt .csv) 

  
 
Log Reports in detail (see page 137)  
 

Read Only Variable 
A variable that cannot be changed over communications, for example, a measurement 
 

Recipe 
This is a set of values for variables on a GDW that are saved on disk under a Recipe name. This Recipe file 
can then be run by SpecView to set the variables to those values. 
 
Only variables on the instrument that are writeable (changeable by the user) can be included in Recipes. 
 
Every Recipe for a given GDW (see page 198) contains values for a single set of variables, i.e. different 
Recipes can't contain values for variables, which aren't included in this single set. 
 
Therefore it is appropriate to include in the Recipe as many variables as will be needed to be set by any 
Recipe. 
 
Tere can be up to 1295 different sets of values, but they can only set that ONE set of variables. Therefore if 
you do not wish to set them all, then use "N/C" (No Change) for the variables, which you do not wish to 
change. 
 
More information is in the Recipes (see page 114) chapter. 
 

Runtime Mode 
SpecView has two modes of operation:  Runtime mode and Configuration mode 
 
Runtime mode is also referred to as On-Line, this is SpecView's normal mode of operation - SpecView is 
communicating with the connected instruments. See Runtime Mode - Using SpecView (see page 51)  
 
When in Configuration mode use the Enter Runtime Mode menu command from the File menu or the 

 tool to return to Runtime mode.   
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Strategy Controller 
(This is an optional feature of SpecView. Without the option you are limited to two events) 
A logic engine based on Events associated with Actions 

Events can be based on either Time/Date or the value of a Variable  
Strategy Controller (see page 146) 
 

Variable 
A variable is a specific piece of information within an instrument. The variable name is always made up of two 
components: <name of instrument>.<name of parameter> 
Examples: 
 Barrel Zone 1.Setpoint 
 Furnace 3.Process Value 
Variables may be selected and placed anywhere on a GDW, used as a Pen on a Trend chart, as a value in a 
Bar chart or selected to be included in a Recipe or data logging. 
There are several Variable Types  
SpecView itself is considered an Instrument with its own Variables (see page 81)  
 
For those who are familiar with the abbreviated variable names used by the instrument's control panel 
SpecView also has the concept of variable Short Names. See Parameter List (see page 56)  

Variable Types 
booleans: On / Off variables. The words for the on and off states can be edited 
Number (with decimals):  A number which may have one or more decimal places 
Integer: A number without decimal places 
Text - May include any characters or numbers 
Time: Expressed in Hours:Minutes:Seconds 
Date: The computer date 
Date Time: The computer date and time  
SpecView User Variables (see page 81) have some additional types 

Variables List 

Accessed by clicking  on the Toolbar while in Configuration Mode, it is a pop-up box listing 
all the variables of all the instruments in the current configuration. 
To display a variable (name and value) on the GDW Double-Click the variable within the  
Variables List (see page 80) dialog box. 
SpecView Variables (see page 81) 
 

Windows filenaming rules 
A file name can contain up to 215 characters, including spaces. However, it is not recommended that you 
create file names with 215 characters. Most programs cannot interpret extremely long file names. File names 
cannot contain the following characters: 
| \ ` ¬ ! " £ $ % ^ & * ( ) + = { } [ ] : @ ~ ; ' # < > ? , . / 
 

Writeable Variable 
A variable that can be changed over communications, for example, a setpoint 
NOTE: Some variables can be both Writeable AND Read Only, for example, output power in a controller can 
be writeable when the Instrument is in "Auto" and be read only when the controller is in "Manual". 
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Index 

COM Port Settings, 198 
Communications ports, 199 —A— 
Communications Ports, 198 Actual Values on Screen, 80 
Communications Protocol, 198 Add a variable to the GDW, 21 
Configuration Mode:, 199 Add a vertical bar chart, 28 
Configuring SpecView, 79 Add buttons to switch between GDWs, 26 
Connections for SpecView Networking, 6 Add/Rename Instruments, 48 
Controlling from SpecView, 52 Adding Instruments, 42 
Copying Drawing Objects, 93 Adding Numeric Values to a GDW, 84 
Copying one variable to another, 102 Adding Trend Chart Pens, 109 
Count Up Timer, 162 Alarm, 87, 198 
Creating / Editing GDW's, 80 Alarm Logging, 142 
Creating a New Instrument, 42 Alarm Scan Rate, 99 
CSV files, 138 Alarm Window Position Reset, 61 

Alarms 
Show Alarm List, 99 —D— 

Alarms - Deleting, 142 Data Entry, 52 
Alarms Menu, 61 Data Entry - Date and Time, 55 
Alarms On/Off, 99 Data Entry - Decimal Places, 52 
Aligning Text, 96 Data Entry - Enumeration, 54 
Annunciating Alarms, 113 Data Entry - Numeric, 52 
Archive, 40 Data Entry - Text Strings, 54 
Archive and Restore, 40 Data Log Files, 137 
Arrange Icons, 77 Data Logging, 135 
Auto Close Boxes, 52 Data Logging - Alarms, 142 
Auto Configuration, 44 Data Logging - Definition, 200 
Automatically detect instruments and display 

instrument views, 18 
Data Logging - Events, 143 
Data Logging - Variables, 135 
Data Logging Rate, 138 
DDE (Dynamic Data Exchange), 169 —B— 
DDE Application Name, 169 Bar Charts, 113 
DDE Read Example, 172 Bar Charts - Creating, 97 
DDE Status Topic, 169 Bar Codes, 104 
DDE Topic Name, 169 Bitmap Properties, 95 
DDEPoke Examples, 171 Bitmaps on a GDW, 95 
Decimal Places, 43 Boolean, 85 
Decimal Places - Changing, 48 Boolean - changing, 53 
Define a second GDW, 25 Boolean Names - Changing, 86 
Deleting old Log Files, 137 Button Attributes and Strategy Controller Actions, 

97 Description, 118 
Disk Space for Logging, 137 Buttons on a GDW, 97 
Displaying Actual Values, 80 
Dongle, 198, 200 —C— 
Draw a trend chart, 23 Calling other Programs, 106 
Draw Menu, 70 Cascade Control, 164 
Drawing Basics, 90 Cascade Windows, 77 
Drawing Irregular Shapes, 94 Changing Instrument Names, 48 
Dynamic Attributes, 200 Changing Screens, 100 

Changing Values Using Buttons, 101, 103 
—E— Close SpecView from Button, 106 
Edit Links, 90 Color Dynamics, 88 
Edit Menu, 68 COM Port, 199 
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Edit/Review, 118 
Entering Values, 52 
Error Codes, 175 
Error Codes - Protocol Specific, 176 
Europe Contact Numbers, 189 
Event Log, 61 
Event Logging, 143 
Event Type, 157 
Events 

Show Event List, 99 
Example 

Automatic Log Report for the duration of a 
Ramp / Soak profile, 147 

Examples of Time Based Events, 166 
Examples of Value Based Events, 161 
Exit SpecView fro Button, 106 
Extruder Picture, 79 

—F— 
FAQ - Installation/Upgrade, 195 
FAQ - Instrument, 195 
FAQ - SpecView Configuration, 196 
FAQ - SpecView Runtime, 196 
File Menu (Configuration), 66 
File Menu (Runtime), 59 
Filling Graphics Objects with color, 92 
Fonts - Changing, 96 
For Instruments using the Modbus Protocol, 17, 43 
Frequently Asked Questions (FAQ), 195 

—G— 
GDO - Graphical Display Object, 198 
GDW - Graphical Display Window, 198 
GDW Configuration & Toolbar, 65 
GDW Control 

Close when swapping, 99 
Closing, 100 
Print Screen, 100 
Swap to another GDW, 100 
Zoom in, 100 
Zoom Out, 100 

GDW Setup, 131 
GDW's - Graphical Display Windows, 79 
Getting data from SpecView DDE, 170 
Getting Started - Drawing Graphics & Charts, 90 
Grouping objects, 92 

—H— 
Help for specific instruments, 5 
Help Menu (Configuration), 78 
Help Menu (Runtime), 64 
Historical Replay, 144 
Historical Replay Option, 144 
History 

Start Replay, 100 
History Menu, 61 

—I— 
Importing Graphics from other Programs, 95 

Insert New Object, 89 
Installation & Wiring, 5 
Installing SpecView, 7, 14 
Instrument, 200 
Instrument Definition/Detection, 41 
Instrument Parameter Lists, 105 
Instrument Settings, 5 
Instrument View, 198 
Instrument View:, 200 
Instrument Views - Automatically, 44 
Instrument Views on GDW's, 48 
Internet, 189 

—K— 
Key Terms, 198 

—L— 
Licensing in SpecView, 191 
Loading recipe problems, 120 
Log files, 137 
Log Report - Definition, 201 
Log Report Format, 139 
Log Report Setup, 138 
Log Reports, 138 
Logging 

access from button, 101 
Convert Specific Log File Format, 100 
On/Off, 101 
Purge Log Files, 101 

Logging - Alarms, 142 
Logging - Events, 143 
Logging Menu, 60 
Logging Rate, 138 
Logo's on GDW's, 95 

—M— 
Manual Configuration, 14, 39 
Manually Defining Instruments, 42 
Master Set-Points, 102, 104 
Math Functions, 104 
Menus - Configuration Mode, 65 
Minimum Requirements for running SpecView, 

193 
Minimum Requirements for running SpecView 

Networking, 38 
Modbus, 5, 17, 43 
Modbus TCP/IP, 17, 43 

—N— 
Naming Instruments, 48 
Network, 31 
Networking (Setting up Local & Remote), 31 
New Manual Configuration, 39 
Numeric Values to a GDW, 84 

—O— 
Object Menu, 71 
Objects in front / behind others, 93 
OPC - Fequently Asked Questions (FAQs), 186 
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OPC - PC Specification/Performance, 187 
OPC Browser, 182 
Options Menu, 62 
Outline Weight / Thhickness, 92 

—P— 
Parameter List, 56 
Parameters 

Alter Value Interactively, 101 
Copy From.. To, 102 
Download Specific Value, 103 
Math Function, 104 
Show Full Parameter List, 105 

Password 
Button to Log In/Out, 105 

Password Menu, 61 
Passwords, 131 
Pointer, 93 
Preferences, 125 
Preferences - Alarm, 127 
Preferences - Debug, 129 
Preferences - Display, 126 
Preferences - History, 128 
Preferences - Logfile Conversion, 128 
Preferences - Logging, 127 
Preferences - Recipe, 127 
Preferences - Remote, 126 
Preferences - Runtime, 125 
Preferences - Settings, 128 
Preferences - Startup, 127 
Preferences - Strategy, 127 
Preferences - Web Server, 128 
Printing the Screen, 100 

—Q— 
Quick Copying of Drawing Objects, 93 
Quick Start, 13 

—R— 
Ratio 

One value the ratio of another, 104 
Read Only Variable, 201 
Recipe 

Access from another GDW, 106 
Download Specific Recipe, 106 
Recipe Manager (Read Only Mode), 106 
Recipe Manager (Read Only Send To Mode), 

106 
Recipe Manager (Send To Mode), 106 
Show Recipe Manager, 106 

Recipe, 121 
Recipe - Definition, 201 
Recipe edit, 119 
Recipe Import/Export, 119 
Recipe Menu, 61 
Recipe Names, 118 
Recipe Save & Save As, 119 
Recipe Send, 120 
Recipe Send problems, 120 
Recipe Send To 

Warning, 121 
Recipe Warning, 117 
Recipes, 115 
Recipes - Using, 116 
Release Notes, 64 
Remote (Setting Preferences), 126 
Remotes Menu, 62 
Renaming Instruments, 48 
Re-Naming Variables, 85 
Replace (on Edit Menu), 68 
Re-Sizing Bitmaps, 95 
Restore, 40 
RS422/EIA422, 5 
RS485/EIA485, 5 
Runtime Functions (on Local), 37 
Runtime Functions (on Remote), 36 
Runtime Menu, 58 
Runtime Mode, 198 
Runtime Mode - Using SpecView, 51 

—S— 
Saving graphics objects, 92 
Scaling Variables, 85 
Screen Print, 100 
See how it works in Runtime mode, 29 
Select Tool, 93 
Selecting objects, 92 
Selecting Objects for Access, 133 
Selecting Variables to be Included in Recipe, 116 
Setting data into SpecView DDE, 170 
Setting the recipe download order, 122 
Setting up an Excel DDE Poke Example, 172 
Setting up SpecView Networking, 31 
Setup Menu, 74 
Short List - Editing, 85 
Software Variables, 81 
Solid Color Objects, 92 
Source and Target Instruments, 121 
SpecView 

Exit Program, 106 
Run External Program, 106 
Write Line to file/printer, 107 

SpecView DDE Restrictions, 170 
SpecView Error Codes, 175 
SpecView Local, 31 
SpecView Networking, 31 
SpecView Networking - Troubleshooting, 37 
SpecView Remote, 32 
SpecView Variables, 81 
SpecView’s OPC Client, 181 
Start Scan, 46 
Starting Historical Replay, 100 
Starting other Programs from SV, 106 
Starting SpecView, 39 
Storing Data, 135 
Strategy Controller, 147 
Strategy Controller - Definition, 202 
Strategy Controller Actions, 161 
Supported OPC Servers, 185 
Switching to another screen, 100 
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—T— 
TCP/IP Autodetect, 46 
TCP/IP Modbus address, 43 
Technical Support, 189 
Test Comms for NEW Configuration, 44 
Text Attributes, 96 
Text File Log Reports, 138 
Text Font, 96 
Text on a GDW, 95 
Tile Windows, 77 
Time Based Event Setup, 159 
Time Based Events 

Examples, 166 
Trend Chart Cursors, 57 
Trend Charts, 109 
Trend Charts - Creating, 96 
Trend Charts - Exact Values, 57 
Trend Charts - Runtime, 57 
Turning on Data Logging, 135 

—U— 
UK Contact Numbers, 189 
Upgrading SpecView, 177 
Upgrading SpecView from a previous version, 10 
URL, 189 
USA Contact Numbers, 189 

User Control, 133 
User Defined Variables, 81 

—V— 
Value (Variable) Based Event Setup, 157 
Value Based Events 

Examples, 161 
Variable Properties, 85 
Variable Types, 202 
Variable:, 202 
Variables - Definition & Types, 198 
Variables List, 80 
Variables List:, 202 
View Menu, 72 

—W— 
Website, 189 
Window Menu, 64 
Window Menu (Configuration), 77 
Windows filenaming rules, 202 
Write error loading recipe, 120 
Writeable Variable, 202 
www, 189 

—Z— 
Zoom Menu (Runtime), 63 
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